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There are so many things that iCloud
can do, and does, that it can be easy
to take it for granted. Yet it's a
cornerstone of the whole Apple
experience; from making it easy to
access your data across your devices
to sharing and collaborating with
others on all kinds of projects.

To help you make the most of
Apple's cloud service, turn to p16
where you'll discover 108 iCloud tips.
Among them we'll reveal some of iCloud’s best-kept secrets,
how and why you'll want to use iCloud+ to boost your privacy
and security, and how iCloud can help you share everything
from photos to movie and music purchases with your family.

Sticking close to home, our second feature this month
(p58) takes an in-depth look at HomeKit and Apple’'s plans for
the smart home of your dreams, both now and in the future.

Finally, we come to this month’s cover stars: the new Mac
mini and MacBook Pro, plus the second-gen HomePod. You
can read our definitive verdicts on all three starting in our
reviews section on p77. Also on test: six of the best note-
taking apps for Mac, iPhone and iPad (p86), the six best apps
to kickstart your spring-cleaning regime (p96) and, seeing as
you're cleaning, you might as well dust down your old vinyl
and give that a spin too, courtesy of the USB turntable (p84).

We hope you enjoy the issue,
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With such top specs, have we
now reached “peak iPhone"?
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Tgple planning
mega spring event

VR headset, Mac Pro and more all expected

pple has some major projects in the
works, and a consensus is forming
that the company is going to host
a blockbuster event in the spring to reveal
its latest projects. If the rumours are correct,
we could see some of the most important new
Apple products in years.

First and foremost is a mixed-reality
headset, apparently dubbed Reality Pro. For
a while now we've had small, scattered leaks
surrounding the device, but that all changed
in January when Bloomberg's Mark Gurman
released a report containing a huge number
of claims of what the headset would offer.

Gurman believes the Reality Pro will offer
hand- and eye-tracking, which Apple wants
to make a “major selling point™. That will let
each user select items and apps by looking
at them, then open those apps by pinching
their thumb and forefinger together. The
operating system (called xrOS) will be
familiar to users of iOS and iPadOS, with
a grid of apps and widgets on the screen.

There will be two high-resolution displays
on the inside to show virtual reality (VR)
content, with cameras on the outside to help
build augmented reality (AR) experiences
that merge the outside world with digital
content. The outside will also feature an
Apple Watch-like Digital Crown - turn this
knob and the headset will switch between
VR and AR modes. And if you wear glasses,

Apple will offer special prescription lenses
that slot into the device's enclosure.

The headset won't be cheap, though,
costing $3,000. The spring event could act
as a first look at the device, and Apple will use
its Worldwide Developers Conference (WWDC)
in June to further explain how it works and get
developers on board.

Many more Macs

We've been waiting for what feels like forever
for Apple to bring out an Apple silicon Mac Pro,
but the time is finally set to arrive this spring.
Multiple sources have been claiming that the
supercomputer will make the jump from

Intel at Apple’s event, but it might be tinged
with a little disappointment.

That's because previous rumours had
suggested the Mac Pro would come with a new,
top-of-the-line chip called the M2 Extreme.
However, Gurman has more recently poured

A springtime, pre-WWDC event could be on the cards,
and we might finally see Apple’s mixed-reality headset.
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cold water on that idea, saying Apple has

dropped the chip in the face of engineering

challenges. Instead, the Mac Pro will now
be outfitted with an M2 Ultra.

Elsewhere, Gurman has also alleged the

Mac Pro will not feature user-upgradable
memory or graphics as a result of the
switch to Apple silicon, which uses a
system-on-a-chip (SoC) design where

these components are integrated into the

chip. The chassis design is also likely to
remain the same. Still, even with these

caveats, there should be a noticeable jump

Rumours suggest the
Reality Pro headset
could offer hand-

and eye-tracking

Apple’s rumoured mixed
reality headset could
cost up to $3,000.

in performance above the Intel chips
available in the current Mac Pro.
Aside from the Mac Pro, Apple could

also launch a 15-inch MacBook Air, which

will be the first time Apple has offered
its lightweight laptop in two sizes since
ditching the 11-inch MacBook Air in 2016.
Few other details are known about this
device, though.

Numerous other products, including a
27-inch display, new MacBook Pro models,
an M2 Mac mini, and a second-generation
HomePod, were all rumoured for the show.

However, all those products - except the
display - were launched in January. As
we explain below, that monitor could be
delayed. Even without those products,

however, the spring event could showcase

some seriously significant devices.

New Apple monitor delayed

Apple is rumoured to be planning a
new monitor with a miniLED panel.
Yet according to analyst Ross Young,
the project has been put on the
backburner, resulting in the monitor
potentially being delayed indefinitely.
Young indicated that he has not
seen any recent signs of life from the
display, suggesting it is far from launch.

»Image credits: Apple Inc, Ahmed Chenni/Freela

The reasons for the delay are not
known and follow previous reports
of delays dating back to June 2022.
Young has previously stated that
the screen will measure 27 inches
across and come with ProMotion
baked in. It's unclear if it will be a
Studio Display, Pro Display XDR,
or something else entirely.

Apple’s next monitor
has been delayed
again, according

to a new report.

The Mac Studio hasn't been out for long,
but its future is already in question.

Apple could
drop the
Mac Studio

pple only announced

the Mac Studio in

March 2021, but the
device could already be set for
the rubbish heap. Bloomberg
reporter Mark Gurman has
claimed a new version might
not arrive until the M4 chip is
released, which could be several
years down the line.

The surprising claim is based
on Gurman'’s assertion that the
Mac Studio would be too similar to
the upcoming Apple silicon Mac
Pro, with both products offering
similar performance. That's
especially so since the Mac Pro
might not come with the M2
Extreme chip it was previously
rumoured to get; instead, it could
be left with an M2 Ultra, which
would be the same tier of chip as
the M1 Ultra inside the Mac Studio.

According to Gurman, Apple
might either decide to delay any
new versions of the Mac Studio for
the foreseeable future, or could
stop updating it altogether. The
latter would be a pretty shocking
turn of events for a new device
that received much fanfare from
Apple upon its release.

APRIL 2023 | MACFORMAT | 7



APPLE

NELUS
ROUNDUP

NEW TECH FOR
BETTER DISPLAYS

The Apple Watch was
Apple’s first OLED
device, and it could
become the company’s
first microLED product
as well. In a new report,
display industry expert
Ross Young stated Apple
will add the tech to its
wearable in 2025.
Compared to OLEDs,
microLED displays offer
improved contrast,
viewing angles, response
times and more. Given
it's a high-end, emerging
tech, it could debut in the
Apple Watch Ultra.

FEATURE IS STILL
IN DEVELOPMENT

We've heard rumours
in the past that Apple
is working on ‘reverse
wireless charging’ tech
that would let an iPhone
charge accessories
placed on its surface.
Now, 9to5Mac'’s sources
say Apple is still working
on the feature, including
firmware that would
manage charging speeds
and heat dissipation.
Apple intended it to
launch in the iPhone 14
Pro series but ran out of
time, suggesting it could
be nearly ready.

8 | MACFORMAT | APRIL 2023

A costly iPhone Ultra
could be coming soon

New flagship phone may sit above the Pro Max

wireless charging.

ight now, the largest and most
expensive phone in the iPhone
line-up is the Pro Max. That could
change this year, as a new report claims Apple
could soon bring out an iPhone Ultra.

The idea is that Apple will try to further
differentiate its top-end model in order to
encourage people to spend an extra fistful of
cash and buy it. According to Bloomberg's Mark
Gurman, that might mean a periscopic camera
lens, a faster chip, and perhaps a larger display
compared to other phones in the roster. It could
even drop the charging port to rely entirely on

All that tech would come in a new iPhone
Ultra that would sit above the Pro Max. Apple
has been discussing the idea internally, Gurman
claims, and could debut it in 2024. But it won't
come cheap, and Tim Cook recently explained
on an earnings call that customers are “willing
to really stretch” and pay more for top devices.
That suggests Apple certainly isn't worried that
a super-high-end iPhone Ultra will put off
consumers with its price.

So it seems the prices for flagship models
could be set to rise again in a year or two, if
Gurman is correct. Better start saving the
pennies to prepare for the outlay.

The Pro Max might not be
Apple's top-end phone for
long, with an Ultra model
potentially coming out soon.

Apple’s clever VR headset plans

You might be able to paint in virtual reality, according to patents

pple’s mixed-reality
headset is one of

the worst-kept
secrets in Silicon Valley
right now, and more details
have recently leaked out
about the upcoming device.
According to a pair of freshly
granted patents, Apple could
have some interesting ideas
on how you'll interact with its
Reality Pro headset (see p6).

The first patent describes

how an Apple Pencil could be
used as a controller for use
in virtual reality (VR). For
example, the patent suggests
you could see your hand
holding the Pencil in VR,
and that swiping or drawing
gestures could result in marks
being made in the virtual
world. In other words, you

could be come a veritable
VR Bob Ross with the help
of the digital pen.

In the second, Apple
explains that its headset
could learn where you are
looking and adjust the quality
and resolution of content
shown in that area. When
your head moves to a new
position, the content at that

location would improve in
quality, while the content
that you are not looking at
would drop in resolution to
save processing power.
These are just the latest
in a spate of Apple headset
patents and, as we've
reported, rumours suggest,
the groundbreaking device
could be almost upon us.
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if a set of recently granted
patents come to fruition.

Apple’s Reality Pro headset could
feature some innovative features,

» Image credit: Apple Inc
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Prepare and publish blogs in the blink of an eye

MarsEdit is undoubtedly one
of the most popular blogging

; - apps available on the Mac.
;d £ Now updated to version 5, it
comes with a slate of new features that help
get your thoughts online more quickly and
easily than ever.

Inspired by sites like Twitter and Mastodon,
there's a new microblogging feature that lets

you compose short, simple messages and
instantly upload them to your website with

a click. And if you like using Markdown syntax,
MarsEdit now automatically styles your copy
appropriately so you know exactly how
everything will look before publication.

There are plenty of other changes, including
a rebuilt rich text editor, improved HTML
highlighting, a more modern search and
replace function, alongside much more. These
enhancements should help make your blogging
even more streamlined than before, whatever
it is that you enjoy writing about.

K

[i0OS APP]
Seven: 7 Minute Workout
FREE (offers IAPS)
Getting fit and
healthy can feel
daunting, but not
when you have this app in
your arsenal. It breaks down
workouts into manageable
seven-minute chunks, giving
you short bursts of activity that
can help you on the road to
fitness. It's a great way to build
strong habits that stick with
you for the long haul.
Why you need it It makes
fitness fast and fun.

)\maqecred : Red Sweater Software LLC, Vertigo

.

[iOS GA.ME]
Frozen City

FREE (offers IAPS)

i The world has
. collapsedinto a
E ! snowy apocalypse,

and now you must rebuild the
last town on Earth and give
humanity a fighting chance at
survival. To do so, you'll need
to collect resources, assign
citizens work, and explore
what's left of the world. Can
you help your people not only
survive, but thrive?

Why you need it A challenging
sim for survival buffs.

[MAC GAME]
Castle Crumble
£4.99/month (Apple Arcade)

o5&, # Onthe surface, Castle
iﬁ‘ Crumble seems
; straightforward:

destroy any castle that stands
in your path. But the fun comes
in the various weapons you
have at your disposal, from
laser beams to TNT. There are
castle themes spanning the
globe, including Aztec
fortifications, Medieval
strongholds, and more.

Why you need it Physics-based
fun with a dose of destruction.

Media
Picks®)

» What you should
be playing and
reading this month

[ALBUM]
Broken By Desire To
Be Heavenly Sent

Lewis Capaldi
£11.99

» Lewis Capaldi says
his second album is not

about reinventing himself,
but about sticking to what
he does best: crafting
“emotional songs

about love or loss.”

Lok

‘

[AUDIOBOOK]
The Creative Act:
A Way of Being
Rick Rubin

£18.99

> World-famous music
producer Rick Rubin
distils lessons he has
learned on fostering
creativity and helping
it flourish in your life.

g&nnupnow

H

[PODCAST]

The Interruption
>IN1977, TV news

was interrupted by

a self-described alien
envoy warning
earthlings to change
their warlike ways. This
is the story of that
mysterious incident.
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There’s been a lot of
talk, but ChatGPT
tech is not yet ready
for prime time...

APPLE CORE Opinion

ver the last few weeks, the single most
m dominant tech story has been ChatGPT, and its
eerily good ability to create written documents
from an ‘AT’ database. Well, I say ‘single’, but what’s been
written about it has gone through so many transformations
- from “Wow), this thing is amazing!” to “Oh, this thing
is terrifying” to “This will make my life much easier” to
“This will put me out of a job” to “I can get any information
digestible” to “Ah, it just makes up facts sometimes”
and “Oh no it also might throw in slurs”, and so on.

A lot of talk about it has been focused on where people
will access it in practice. Microsoft sees it as a way to do the
impossible and leapfrog Google in search, adding it into Bing
in a trial that’s live now. Ask Bing a question and you’ll get an
answer that ideally makes sense and is accurate, but the latter
of those in particular is not
guaranteed (though the next
version of ChatGPT features

Microsoft is already
pushing it as a way to
compose copy too - it can
be used in the Edge browser
to write posts on LinkedIn,
which is a terrifying thought. I really don’t know that the
platform needs an easier way to post complete drivel on it.

One company silent on ChatGPT so far is Apple. I think
this is no bad thing - the technology is not ready for prime
time, and how ‘acceptable’ we’ll find it is far from settled. But
it’s in Apple’s wheelhouse - think about how the company
uses other types of machine learning in photos and battery
management and predicting what apps
you’ll use, all to make life easier - so
I wonder what it’s thinking about it.

Maybe it gives Apple the chance to

i larwing u 1 s o
3 hizer fpht frorm Lareben

create its own search engine, as it has

supposedly wanted for a while. But I
can’t see the company liking the idea of

the possibility that an Apple-branded

product might tell you that it’s safe to

boil a baby (as Bing’s version did for
a moment, reportedly).

an increased amount of data).

MATT BOLTON...

IS WONDERING WHETHER
CHATGPT IS A DANGER TO APPLE,
SIRI'S SAVIOUR, OR JUST JUST
ANOTHER API TO SUPPORT

=
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Few ideas are odder than the idea of choosing a topic,
choosing a chipper tone, and then posting it as your own.
there. Use Siri’s voice recognition to identify
knowledge questions, feed them to ChatGPT,
and have Siri read out the answers. It has the
same risks as above, but maybe Apple would
be more willing to take them since Siri is an
existing product that needs a boost.

Or maybe Apple will take no stance at all.
Maybe it’ll promote that if developers want
to use ChatGPT in their apps, the A-series
and M-series chips do it faster than anything
else on the planet, but it’ll keep clear of
the tech itself. Maybe it’ll include Bing’s
ChatGPT search in Spotlight, again keeping
it clear that it’s another company’s results,
and with the option to turn it off - an arm’s
length away from any worrying results.

We’re on the precipice of something,
make no mistake. But what happens next
is as much about politics as it is technology,
and don’t underestimate the power of the
former to steer the latter.

ABOUT MATT BOLTON

»>Matt is Managing Editor at
TechRadar.com, and previously worked
on T3, MacLife and MacFormat. He's

Siri has been stagnating compared
to other voice assistants, and ChatGPT
could be an incredible opportunity

been charting Apple’s ups and downs
since his student days, but still hopes
to hear “one more thing".

The conflation of information here is
impressive; flights from Heathrow, time
to get there, and what the places are like.
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 “peak
1Phone”’?

Charlotte Henry explores whether Apple's
key product is starting to lose its magic

WRITTEN BY CHARLOTTE HENRY >

niPod, a phone, an
@ internet communicator...
AniPod, a phone - are you
getting it? These are not
three separate devices. This is one device.
And we are calling it iPhone.”
Ever since 2007, when Steve Jobs
got on stage, uttered those words, and
changed the history of his company yet
again, the iPhone has sat right at the heart
of Apple’s now multi-trillion-dollar
empire. Year after year, the company rolls
out the latest model offering various
feature improvements. Year after year
consumers flock to buy it. Or do they?
Sixteen years after the iPhone
launched, there are certainly a lot of
Apple smartphones in the world. In the
statement accompanying Apple’s first
earnings report of 2023, which covers
the last three months of 2022, chief
executive officer (CEO) Tim Cook said:
“During the December quarter,
we achieved a major milestone and are

12 | MACFORMAT | APRIL 2023

Have we
reached

excited to report that we now have more
than 2 billion active devices as part of
our growing installed base.”

It is safe to assume a significant
proportion of these active devices are
iPhones. Interestingly though, Apple’s
chief financial officer (CFO) Luca Maestri
used the same statement to emphasise
that “we set an all-time revenue record of
$20.8 billion in our Services business.”
Apple is certainly keen to show investors
that the revenue from its services offering
is growing, but if iPhone sales were
booming then that is surely what he
would have focused on.

Telling numbers

Apple revealed iPhone sales had dropped
by eight percent from the same time the
year before to $65.8 billion. That was

the first-time sales had fallen since 2020.
This is particularly concerning given

the numbers are from the quarter that
includes both the roll-out of the iPhone 14
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and the main holiday period.
One of the key problems is
disruption to device
production in China, largely
caused by Covid lockdowns
in the country. The country
is crucial to Apple’s
manufacturing process.
However, Cook was
optimistic about things
going forward, telling the
Reuters news agency that
“production is now back
where we want it to be”.

The issues go beyond
manufacturing slowdowns
though. It seems that,
while the iPhone remains
sensationally popular, people are holding
on to their devices for longer than before.
In places like the UK and US we may have
got used to carrier networks offering
24-month contracts, but that does not
mean we are rushing toupgradeour  ©

»Image credit: Apple Inc



While each iPhone incarnation brings
improvements, are they enough to
have us reaching for our bank card?
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© phones as soon as our term has ended.

A host of things are contributing to this, not
least because of economic and personal
financial circumstances. Once a two-year
phone contract period is over, it is often cheaper
to go for a ‘SIM only’ deal - then you are only
paying to be on a mobile network, not paying
for the cost of a new phone.

Another key factor seems to be a growing
sense that each generation of iPhone is no longer
significantly better than the last. Sure, there are
always a number of upgrades and new features,
but for many these mostly incremental
improvements are not worth the expense.

Take the iPhone 12 Pro, for example. While
we have undoubtedly seen some nice additions
in successor models, the battery on the device
is known to stay in good health, the camera is
more than sufficient for an amateur, and the
phone supports both 5G and the latest version
of i0S. So, if you have a handset you're happy
with, where’s the incentive to upgrade?

Not all bad news

In many ways, this is actually something
positive for Apple to brag about. It is an
endorsement of the quality of its devices, and
it also means fewer old iPhones are being
disposed of, which is better for the environment.
Indeed, this is the approach the company
took when launching Self Service Repairs in
Europe at the end of 2022. The programme
enables customers in some European countries,
including the UK, to purchase Apple parts
and fix their own iPhone. “We believe the best
technology for our customers and for the planet
is technology that lasts, which is why we design
our products to be durable and rarely require
maintenance or repair,” Jeff Williams, Apple’s
chief operating officer (COO), said at the time.

The iPhone 11introduced Apple's all-new dual-camera
system with Ultra Wide and Wide cameras.
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The most
popular

iPhone

The iPhone 6 and iPhone 6
Plus are understood to be
the most popular iPhone
models of all time, with a
total of 222.4 million sold.
That includes a staggering
4 million units sold in Apple
Stores on the launch day.

The iPhone 6 was
considered a significant
upgrade on previous models.
The 6 Plus, with its 5.5-inch
screen, was the first Apple
handset with a larger display.

The iPhone 6 was not
without its own controversy
though - Apple admitted
that it was the key device
on which it intentionally
slowed the processor.

While the number of people taking advantage of
such a programme is likely to be relatively
small, it all contributes to a slowdown in people
wanting to buy the newest device.

Tech website ZDNet crunched some
numbers back in September 2020 and found
that iPhone unit sales - the numbers of iPhones
actually sold not the amount of money Apple
makes from the sales - has been dropping for
afive-year period. As time has gone on, we’ve
heard stories of Apple asking its manufacturers
to decrease production of, or even stop making,
certain models and focus on others, presumably
the ones that are selling better. For example, in
October 2022, production of the iPhone 14 Plus
was slashed following poor demand for the
oversized device that had all the same features
of a standard iPhone 14. A similar fate befell the
iPhone 12 mini back in 2021. Furthermore, it
looks like we won't get to see a next generation
of iPhone SE at all; in January, well-known
analyst Ming-Chi Kuo wrote that the model
had been cancelled altogether.

This all puts Apple in something of a bind -
while some feel that there’s too much similarity
between models, it would appear that handsets
with some level of (design) differentiation do not
do well. And it seems there is not much appetite
for playing with the size of the iPhone, after all.

Crisis? What crisis?
Obviously, the iPhone remains wildly popular
around the world. It is worth reiterating the stat

»Image credit: Apple Inc



from earlier - there are 2 billion active Apple
devices out in the wild. Sales in crucial markets
like India continue to increase; according to the
Hindustan Times, it was thought as many as 7
million iPhones could have been sold in India
in 2022, and the iPhone has gained 10 million
users in the country over six years.

As Tim Cook indicated, iPhone production
is now expected to be back at its usual level,
which should help improve shipments. There is
also some hope for a positive turn in economic
conditions, which may give people more money
to spend on items like new iPhones.

iIPhone popularity APPLE CORE

¥

Apple has committed to producing
long-lasting, quality products
which is great for the environment
and our pockets, but not so good
for the company's bottom line.

While we are still some time away from the
iPhone 15, that has not stopped the speculation.
MacRumors report that there is likely to be
something of a redesign, not least because of
a shift from Lightning port to USB-C. While
some may be put off by the prospect of having
to buy adaptors or new accessories, significant
improvements could encourage some to finally
consider a new upgrade.

The cameras always improve with each
new iPhone and this year will be no different.
Indeed, Ming-Chi Kuo thinks the top-end
iPhone 15 model could offer an updated
‘periscope’ telephoto lens. Other potential new
features include solid-state surfaces on the side
of the phone instead of physical buttons, using
additional Taptic Engines to provide haptic
feedback. Bloomberg News’s Mark Gurman
reported that there may be an iPhone 15 Ultra.
This could simply be about aligning the name of
the top-end iPhone with the Apple Watch Ultra,
but it could also signal a more rugged device
designed for heavy use outdoors.

If the mooted features come to fruition, they
will contribute to making the next Apple iPhone
avery tempting option, particularly to anyone
who has held on to an older model.

In reality, the iPhone is not going anywhere
anytime soon. The world’s biggest technology
companies have all had a difficult time in recent
months and the recent set of Apple financial
results have finally showed even it is not
immune to market factors. Depending on those
rumoured new features, the next generation of
iPhones may well see booming sales for Apple's
popular handset once again.

Groundbreaking iPhone models

The release of the first iPhone was hugely significant. Since then, there have been some other key generations

iPhone X

iPhone 3GS iPhone 6/6 Plus iPhone 12
> Fast (for the time) cellular > A redesign helped this > Goodbye Home button, hello >The first iPhone with an
connectivity, allowing users become the biggest selling Face ID. A huge innovation in Al14 Bionic chip and 5G

to better browse the web.

iPhone. (See left.)

both design and technology.

connectivity.
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ICLOUD

TIPS

From humble beginnings as MobileMe, Apple’s
iCloud service has grown into an excellent facility,
But what is iCloud, and what can it do for you?

Written by lan Osborne

pple's iCloud was

launched in June

2011, replacing the

unsuccessful MobileMe
service. As well as an iCloud email
address and 5GB of free online
storage, it brings a range of free
services such as syncing your
Contacts, Calendar, Reminders, Notes
and Messages apps between your
Apple devices, storing and syncing
documents and data on iCloud Drive,
real-time collaboration on Pages,
Numbers and Keynote projects and
the ability to locate your Apple gear,
items such as AirPods and AirTags
and even other people.

The service also powers a lot of
features offered by macOS, iOS and
iPadOS. Your passes and cards stored
in Apple Wallet, for example, are kept
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in sync across your devices using
iCloud, with no user intervention
needed. This is also the case for your
Apple Home settings and devices,
Safari bookmarks, iPhone call
history, Siri settings and interactions,
Books app highlights, bookmarks,
annotations and books, and more.

It can even sync your passcodes and
passwords using iCloud Keychain.

Yet there's so much more to
iCloud than syncing and data storage.
Apple's famous service can also
access key Mac, iPhone and iPad
apps through any computer with a
web browser, offers online storage
and extra services (for a monthly fee),
and provide security services such
as Private Relay and Hide My Email.
Let's take an in-depth look at Apple's
iCloud, and what it can do for you.
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[ 108 iCloud tips ]

What is iCloud?

In a nutshell, it's a range of services made possible by connecting your computer
or mobile device to Apple's servers. Here's a breakdown of these services

Photos

> Using Photo Stream, iCloud can store
your most recent 1,000 photos for up
to 30 days. They then sync with all
your Photo Stream-enabled Apple
gear. iCloud Photos goes further and
stores every photo and video you take
on the cloud, syncing data and edits as
well as the pics themselves. You can
use the Optimise Storage option to
keep low-res versions on your devices
and high-res copies on iCloud.

Kkud Drive B = sken s

iCloud Drive/Files

>On a Mac, you can access iCloud
Drive storage space by using the link
in a Finder window's sidebar, or by
selecting iCloud Drive from the
Finder's Go menu. On an iPad or
iPhone, you open the Files app and
select iCloud Drive in the Locations
section of the sidebar. Either way, you
see the files and folders you have
stored on iCloud. It's obviously great
for syncing documents.

Two-Factor Authentication
> Your Apple ID and iCloud facilitates
two-factor authentication (2FA), a
security feature that makes it harder
for someone to impersonate you
online. When you sign into your Apple
ID for the first time on a new device
or online, you're asked for an
authentication code. This is delivered
on one of your other Apple devices
signed into the same Apple ID. Type it

in and you're logged into your Apple ID.
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Invite Family

Family Sharing

Family Sharing
> Using Family Sharing, you can share
your purchases such as apps, media,
books and streaming services with up
to five family members. When, for
example, you buy an album on iTunes,
it becomes available to everyone else
in your family group without their
buying it separately. You can have a
family photo album shared between
all members too, and even find each
other's devices.

Application data

> On a Mac, open System Settings from
the Apple menuy, and click on Apple ID
at the top of the left-hand sidebar. On
an iPhone or iPad, open the Settings
app and tap your name at the top of
the screen or sidebar. You can then
choose which of your applications
sync their data through iCloud. Use
the switch to the right of each app's
name to turn iCloud syncing on and
off for that particular app.

Private Relay
> If you pay for extra iCloud storage,
including through subscriptions to
services such as Apple One, you get
extra features collectively called
iCloud+. One of these features, Private
Relay, hides network info such as your
IP address and DNS records when
browsing online. Go to the Apple menu
> System Settings on Mac, or Settings
on iPhone/iPad, tap/click your name,
tap/click iCloud to switch it on.

Image credit: Apple Inc
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iTunes

>Using the iTunes Store app, you can
purchase music and media to use on
your Apple gear. This is then made
available on every Apple device
signed into your iCloud account, and
even PCs, Microsoft Surface tablets
and more using iCloud for Windows.
If you subscribe to iTunes Match, you
can sync music ripped from your CDs
too. You also can download music and
videos for offline entertainment.

ICloud Backup

i0S/iPad0S backups

>In Settings, tap your name at the top
of the screen (or the sidebar for iPads
and large iPhones in landscape mode),
then tap iCloud on the right-hand side.
Here you see an option called ‘iCloud
Backup', which lets you back up your
device to the server. You can turn
automatic backups on and off, choose
whether to allow backups over mobile
data (if available) and opt to back up
immediately.

Find My

>What do you do if you lose your
iPhone, leave your MacBook on the
bus or mislay your iPad or AirPods?
With Find My, you can see where they
are. Open the Find My app, on a Mac,
Apple mobile device or on the web
at iCloud.com, and you can find the
location of Apple devices signed into
your Apple ID, mark them as lost,
make them play a sound and even
wipe them remotely.

Access anywhere

>You can access your key iCloud apps
online, from any computer or mobile
device that has a web browser. Just
point it at iCloud.com, and sign in with
your Apple ID and password. You can
then access apps synced in iCloud
such as Contacts, Notes, Mail, Photos,
Reminders, Keynote, Numbers, Pages
and more. It's great for getting hold of
your important data when you don't
have an Apple device nearby.

[ 108 iCloud tips

What iCloud is not

It won't back up your Mac

iCloud is an excellent way of backing
up your iPhone and/or iPad onto the
cloud, but it won't do the same for
your Mac. To back up a Mac notebook
or desktop, you can use Time Machine
and an external drive. Alternatively,
you can clone your internal drive
using an app like SuperDuper! or
Carbon Copy Cloner.

It's not unlimited

For all its strengths, iCloud is not
an unlimited storage service. You're
limited by the capacity of your own
particular service which, unless
you've paid for more, is 5GB. You
can't upload files larger than 50GB
either, which might be an issue if
you work with very large files.

It's not invulnerable

Files and data uploaded to iCloud
Drive are stored on Apple’s servers.
These are very secure; data is
end-to-end encrypted except Mail,
Calendar and Contacts, which have
to conform to industry standards.
iCloud data is not, however,
invulnerable. Nothing is.

What are iCloud
storage tiers, and
what's included?

When you sign up for an Apple ID
you get 5GB of iCloud storage for
free. If you need more, you can pay
a monthly subscription for more.

A paid-for iCloud service also brings
you the additional features of
iCloud+. A subscription to Apple
One also gives you iCloud+.

Capacity Price Per Shareable
Month
56B Free No
50GB £0.79 No
2006B £2.49 Yes
2TB £6.99 Yes

APRIL 2023 | MACFORMAT | 19


https://www.icloud.com/
https://www.icloud.com/

iCloud Photos is available on
Macs, iPads and iPhones, and

can be viewed on Apple TV.
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iICloud Photos

You can keep all your snaps and clips synced across your Apple devices, and more

he iCloud Photos service is your albums - self created and automatically
heavily integrated into the generated - from your Photos app are also
Photos app on Macs and Apple carried over to the iCloud Photos service.
. mobile gear. With iCloud Photos
iCloud Photos active, every photo you take is automatically Make space
on Apple TV uploaded to your iCloud account and synced If storage is getting low on your mobile gear,
» To view iCloud Photos on with other Apple devices signed into your you can switch on the Optimise Storage
your Apple TV, first open the Apple ID. You can thus enjoy your photos feature. From then on, full-resolution copies
Settings app. Go to Users and videos on all your Apple gear, regardless of your media are kept on iCloud, and
and Accounts > [your name] of which device they were taken on. lower-res versions are shown on your Apple
> Photos and turn on iCloud Features such as Memories, People and devices, from where you can download and
Photos. You can then review edits you've made are synced between your open them at will. Just make sure you have
your photos and videos by Apple devices. Edit a photo on your Mac, and lots of storage space on your iCloud account
opening the Photos app, the edited version also appears on your iPad if you take a lot of photos. Of course, there's
navigating to the picture, video and iPhone. When you access your photos another option. If you only want to sync
or album you wish to view with on the iCloud website, they're organised recent photos and videos, there's My
the remote and then clicking. according to the date and time taken, and Photo Stream which can do it for free.

Sharing photos, videos
and large files in Mail

| andsend it. The attachments
| are stored oniCloud. When
l the recipient gets the email,
a limit on file sizes that can be sent l the attachment is replaced
in this way. Thankfully, iCloud comes ) with a link that allows them

l

l

l

|

Sending large email attachments can
be problematic. Some - maybe most
- internet service providers impose

Use Mail Drop to send large attachments via email.

account, click the box marked ‘Send
is accessible for 30 days. large attachments with Mail Drop’. On

to the rescue with Mail Drop. to download it, and it the link |
I

On a Mac, to turn on Mail Drop in I an iPad or iOS device, just tap Use Mail
I
1

With Mail Drop, you can send
attachments of up to 5GB, regardless
of what device you're using. Just attach
the files to your email in the usual way

Mail, open its Settings (under the Mail Drop in the menu that pops up when
menu), click Accounts and for each you try to send large attachments.
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iCloud Photos on Mac

To turn on iCloud Photos on a desktop
or notebook Mac, first open the Photos
app, and under the Photos menu bar
option, open Settings. Under the iCloud
tab in the Settings window, check the
box labelled ‘iCloud Photos’.

Drive
5
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Access on iCloud.com
With iCloud Photos turned on,
you can access your media online. Open
the iCloud website at iCloud.com from
any computer with a web browser and
internet access, and click the Photos
option on the home page.

Edits and delete

When you have iCloud Photos
active, edits you make to a photo are
synced with other devices using iCloud
Photos. If you delete a photo on one
device, it's deleted from all your other
iCloud Photos devices too.

108 iCloud tips

HOW TO Share your photos and videos >

iCloud Photos

«©

Automatically upload and safely store all your phetos

iCloud Photos on iPhone
On an iPhone, first open the
Settings app. Scroll up until you see the
Photos option, then tap it. On the next
screen, shown here, tap the switch
marked ‘iCloud Photos' to turn on
the iCloud Photos service.

5 Optimise storage

There's an option next to the iCloud
Photos setting outlined earlier called
Optimise [Device] Storage. If you switch
this on, only low-res versions of your
media will be stored locally, with full
resolution versions on iCloud.

If you don’t want to use up iCloud
storage space with your photos but
would like to sync them between your
devices, My Photo Stream stores and

syncs the last 30 days of pics and
videos, to a maximum of 1,000 items.

iCloud Photos on iPad

It's a similar story on your iPad.
Go to Settings, then tap Photos in the
sidebar and turn on iCloud Photos. With
this switched on, your photographs and
videos are uploaded to iCloud, and
synced between devices.

Add to Shared Album ol
Addel te Album =
Alrlay [
Usz &5 Wallpaper (]
Copy Gk Link e
Sawe Lo Files =
Assign to Contact ]
Print =
Sharing photos

To share a picture, open it in Photos
and tap the Sharing icon. In the pop-up,
tap Copy iCloud Link. You can then
paste that link into Mail, Messages or
elsewhere, and share it. The recipient
gets a thumbnail which can be opened.

My Photo Stream is free, and storage
taken up by syncing your photos
doesn't count against your iCloud
storage space. Edits made to pictures
synced with My Photo Stream are
not synced with other devices.

e
€
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08 iCloud tips

Files, Documents & iCloud Drive

iCloud Drive is great for storing and syncing files and documents, and collaborating

What about
hared

with You?

» If someone shares something

with you in the Messages app,

you can access it using its

native application. A web link,

for example, appears in Safari

and a news item in News.

Other Shared with You apps

are Music, TV, Photos and

Podcasts. Open one and in

its sidebar, you see an option

called Shared with You. Tap

it to see shared items.

hether you have the 5GB you
get free when you sign up for
an Apple ID or pay a monthly
subscription for more space,
iCloud Drive is like having an external hard
drive that's accessed through the internet.
But it's so much more too.

When a document or file is on iCloud Drive,
it's synced with all your other Apple devices, so
you can (for example) create a document on
your Mac, leave the house and edit it on your
iPad on the train to work. You can even share
it with other people directly from the cloud, or
work together on collaborative projects with all
edits synced between all users. Because your

contents on iCloud Drive are stored online,
they're accessible wherever you are in the
world. As long as you have internet service,
you can use iCloud Drive. You can even use
it from non-Apple devices, by heading to
iCloud.com. All you need is a computer, tablet
or smartphone with an internet connection
and a browser. And while nothing on the
internet is invulnerable, iCloud Drive is very
secure, with end-to-end encryption on for most
of your data and in-transit and on-server
encryption for Mail, Contacts and Calendar.
Heavily integrated into Apple's apps
and tech, iCloud Drive is an indispensable
cloud service for Apple users.

EXPLAINED Find your way around the Files app >

= 69% -

Q Search

Movies to Look
Far
03062020, 2111 pm
202 KB

Nicolas Cage
Filmography
141032016, 10:57 am
TED KA

=0

Papercut
Address Label
28/11/2022, 2:05 pm

3:08 pm Mon 16 Jan ase
il o @) < Pages ~ EF B8 select
Files B a =
@ LR Liz macOS High Making Music Marvel Metflix

o 14/06/2021, 5:12 pm Sierra A...nds Oz 30/09/2021,12:54... Shows in Order
Ii Shared 15/09/2017, 3:27 pm 23.3 MB 07(11/2021, 2:09 pm
Download Now D B44 KB 168 KB
Locations ~
Get Info @ e
[] onMyiPad &
Rename /s
@ iCloud Drive e
Compress g NB64 Neue Blro Next month copy
K- Keep It 1/08/2018, 2.16 pm 10/10/2021, 3:49 pm 22/10/2021, 1216 pm
Duplicate 260 KB 166 KB 143 KB
1l] Recently Deleted
Quick Look @
Favourites ~  New Folder with ltem 9 = b
(1) Downloads Tags 16 E "
> Notes for the Odd Jobs Old book stuff
ags ~ Copy @ new magazine 17/07/2016, 2:34 pm 11 items
= 5/01/2019, 3130 pm 100 KR
The sidebar iCloud Drive Contextual menu Not downloaded

»In the Files app, open
and close the sidebar
by tapping this icon.
The".."icon gives
more options.

>In the sidebar, tap

iCloud Drive to be
taken to the folders
you have stored in
your online storage.
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>Tapandhold a
document or folder
for a contextual
menu of options,
including Delete.

»If a document has

a cloud in its top-
right corner, it's not
stored locally. Tap it to
download and open it.

Folders

» You can add folders
to iCloud Drive,
including within other
folders, just like on

a Mac's storage drive.

»Image credit: Apple Inc
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HOW TO Collaborate in iWork apps and Notes >

108 iCloud tips

=

New features

Apple introduced new Collaboration
features in macOS Ventura, iOS 16 and
iPadOS 16. These let you collaborate
on documents in the iWork apps; Pages
(word processor), Numbers (spreadsheet)
and Keynote (presentations).

iill, Book Sale ==

reae -~

Collaborate with others
Click/tap the Sharing icon in the
top bar for a new menu. From the menu,
select the Collaborate option; Send
Copy enables you to send a copy of
the document without giving the
recipient collaboration rights.

7 Latest activity

After sharing the document (you
can share with up to 100 people), all
people can see the latest updates to a
collaborative document, read a list of
everyone's changes and get notifications
regarding changes and notes.

k Sale

Turn on iCloud Drive

Here we're using Pages on a Mac,
but these tips hold true for all three
iWork apps and i0S/iPadOS devices.
Make sure iCloud Drive is turned on.
So to Settings/System Settings > [Your
Name] > iCloud and make sure it's on.

Open document

Open the document you wish
to collaborate on, or start a new one
if necessary. Make sure it's saved in
your app's iCloud Drive folder, as it
needs to be there if you're going to
share and collaborate on it.

Create a link

Using the Create Link sharing
option, you can create a link which you
can send to whomever you choose. Enter
the names of the people you want to
authorise, then tap/click Copy Link to
have the link saved to your clipboard.

Establish rules

Click the chevron under the
Collaborate option for two further
menus; these enable you to set rules
about who can edit it. They're self-
explanatory. Set it up however you like,
then choose how you wish to share it.

Firsi Editions

Review collaboration 9 Manage sharing

Click/tap the Collaboration icon in Tap/click the Collaboration icon
the toolbar. Show All Activity lets you see then Activity Settings to set notifications
all edits, according to the person who and permissions. The Manage Shared
made them. The chevron next to each Document option shows who's sharing,
activity opens it for more information and lets you add or remove participants.
regarding each change. You can stop sharing here too.
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Get started with iCloud.com

The iCloud website recently had an overhaul. How does it work and what can it do?
access iCloud services. You

can do so from any computer,

tablet or smartphone with a web browser and
an internet connection, regardless of what
operating system it uses. Just go to iCloud.com
and log in with your Apple ID and password.
The iCloud website gives access to your
files and folders stored on iCloud Drive. It also
offers online versions of several key Apple
applications. If you need to edit or share a
Pages, Numbers or Keynote document, you
can. You can check your email in Mail, get a
phone number from Contacts, review your

Remove old

and unwanted
devices from
your Apple ID

»If you have Apple devices you
no longer use associated with
your Apple ID, you can remove
them. Open the System
Settings app (Mac) or Settings
(iPad and iOS devices), and tap
your name at the top of the
list. Scroll up to the list of your
Apple gear, tap/click on any
you no longer use and use the
'Remove from Account’ link.

ou don't have to have one of
your Apple devices handy to

Notes, look at and create Calendar events and
more. It even has an online version of Find My,
so if your Apple device is lost or stolen while
you're out and about, you can locate it.

The website has recently had a makeover.
Instead of being offered only the app icons on
the Home page, it's now laid out in widgets,
which you can edit by scrolling up and clicking/
tapping the Customise Home Page button.
Widgets for Notes, Mail and iCloud Drive give
instant access to recent emails and documents,
recent pictures are shown in the Photos widget
and if you scroll the page, you can review your
iCloud plan, check on your storage and recover
recently deleted items for up to 30 days.

EXPLAINED The iCloud.com interface »

“ Fhotos

6867 Snokes, 08 Video:

Find people & things

with Find My

Open the Find My app

on iCloud.com and you

can locate Apple devices

signed into your Apple

ID. This can include your

Mac, iPhone, iPad, AirPods

and AirTags, and friends

with Apple devices. Their

location is shown on a map,

and you can remotely wipe s e st e bt
devices over the internet - ) 7 ki i b mieri.
handy in cases of theft. & B

Apps menu Create new

> This icon gives access
to online apps, iCloud
storage options and

if you pay for iCloud,
iCloud+ features.

> Open a new email,
note, calendar
event, reminder, or

a document in Pages,
Numbers or Keynote.
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Account settings

» Click/tap this widget
for details about your
iCloud package and
storage plan, and links
to manage them.

App Widgets

> These give instant
access to recently
opened docs or media
in Photos, Mail, iCloud
Drive and Notes.

App icons

» Click/tap an icon in
this widget to open
and use the browser
version of the app
in question.

»Image credit: Apple Inc
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With iCloud, you can back up
your mobile gear to the cloud
and then restore from a backup
later if necessary.

Backups, syncing and security

Find out how to sync your data across your Apple gear, and how to keep it secure

What is Cloud+?

> An Apple ID gives you 5GB
of iCloud storage, which
includes all the backup and
syncing features discussed
in this article. But if you pay
for more storage through a
monthly subscription (including
an Apple One subscription), you
get extra features, collectively
known as iCloud+.

Obviously, one of
the benefits of an iCloud
subscription is more storage.
You can get up to 2TB,
depending on your plan.
Other benefits are iCloud
Private Relay, the Hide My
Email service, a Custom Email
Domain, HomeKit Secure Video
support and Family Sharing.

LRI R R T

A paid subscription gets you more
storage space, and extra features.
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sing the iCloud service to back
up your iPad and iPhone is easy.
First of all, open the Settings app.
At the top of the list (iPhone,

iPod touch) or in the sidebar (iPad, plus-sized
iPhones) tap your name to get to the Apple ID
screen. Tap iCloud, then iCloud Backup. On this
screen, you can turn on iCloud backups using
the switch. If your
device has cellular
connectivity, you can
choose whether to
use it for backups,

or restrict yourself to
backing up over Wi-Fi
to save mobile data.

Erase This iPhone

Erasing will sign cut of your Appla I and
remave your persanal data, so this iPhone
can be safaly lradad in or given away.

set up your device again, reinstalling a backup
during the setup process. Note though: Macs
are not backed up over iCloud.

Sync and security

iCloud is great for syncing data and documents
across your Apple devices. See the step-by-
step guide opposite for details. With your
devices synced, edits made on one
device are carried over to the others.
Make a new note on your Mac, for
example, and you can review it on
your iPhone or iPad. If you then edit
it on your mobile gear, the edit is also
shown on your Mac's Notes app.
Names, addresses and details

The following items will e safely removed

You can also tap an
option to back up there
and then instead of
waiting for a reqular Ao
backup time. Tap one

of the backups to see

a list of apps that are
taking up space. You
can switch off individual
apps, so they won't

Apps and Data

BZ73CE

Fimd My

ctivation Lock

Apple Wallet

be backed up. -
To restore froma _
backup, go to Settings > Not Now

General > Transfer or
Reset [Device], then tap
Erase all Content and
Settings. You can then

tram this iPhore:

To restore from an iCloud backup,
you must erase your device and
go through the set-up procedure.

entered into your Contacts app and
events made in the Calendar app
show up on every device, and online
passwords and usernames are
synced through the iCloud Keychain.
iCloud is as secure as it can be. It
facilitates two-factor authentication
(2FA), by which when you sign on to
a device with your Apple ID you're
asked to input a code sent to one
of your other devices. The majority
of iCloud data is encrypted end to
end, with the exception of the Mail,
Contacts and Calendar apps, which
use industry standards that preclude
such encryption. They're encrypted
In transit and on server instead.

»Image credit: Apple Inc




1

HOW TO Sync your data across your devices >

08 iCloud tips

Click on name (Mac)

To sync your apps on a Mac, first open
System Settings from the Apple menu in
the top-left corner. In the System Settings
window, click on your name at the top of
the left-hand sidebar.

b Messages
¥ Health
| Contacts
23 Calendars
Reminders

6 Safari
4 Sync apps (iPhone)

iCloud+ options are listed in this
window. To get to your apps, tap Show All
in the Apps Using iCloud section. On the
next screen, turn on every app you wish
to sync between devices in iCloud.

)
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2 Sync applications (Mac)
If you have iCloud+, you can access
its features here. To sync applications,
scroll the window up and check whether
syncing is on. If it's off for an app you
want to sync, click its switch to turn it on.
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And on iPad...

Things are similar on an iPad. Open
Settings, tap your name at the top of the
sidebar. On the next screen, tap iCloud,
then Show All. You can turn on iCloud
syncing for your apps here.

Passwords, Passkeys and 2FA

One of the apps you can sync in
iCloud is Password & Keychain. If you
sync this, online passwords are synced

between your devices. This is useful if, for

example, you use an internet forum on

your Mac, your iPhone and your iPad. You

no longer have to log in on every device

separately; your passwords are saved,

and accessed with Face ID or Touch ID.
Passkeys are the next generation

of passcodes. They're powerful

cryptographic techniques and the

biometrics built into your device to

enable you to log into a website, make an

online purchase and anything else that
requires a login ID and a password
without typing anything. They're synced
through iCloud so a passkey created on
one device functions on them all, and
they're super-secure, being invulnerable
to key loggers, hacks and phishing sites.
2FA, or two-factor authentication

keeps your Apple ID secure by asking for

a passcode when you sign in, which is
delivered to another of your Apple
devices by message or phone call.

Payment & Shipping Visa

Subscriptions

» iCloud 50 GB
w Media & Purchases

{?; Find My

Tap on name (iPhone)

On an iPhone, first of all, open the
Settings app (the one with a grey cog on
the icon). Again, tap your name at the top,
and then tap the iCloud option on the next
screen. It's near the top of the options.

And online...

When your apps are syncing
through iCloud, you can access many of
them online at iCloud.com. Any changes
or edits you make through the web portal

are then synced to your devices.
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Family Sharing

Share your apps and media with your family, and enjoy theirs too

What is

Apple One?

> Apple offers a bundle of its
subscription services available
at a single monthly price.

It's called Apple One, and it's
available in three tiers. Individual
offers Apple Music, Apple TV+,
Apple Arcade and iCloud+ with
50GB of storage. Subscribers

can share all except Apple Music
with a family group. Family offers
200GB of iCloud+ storage and all
services can be shared. Premier
throws in News+ and Fitness+ and
2TB of storage. Again, it can all be
shared with your family.

What about iTunes Match?

Another subscription
service available for music
lovers is iTunes Match. For
£21.99/year, iTunes Match
uploads the contents of your
Music app to the cloud and
makes them available on all
your devices. This is the case
whether your songs were
bought digitally or ripped
from your CD collection.

ith Family Sharing, you can
set up a family unit of up to six
people. Your family then get to
share media, apps and more. If,
for example, the kids all want the same game,
you only have to buy it once. Everyone in your
family group can download and enjoy it. If you
purchase an app, the rest of your family can
install it on their own devices without buying
it again. If you all want to read the same book
or listen to the same album, no problem. You
only have to buy it once.

You can also set up a shared family photo
album so all your family members can view,
add to and edit family photos. If you pay for
extra iCloud storage space, you can share it
with your family group and if you subscribe

On a Mac, subscribe to
iTunes Match by opening the
Music app and clicking on
iTunes Store in the sidebar.
Scroll all the way to the
bottom of the iTunes Store
window, and in the small links
at the bottom, you'll see
‘iTunes Match'. Click that
link and follow the steps

to subscribe. iTunes Match makes your music accessible on all of your devices.
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Set up Family Sharing and
you can share purchases
and subscriptions, and
use parental controls.

Applein

Family Sharing

Sharz yaur sabeeriptions and musle, mesde and other media surchases
Wit Uz o P peaple

isa
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#

to the Apple Music subscription service, for
a little extra you can upgrade it to a family
subscription which everyone can enjoy.
Subscriptions to Apple News+, Apple TV+
or Apple Arcade can always be shared,
with no subscription upgrade necessary.

Parental checks

When you have a Family Sharing group, you
can set up an Apple device for a child. You

can turn on Ask to Buy, so the child must get
parental approval before making a purchase,
make sure they're not accessing age-restricted
material and more. You can also set up Screen
Time for the children’s devices, setting
downtime and making sure they're not
spending too much time on social media.

iTunes Match
Millisns of Sengs to Mateh A ! h
S REEE
SEHEREEL
POl e = 14

Listen at 256 Kbps DRM-Free

»Image credit: Apple Inc




HOW TO Set up and manage Family Sharing >

108 iCloud tips

‘I Open System Settings
We're setting up Family Sharing on
a Mac here, but if you need to use an
iPhone or iPad instead, the procedures
are basically the same. From the Apple
menu, open System Settings. (For iOS,
click on Settings then your name.)

Create a child account

If you want to create an account
for a child and oversee it with parental
controls, open System Settings and click
Family under your name. Click the Add
Member option, then click the Create
Child Account button.

| [

7 Complete child account

Follow the on-screen instructions to

complete your child's account. Set their
password and iCloud email address used
for Apple ID. You also set whether your
child’s location is shared with family
members using Find My.

2 Set things up

Click on your name at the top of the
window's left-hand sidebar and then, on
the right, click Family Sharing. You'll see
a screen outlining the advantages of
having a family account. Click the Set

Up Family button (bottom right).

] MESO a
T

Confirm adult status

A child account will remain part of
your family unit until he or she is at least
13 years old. To progress setting up a
child account, you must prove you're
an adult, so click the ‘Verify You Are
an Adult’ button in this window.

Set screen time

To set up the child's Screen Time,
on your Mac, go to the Apple menu and
open System Settings. Click on Screen
Time in the sidebar, and use the menu
to access your child's account. Turn on
Screen Time, and set it up as you see fit.

ZEEC O
B ® =
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00 ODLEEE
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Invite family members

You're then shown if you have
subscriptions you can share. Click the
Invite People button and follow the
on-screen instructions to invite family
members to join the family group
you're setting up and managing.

Verify with card

Verify you're an adult using the
security code for the credit card you use
for your Apple purchases. This is purely
for verification; you're not charged for
anything. After typing it in, click the
Continue button.

Remove a child's details

To remove a child from a family
account, go to System Settings > Family >
[Their Name]. You'll see a ‘Remove from
Family Sharing’ option. If the child is
under 13, this option is greyed out; they
can be transferred, but not removed.
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Subscribe today and get a set of
EarFun Free Pro - the world’s smallest
active noise cancelling earbuds

> Excellent
isolation

> Low Latency Mode
improves video and
> Customised gaming experiences

noise cancellation

> Single earbud mode
- for right or left
independent use

> Fast charging,
10-min charging =
2 hours' playtime

> 40-min full
charging = 32
) hours’ playtime
> Wireless
charging
compatible

Call or visit our website...

www.magazinesdirect.com/mac/B44F
Or call 0330 333 1113 and quote '‘B44F’
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>Master Apple
shortcuts

macO0S

»(3¢) is the Command key, which
is also labelled cmd.

» =) means the Option key,
labelled alt or opt.

»[a] means the Control key,
labelled ctrl, and shown as *
in shortcuts in the menu bar.

> (o) is the Shift key.

»[<] is the Delete key, which
deletes to the left. [in|+<|
deletes to the right.

» > is the Tab key, which shifts
the focus between some
controls.

i0S

» A tapis a brief contact of
(usually) one finger on your
device's screen.

>To dragis to move a finger
across the screen to scroll

or pan around content.

> Swipe means move one or
more fingers across an item
or the screen, then let go.

> A flick is like swiping, but it's
quicker, and is often used to
scroll content more quickly.

» Pinch means move two
fingers together or apart,
usually to zoom in or out.

> Touch and hold means lightly
rest your finger on an item
and wait for a reaction.

»Image credits: Apple Inc
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Secret headphone app

NEW
IDEAS

Your in-depth guide to
getting more from
your Apple kit

Contact us

Email your queries and
your questions to
letters@macformat.com

COLLABORATE WITH OTHERS

WHAT'S INSIDE
I

34 COLLABORATE WITH OTHERS

> Brainstorm with colleagues using Freeform

36 BOOST YOUR PRODUCTIVITY

>Use Notion to organise work and play activities

38 EDIT YOUR PDFS
> Adjust, sign and annotate with PDF Expert

40 USE CONTINUITY CAMERA

> Transform your iPhone into a webcam

42 WORK WITH MASTODON

>Introduce yourself to the Twitter alternative

44 MASTER iOS VIDEO CONTROLS

> Use different shooting modes and file formats

00:00:00

Max

46 CONNECT EXTERNAL DEVICES
» Attach external hardware to your iPad/iPhone

48 MAKE AND TAKE CALLS
» Call and chat with friends using Apple Watch

50 HOW IT WORKS
» Spatial audio and dynamic head tracking
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CoHéBorate with Freeform

Freeform is the ideal tool for brainstorming with colleagues remotely

IT WILL TAKE
» 30 minutes

YOU WILL LEARN

» To use collaboration
features in Freeform
and beyond

YOU'LL NEED
»macOS 13 or later,
i0OS 16 or later

Apple has been adding
collaboration and sharing
features to macOS, iOS and
iPadOS for several years now,
including allowing you to work with others
in applications like Pages, Numbers, and
even Notes. But it's a new Apple application,
Freeform, where some of the most interesting
opportunities to work with others lie.

In some ways, it's a surprise that Apple, a
company whose roots are in making products
for creative professionals, took as long as it

HOW TO Get started in Freeform »

has to release software that provides tools
to help kick-start the creative process -
essentially creating the digital equivalent
of a meeting room and a whiteboard.

And Freeform has had a difficult start.
It was delayed several months, having
originally been slated to launch with the
release of i0S 16, iPad0S 16, and macOS
Ventura. However, now that it's here, it's
easy to see how it could quickly become very
popular, particularly among creative teams
who work remotely. Kenny Hemphill
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'I Set up collaboration

To start collaborating, you need

to turn on iCloud in Freeform. Launch
Freeform on your Mac, click Shared in
the sidebar, then click ‘Go to Settings'.
In Settings, click iCloud, scroll to
Freeform and switch it on.
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2 Finish setting up iCloud
If you have already used Freeform
on an iPad or iPhone and have created
boards, it will now ask you if you want to
merge your Mac-based Freeform data
with your iCloud Freeform data. To do
that, click Merge.

3 Manage shared board

To edit sharing settings, Ctrl-click on
the board and choose Manage Shared
Board. In the window that opens, click
the ‘+' button to share with more people
and use the options to control how the
board can be edited.

»Image credit: Apple Inc



Collaborate with Freeformm APPLE SKILLS

HOW TO Collaborate using Messages »

I headphone app

a

1 Share in Messages
If you use Messages to collaborate

on a Freeform document, you can see

updates in Messages when someone
makes changes. Open the Freeform

board you want to share, click the Share
icon in the toolbar and choose Messages.

.

Choose collaborators Set the parameters

When Messages opens, you'll You can add more collaborators
see a new message with a link to the by adding more names in the Send
Freeform board. Start typing the name field. Next, click the text below the
of the person you want to collaborate thumbnail of the board and choose
with in the Send field. Choose a contact how you want to share the board and
from the list that appears. the permissions for collaborators.

HOW TO Go deeper with collaboration »

] See others’ work

In a board you're collaborating on,
click the head-and-shoulders icon to

see collaborators. Check Participant

Cursors. You'll see the additions they
make. Participants can only undo and
redo their own changes.

2 Add more people Remove collaboraters
Click the head-and-shoulders icon To remove a collaborator, in the

on the board to add people and choose Manage Shared Board dialog, hover the
Manage Shared Board. Click Share With pointer over their name, click *..." and
More People. Choose a suggested choose Remove Access. To stop sharing
person or click on an application a board altogether, click Stop Sharing
to share the board. at the bottom of the box.

Collaborate in other apps
Working with others made simple »

Pages, Numbers, and Keynote all allow you to share documents with others and
collaborate with them. Those you allow to do so can make changes to documents
or add comments, and you can see those changes summarised the next time you
open a document. Notes also now allows you to collaborate the same way. All
these apps use a Share menu to start the collaboration; you just choose how to
want to collaborate and who with and they will be sent a link. Photos goes even
further, enabling you to create a shared library with friends and family.
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Boost your productivity

Use Notion to help you organise both work and play acitivities

IT WILL TAKE
»15 minutes

YOU WILL LEARN
»>How to create and
manage pages and
databases in Notion

YOU'LL NEED

> Notion (Free,
with IAPs), macOS
10.12 or later

Tired of trying to manage your
work and personal projects in
a multitude of different apps?
Instead of juggling the likes of
Dropbox, Airtable and Trello, try Notion. It can
handle anything you throw at it, from simple
text documents to sprawling databases with
countless contributors, and is super-simple
to use no matter what you want to do.
Notion’s key strength is its ease of use. It
comes with a friendly interface that lets you
drag and drop items, create databases and

tables with just a click, and collaborate using
tags and comments. That means you can
plan your next holiday or keep track of your
work assignments without a steep learning
curve or having to switch apps.

Despite its extensive feature set, Notion
is totally free to use. You can pay for some
extra tools like more space for uploads and
extra guest slots, but for most people that's
not necessary. Getting all its best features
for free is the cherry on top.

Alex Blake

HOW TO Manage your tasks with Notion »

'] New Page

Click New Page and add a title. If you

My i paga

My first page

This iz a cortent bleck

4 Here'sanaties bloce
=

2 Click and drag

Centart blecka can be almest aything, cluding text, tabiles, mages, and mo

Start a new blank doc and start

just want to get started, press Return.
Otherwise, pick a template and click
‘Get template’ to add it. You can also
import CSV and HTML files or content
from third-party apps.
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typing. Click and drag the dotted lines

to move a content block around. Press '+

to the left of the dotted lines to choose
what type of content to add, including
lists, headers, sub pages, and more.

My first page

Convert a block

Ctri-click a block and hover the
pointer over ‘Turn into". You will see a
huge list of options. This lets you quickly
transform plain text into a checklist, for
example, or switch from a one-column
layout to a five-column one.

»Image credits: Apple Inc, Notion Labs Inc



Manage tasks APPLE SKILLS

CONTINUED... Manage your tasks with Notion »

My first page

Here's araiher biock

4 Page organisation

You can add page icons and header
images, and rearrange your pages in the
sidebar. To add a sub page, click '+ next
to the page name in the sidebar. You can
embed or link to other pages and
databases within each page.

+ — - e

Download benchmarking appe

Card details

Hover over an entry and click Open.
This shows each entry's details, where
you can add comments, attach files,
assign colleagues, and more. Try
adding a comment, or click ‘Add a
property’ and choose from the list.

aaaaaa

] Show more info

By default, all properties except
the item name are hidden. Next to the
blue New button, click '...", followed by
Properties. Now drag anything you
want shown to ‘Shown in board’ and
you'll see it without clicking the task.

New database

Databases are collections of pages,
and can be organised in various ways.
Click 'New page’, then click Table (under
Database). Under 'Select data source’,
click ‘New database’. We'll convert this
into a project management board.

Ve

W Work planner
D S . ]

View options

Under your table's title, click '+
next to the word Table. Now choose a
new view for the content. Board lets you
drag and drop items between categories,
while Calendar might be helpful if you've
assigned due dates.

]'] Add a filter

Click Filter and choose from basic or
advanced filters. A simple date filter can
highlight any items that fall between two
dates. An advanced filter can use multiple
criteria to find items, which helps in
larger datasets.

LA —

& Work planner

B Tabke
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Add some entries

Start by adding some data. We'll use
this to manage our work, so under Name,
add some tasks you need to do. Add
some tags, then click ‘+' in the third
column and pick Date from the list,
before adding some due dates.

o pEena

8 Work planner
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Board view

Click Board from the view list.
Under 'View name’, type ‘Task status’.
Click and drag the columns to reorder
them, if you like. Now you can quickly
switch between views when required,
or add another view if it suits.

1 The search tool

Lost something? Notion has a
powerful search feature that can help.
Simply press Cmd+P and start typing.
You can adjust search filters on the fly
and results start populating every time
a letter is added.
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How does Apple
track your location?
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- dit your PDFs

Easily adjust, sign and annotate PDFs with PDF Expert

IT WILL TAKE Whether we like it or not, most
»10 minutes ) of us reqularly work with PDFs.
Editing these files can be fiddly

YOU WILL LEARN
» How to adjust your
PDFs with a host of
tools in PDF Expert

and unwieldy, provoking more
frustration than anything - unless you have
an app called PDF Expert at your disposal.
This app has an array of tools designed to
help make managing your PDFs much easier.

YOU'LL NEED

» PDF Expert (£72.99/
year), mac0S 10.13

or later

You can edit text, fill out forms and sign
documents, banish blotches and unwanted
imperfections, and rearrange pages with

a quick click and a swipe.

There are various reading modes
(including Split View) designed to ease the
burden on your eyes, while you can export
to different formats to share with others.
And if you have an iPad, you can annotate
your files with handwritten notes and
signatures with the help of an Apple Pencil.

Soinstead of struggling along with the
limited PDF tools in other apps, you may find
that PDF Expert makes things a whole lot
more bearable. It's an incredibly handy
app to have by your side. Alex Blake

HOW TO Work with PDFs in PDF Expert >

................... -
we T mkmsmu-nu rl:lp:n growth and rew: nppununl
ol ves ging foeward,

Thank you leriah
heasing fram yeu

vl Flook Torw;

Yours sincerely.

Fill out forms

PDF Expert recognises forms,
including tick boxes and drop-down
menus. In a form, click inside a box

1 Sign documents

Click the Annotate tab > My
Signatures, then click the ‘+" button to
sign a file. Add a signature by typing,
using a trackpad, or adding an image,
then click Create. Drag it onto a
document and resize if necessary.

click Annotate > Text to add text.
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(highlighted in purple) and start typing.
If there are no interactive purple boxes,

Annotate your files

In the Annotate tab, the top row
of buttons has various annotation tools.
Some, like the highlighter and underliner,
automatically snap to lines of text. You
can add stamps, sticky notes, shapes,
and more to your file.

»Image credits: Apple Inc, Readdle Inc
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CONTINUED... Work with PDFs in PDF Expert >

Lok
wanted ta find something, Spotlight was FORMAT
wer. Tntraduced in 2004, it ket you MVESTISA

ook 1 ap files, fobders and mare using natural

language, Although Spotlight and Time
Machine covered very different areas, the The mfluence
T‘i]'nc Nlachine underlying philosophy was the same: remove Of Mac OS X
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problem sttt s

B e ——— I Mac

Edit text 5 Change the type Choose a theme

Click the Edit tab, then click Link. If text is too small, click Edit > Text, PDF Expert has a few themes to
After highlighting some text, you can add highlight the text in question, then make viewing easier. Click View > Themes
a URL. Or click the Redact button and increase the font size in the right-hand and choose either Day, Sepia, or Night.
highlight text to black it out or erase it. sidebar. You can also change the font, Each theme's colours also affect the
Finally, you can click Text to change weight, colour, and alignment to make content you're viewing, so a white
the words on the page. it easier to read. page turns black in Night mode.

How does Apple

E FIMAL
track your location? FRLIGHT PLAN.
'.f

{ i{i'/

7 Work with images Enhance your scans 9 Clear margins

Click the Image button, then select Sometimes, scanned documents If you have a scanned page and

an image on the page. In the right-hand don't look their best. To fix things up, want to clear the sides for notes, click
sidebar, you can rotate the picture, crop click Scan & OCR > Enhance Scan. Here, Scan & OCR > Clear Margins. You can

it, replace it, or export it. To add a new you can convert the scan to colour or drag the margins to set how much space
picture, click Edit > Image, then click black and white, remove distortion is cleared and choose the margin colour.
anywhere on the page. effects and blemishes, and more. Then click Clear Margins > Apply.

]O Recognise text H Split, merge, crop ] 2 Reorder pages

If you need to make text in an Got two pages side by side? Click You can rearrange pages by
image selectable, click Scan & OCR > Scan & OCR > Split Pages to separate clicking the Page Thumbnails button in
Recognize Text. Choose your language them. Or click File > Merge Files to the top-left, then clicking and dragging
and click Recognize, decide how many combine two or more PDFs. You can a page to reorder it. This menu also lets
pages to scan, then click Apply. You also cut out distractions like page you rotate, copy or extract pages and
can now select the text in the PDF. gutters with Scan & OCR > Crop Pages. append fresh pages to the file.

APRIL 2023 | MACFORMAT | 39



APPLE SKILLS macOS/iOS

F = 5 oo @ Tealeri s

How to use Continuity Camera

Why buy a separate webcam when you can use your iPhone?

IT WILL TAKE
» 30 minutes

YOU WILL LEARN
>How to use
Continuity Camera

YOU'LL NEED
»macO0S 13 or later,
i0OS 16 or later (some
features require
arecent iPhone)

£

Genius tip!
> If you tap Disconnect
on the iPhone screen,
you will have to connect
it to your Mac with
acabletouseit as

a webcam again.
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Apple's Continuity suite

of features has been around
for years. It's this feature that
enables you to use your iPhone
as a scanner for your Mac, for example. The
latest addition to the feature set, Continuity
Camera (confusingly, it has the same name
as the scanning and photo features), enables
you to use your iPhone as a webcam for your
Mac when making FaceTime, Zoom or Teams

-0

Belkin's £29.99 iPhone Mount with MagSafe is one of
several gadgets that enables you to use the MagSafe
magnet to mount your iPhone on your Mac.

calls. In fact, you can use it with any
application that would normally use
the FaceTime camera on your Mac.

Using your iPhone in this way not only
gives you more flexibility in where to position
the camera, but allows you to make use
of some of the features of recent iPhone
cameras. For example, more recent iPhone
lens systems work much better in lower light
than the FaceTime camera on a Mac.

Ready for your close-up
More impressively, Desk View makes use of
the Ultra Wide setting on the iPhone 11 and
later to allow you to show a top-down view of
your desk and your face at the same time. You
can use Portrait mode to blur the background
or Studio mode to dim it while lighting your
face. And Centre Stage keeps you in the
middle of the frame when you move around.
You can choose whether or not to use your
iPhone's microphone for calls, and if you do,
you can isolate your voice from ambient noise
or do the opposite and capture all the noise
around you as well as your voice.
Kenny Hemphill

»Image credits: Apple Inc, Belkin



Continuity Camera APPLE SKILLS

HOW TO Use your iPhone as a webcam »

i
Mon 23 = 16:34

1 Get your iPhone ready
Your iPhone needs to be close to your
Mac in order to use Continuity Camera.
It also needs to be locked. You can
charge it from a plug or from your

Mac while using it, so, if the battery

is running low, plug it in.

4 Use Centre Stage

To have your iPhone place you at
the centre of the screen, click on Control
Centre, choose Video Effects then Centre
Stage. Note though, that to use Centre
Stage you must have an iPhone 11 or
later, excluding the iPhone SE.

Try FaceTime Desk View
In FaceTime, start the call then click
Desk View in the top right of the window.
Use the Zoom control to zoom in or out.
Click Start Desk View. If your desktop
can't be seen, click Desk View then
Share Desk View.

2 Mount your iPhone

If you're using a mount, connect it
and attach it to your Mac. If not, position
your iPhone where it is stable and facing
you. If you put the iPhone in landscape
mode, most apps will be able to choose
your iPhone automatically.

Use Portrait mode
Portrait mode, which blurs the

background, needs an iPhone XR or later.

Click on Control Centre, choose Video
Effects then select Portrait. You should
see an effect similar to using Portrait
mode to take photos.

Desk View across apps

If you're using another video calling
app such as Zoom or Teams, start the
call and click Control Centre, then click
Desk View. Go to the screen sharing
controls in the app and choose Desk
View to allow others to see your desk.

Choose the camera

Launch FaceTime. It should choose
your iPhone's camera automatically. If
not, click the Video menu and choose it.
Most third-party apps should also choose
it automatically. If not, use the device
settings in the app to select it.

6 Turn on Studio Light

Studio Light does the same as it
does in the Camera app. It illuminates
your face and dims the background,
useful for when you're sitting in front
of a window. Go to Control Centre and
choose Video Effects > Studio Light.

9 Change mic modes

There are two microphone modes.
The first, Voice Isolation, prioritises your
voices and minimises background noises
such as traffic. The other, Wide Spectrum,
captures everything. Click Control Centre
then Mic Mode to choose one.
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‘mastodon

Social networking
that’s not Lor sale.

Your home

Cet the app

Create account

-

=

Get started with Mastodon

Fed up with Twitter? Mastodon offers a billionaire

IT WILL TAKE
» 20 minutes

Mastodon has been a big
beneficiary of Elon Musk's Twitter
takeover; with Twitter in apparent
chaos and lots of previously
banned users being allowed back on, many
people have been looking for a more pleasant

YOU WILL LEARN
> You will learn what
Mastodon is and

how to use it alternative. For many, Mastodon is that
alternative. It has very strong anti-abuse
YOU'LL NEED rules, and with a bit of effort you can make

» A browser, and
a bit of patience

it just as easy to use as Twitter.
Mastodon works a bit like email; in much the
same way you can have yourname®@iCloud.com

-free alternative

or yourname®@gmail.com, there are different
Mastodon servers for different people.
Mastodon calls them ‘instances’, and there
are instances for journalists, drummers,
environmentalists... and so on. You can see
posts from and communicate with people
from other instances, just like you can

email Gmail users from your iCloud mail.

In this tutorial, we'll discover how to get
started, and how to find out and follow other
people. We'll focus on the desktop here, but
there are great iOS apps too. Carrie Marshall

HOW TO Set yourself up on Mastodon »

fMmastodon ‘fastodon

Servers

Find your place

Point your browser to joinmastodon.
org and click on Servers. This enables
you to see a list of available servers and
to sort them. For example, you can find
instances dedicated to football or tech,
or to specific cities or countries.

1
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2 Open an account

The Servers tab will show one of two
buttons below a server name: Create
Account or Apply For An Account. The
former means anybody can join; the
latter means the server vets new users
to ensure they're not a potential problem.

Read the rules

Every instance has its own set of
rules, and breaking them can get you
banned from that instance. These rules,
for the mastodon.london instance, are
fairly typical and hardly controversial:
nothing illegal, no hate speech, etc.

»Image credits: Apple Inc, Mastodon GmbH, Bruno Philipe
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CONTINUED... Set yourself up on Mastodon »

[imastodon

Lat's get you set up an
mastodon.london.

4 Enter your details

All you need to do now is sign
up with the instance by providing your
name, preferred user name and email
address. You're signing up with a specific
instance, not an app; you can use any
app you like to access your account.

Look at Local

There are three views of Mastodon.
The standard view is your own feed,
which will contain posts from the people
you follow. The Local view shows posts
published the instance you're on, in this
case mastodon.london.

Insert instance addrass:

Mastadon

Sheww hull Dascriptios 3

14k 27k 402
Users Tools Version

Or pick from this list of popular instances:

mastedon.social
Gonral-purpose server run by the lead develuper of Mestodon

ek Tazs Versicn Usiime

mstdn jp
EICEET)

1 Pick your account
You have two choices here; you
can log in with an existing Mastodon
account, or you can create a new one.
We'll use the Mastodon account we just
set up, so we'll enter the name of our
chosen instance in the field provided.

5 Check your spam

Strangely, Mastodon confirmation
emails often go straight to spam or junk.
If you don't see an email verification link,
it's probably been marked wrongly as
spam. Find the message and click the
link to activate your account.

Join the federation

The other view is the Federated
view. This enables you to see posts
from other Mastodon instances that
your particular instance is federated
with - essentially, instances that your
one says are okay to view.

Fminm
e I3

H Authorise your app
Whether you're on Mac, iPad or
iPhone, the app needs to be authorised
before it can connect to your account.
You should automatically see the screen
shown here, and clicking Authorise takes
you back to the app.

o
Follow oo youre i s su pets freen| & akatin
Here s noems suggastinns, ¥ s
i %
[

mmmmmm

Look around

This is the web interface for
Mastodon, and it has three columns. On
the left is where you write your posts and
replies. In the middle is where you see
other posts, and at the right there are the
various options to filter what you see.

Welcome to Mastonaut!

L2 1w Hh pour M asmcion accoun b ges et

Install an app

There are some good third-party
apps for Mastodon for both desktop and
i0S, and many of them are free. Although
they may look different they all work in
much the same way. Let's try the free
Mastonaut app (mastonaut.app) for Mac.

87281 remcts sk, fairad | Logmit]
* ok obownd accourns |

doinad & Activa | Fakwnl |
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1 2 Find your people

A great way to find people is to
see which of your Twitter follows have
Mastodon accounts. Movetodon.org can
scan your Twitter account, enabling you
to follow some or all of the people who've
got Mastodon links in their profiles.
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Master iPhone video controls

How to use different shooting modes and file formats in the Camera app

IT WILL TAKE
»15 minutes

YOU WILL LEARN
»How to master
different video shooting
modes and formats

YOU'LL NEED
»An iPhone (some
features model
specific)

With the introduction of the
iPhone 14 you can now shoot
videos in Action mode, but
that’s not the only type of
video your iPhone can capture. In this
tutorial, we're going to explore all of the video
recording modes available to your iPhone’s
camera (no matter which iPhone model you
own), explaining what they are, how they work
and how you can make the most of them.
We'll be covering Action mode, shooting in
HD, 4K and the amazing Cinematic mode. Plus,
we'll take a look at quasi-video modes such as

Slo-Mo, Time-Lapse and Live Photo to expand
your video shooting repertoire.

We'll also show you how to turn on the
Apple ProRes format on Pro model iPhones.
ProRes enables you to capture HDR (High
Dynamic Range) clips that have a wider
range of colours and tones than standard
HD or 4K clips. HDR clips take up a huge
amount of storage space, so we'd only
recommend shooting in Apple ProRes
if you need to edit and share clips to be
viewed on HDR-compatible devices such
as an iPhone 14 Pro. George Cairns

EXPLAINED... How to use different video modes »

Apple ProRes

00:00:00

Max Time: 68 min

Shooting time

Shooting modes

PORTRAIT

(o]
=
o
aE
o

Frame rate

» A minute of 10-bit ProRes
HD footage takes up 1.7GB
of storage space. Maximum
shooting time appears here.

»On a Pro model iPhone tap
here to toggle on the ProRes
shooting mode (once you've
activated it in Settings).

»In the Camera app, swipe
here to choose a shooting
mode. The active mode
will appear in yellow.

» Tap here to change the
resolution and frame rate.
We're shooting at 4K res
with a frame rate of 30fps.

44 | MACFORMAT | APRIL 2023

»Image credit: Apple Inc
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HOW TO Use every video mode »

ings Camera
L]
Formats
Record Video
Record Slo-mo
£
Record Clnematic
Record Sterec Sound (\-

Preserve Settings
Use Volume Up for Burst

Scan OR Codes

'] File formats

Go to Settings > Camera. Here you

can choose default video file sizes and
frame rates for the Camera app, such
as shooting 4K footage at 30fps. You

can also change file sizes and frames

rates from within the Camera app.

HD or 4K

In the Camera app, swipe to
Video mode. Tap top-left to toggle the
resolution between HD and 4K. Tap to
change the frame rate. 30fps is good
for sharing HD files online; 24fps gives
a more cinematic look on a 4K TV.

Cinematic mode

To give your footage a Hollywood
look, swipe to Cinematic mode. This
mode is similar to the Portrait mode
in that it digitally blurs the video clip’s
background while keeping the main
subject looking nice and sharp.

L3

Pull focus

While shooting in Cinematic mode,
the camera will usually focus on the
person closest to the lens. You can tap
on a background person (or object) to
make them become sharp. A yellow
box indicates the focal point.

Action stations

The iPhone 12 and 13's sensor-shift
optical image stabilisation system
reduces camera shake. When shooting
video on the iPhone 14 range, tap the
Action mode icon to capture even
smoother handheld clips (up to 2.8K).

Go slow

Swipe to Slo-mo. Tap top-left
to shoot at 720P with a slow frame
rate of 240fps to create a small (low-
resolution) file. For higher-quality
choose HD 120. Tap the red button
to record a slow-motion clip.

< N

i LOKG EXFOSURE

Langian - Saint Fancras. Edit

Live
Locp
Bounce

+ Long Exposure

off

Live Photo

Live Photo mode captures a short
video sequence that you can use in
creative ways. In Photos, tap the top-
left menu and choose Long Exposure.
Moving objects become blurred (as if
you'd shot using a slow shutter speed).

Time travel

To view the world in a creative
and dynamic way, swipe to Time-Lapse
mode. This causes the iPhone to capture
approximately two frames per second.
When you play the clip, subjects such
as clouds move at high speed.

€ Camera Formats

WIDEQ CAPTURE

Apple ProRes Cl
s o e st

Go Pro

On Pro iPhones, choose Settings >
Camera > Formats. In the Video Capture
section choose Apple ProRes. In the
Camera app, tap to turn ProRes on or
off. You can edit ProRes clips in iMovie
on iPhone to preserve their HDR quality.
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Use external devices

Connect your iPad (or iPhone) to almost anything via the power of USB-C

IT WILL TAKE
»10 minutes

YOU WILL LEARN
»How to use external
storage and other
devices with iPad

YOU'LL NEED
»iPad, USB-C cables
or adaptors

Your USB-C
IPad can
charge your
IPhone,
AirPods or
Apple Watch
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i ,_;;3’/ One of our favourite things
about the latest iPads is their
USB-C port, which enables you
to connect all kinds of devices.

USB-C is the most recent and fastest version
of the standard, and it enables you to connect
more demanding devices such as fast external
storage. It also enables you to charge your
iPhone, AirPods or Apple Watch; just connect
the appropriate cable to your iPad and it'll

CLD=REE S rimn

If you're into making music, USB-C enables you to connect
external keyboards so you can play around in GarageBand.

share its battery. That's not all your iPad

can do. It can move files to and from external
drives and memory cards; connect to
DisplayPort external displays; connect to
external keyboards and mice; connect to
USB interfaces for microphones and musical
instruments; and you can use it with adapters
as an HDMI output or an Ethernet connector.

Some limits apply
With the third-generation iPad Pro 11-inch and
the fifth-generation iPad Pro 12.9-inch, you
can daisy-chain devices to connect multiple
Thunderbolt devices simultaneously.

There are some limits to what you can
do, however. USB webcams won't work in
FaceTime, and while you can connect to
external storage you can't format or partition
it and it has to be formatted as exFAT, HFS,
FAT32, or APFS. And some USB devices need
more power than your iPad can provide, so
for those you'll need to connect your iPad
to a mains-powered USB hub.
Carrie Marshall

»Image credit: Apple Inc
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HOW TO Using an external drive »

.....

1 Open up Files

When you connect a USB external drive

or memory card, it'll show up in the Locations
section of the Files app's sidebar. Some devices
may need external power - if so, they won't
show up until they're connected to power.

A

Have a listen

One of the great things about USB-C is
that it's very fast, and that means you don't
need to copy media files from external storage
to your iPad in order to play them. Here we're
checking out a high-quality Apple Music track.

2 Explore your files

As you can see, external storage works

just like your iPad storage - and you can drag
and drop between the two. You can't format

external storage from your iPad, though; for

that you'll need to connect it to your Mac.

. e s
WASTERTONE  MASTER VOLLME

KEY—= =NER |
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.......... e ‘
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4 Get marking
Everything on external storage works as

it would if the files were stored on your iPad,
so for example you can open an image and use
Markup to highlight or annotate it, or use the
Share menu to send it via Messages or Mail.

5 View your videos

Provided they're in a format your iPad can
play, you can even play videos in real time from
your external storage - and, as you can see at
the top and bottom of the screen here, you can
instantly rotate the clip or scrub through it.

6 Apply actions

Press and hold on a file or folder in the
Files app to see this menu; this enables you to
access the most commonly used file actions

- including renaming, compressing, duplicating,
tagging or deleting files or folders.

7

Jargon buster
» Thunderbolt was

a faster alternative

to USB, but the most
recent versions of USB
have caught up. The
iPad Pro's USB-C/

USB 4 portisalsoa
Thunderbolt 4 port.

Genius tip!

»You don't need the

most recent iPad to

connect devices such as
USB keyboards or
audio interfaces
to your tablet, but
you will need a
Lightning to USB
cable or adaptor
to connect them.
It'll work with

— iPhone too.
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10:09

Open Walkie-Talkie

Louise Blain has accep-
ted your Walkie-Talkie
invitation.

Dismiss

Make and take calls

Use your Apple Watch to chat with friends - it's so easy and versatile

IT WILL TAKE
»10 minutes

YOU WILL LEARN
>How to use the
Walkie-Talkie Apple
Watch app

YOU'LL NEED

> An Apple Watch, and
someone else with

an Apple Watch

£

Genius tip!

»If you use Focus modes
on your iPhone and
Apple Watch to enable
Do Not Disturb settings,
they include the
Walkie-Talkie app too.
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Our Apple Watch sometimes
makes us feel that we're living

. in the future; at last, we have
the wrist-based communicators

our comics promised us as kids.

When someone calls, your Watch shows
their name if they're in your contacts. Tap the
green button to talk, the red button to send
the call to voicemail, or the ... (More) button
to send the call to your phone or reply with a

14:33

Louise Blain tried to
reach you, but you

were unavailable.

Talk to Louise

If someone tries to contact you via the Walkie-Talkie
app when you're unavailable, your Watch will display
amissed call notification.

text message. You can adjust the volume with
the Digital Crown and switch from Watch to
Phone by unlocking your iPhone and tapping
the green bar at the top of the screen.

And of course, you can phone people too.
Simply tell Siri to call the person, or open the
Phone app, scroll to the appropriate contact
and choose whether to make a phone call or
a FaceTime Audio one.

Roger, over and out

One of our favourite features of taking calls
via Apple Watch is Announce Calls. If you go
into Settings on your Apple Watch and tap on
Siri > Announce Calls, Siri will tell you who's
calling and ask if you want to take the call.
All you need to dois say Yes or No.

In this tutorial, we're going to focus on
one of the lesser-known voice-calling apps,
Walkie-Talkie. If you have a friend, family
member or colleague with an Apple Watch
you can use the app for instant voice
communication. All you need is for both
Watches to be connected via Wi-Fi, iPhone
or mobile data (if your Watch is a GPS+
Cellular model). Carrie Marshall

»Image credit: Apple Inc
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HOW TO Chat to friends using Walkie-Talkie »

Phone

77 Favourites
) Recents

@ Contacts

] Phone home

Open the Phone app and choose from
your Favourite contacts, your recent calls
list or your full contacts list; you can also
select a numeric keypad or access your
voicemail here. If you prefer, you can use
a Siri command to call a specific person.

Walkie-Talkie 13:53

Walkie-
Talkie “

Louise
Blain

Find a friend

You can't just start walkie-talkie-ing
to everyone in your contacts list. You
need to invite them to use the app. Scroll
to the name of the person you want to
add and tap Invite; you'll now see this
display until they accept the invitation.

< Louise

Start the chat

Tap the name of your friend and you
should now see this button. All you need
to do now is hold the button when you
want to talk and let go when you're ready
to listen. Saying “over" at the end of
each sentence is entirely optional.

Phone 09:27
Sophie Mar-
shall

CALLING IPHONE

Make the call

When you're on a call, you can mute
your mic with the left-hand icon, hang
up with the middle one or access more
options with the '..." button. This enables
you to hand the call over to your iPhone.
The Digital Crown adjusts the volume.

O

Louise Blain has accep-
ted your Walkie-Talkie
invitation.

14:30

Open Walkie-Talkie

Dismiss

5 Get ready

When your friend accepts, you'll get
this notification, which includes an option
to open the Walkie-Talkie app if you aren't
already in it or to dismiss the notification.
Now when you go to the app you'll see
your friend(s) at the top of the display.

Set your status

If you don't want to be disturbed
at any time of day or night, toggle your
Walkie-Talkie availability in Control
Centre. The toggle is just the app logo: if
it's black on a yellow background you're
available; tap it to become unavailable.

‘ Tips

= Voice Memaos

O Walkie-Talkie
a Wallet

‘ Weather
Get Walkie-Talkie

The Walkie-Talkie app has been
automatically installed on every Apple
Watch since watchOS 5.3. If you've
deleted yours to free up space, get it
back by tapping on the App Store and
downloading it again. It's a free app.

Walkie-Talkie 14:32

Add more

You can add as many other friends
as you like. Walkie-Talkie uses FaceTime
to communicate so both of you will need
to have set up the FaceTime app on your
devices. You can remove friends from
the list by swiping left on their name.

82% N\
e ¢

See your status

When you've used the Walkie-Talkie
app, you might notice the icon in tiny
form at the top of the Control Centre.
That's where your Watch shows its
different connection statuses, so if
Walkie-Talkie is active it appears there.
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APPLE SKILLS How it works

22 {IOW IT WORKS
Spatial audio and
dynamic

Create immersive effects for music and video

YOU WILL LEARN

» How spatial audio and
dynamic head tracking
work on Apple devices

Key fact

» If your AirPods support
spatial audio, the Music
app will automatically
play spatial audio for
tracks that support
Dolby Atmos. If you want
to listen to spatial audio
using non-Apple
headphones, go into
Settings > Music (iPhone
and iPad), or Music >
Settings > Playback
(Mac). Look for the Dolby
Atmos option and then
select Always On.

Nead trac

patial audio has been available on
iPhone and iPad for a few years now,

since it was introduced with iOS 14
and the AirPods Pro in 2020. It's taken Apple
a while to extend the tech to a wider range of
devices, but you'll now find it in the latest
AirPods and AirPods Max, as well as Macs
and the Apple TV box.

Spatial audio is designed to create an
immersive sense of space when listening to
music or video, allowing music to swirl around
you, and also to precisely place individual
instruments or sound effects from a film at
specific points in space. Spatial audio is a bit like
surround-sound speaker systems used in
cinema set-ups, but instead of having to place
multiple speakers around you, spatial audio is
designed to work through headphones. It uses
special algorithms, called HRTF (head-related
transfer function) that convert two-dimensional
stereo sound into a kind of ‘virtual surround
sound’ using the earpieces of your headphones.

EXPLAINED Spatial audio settings »

The large, over-ear design of the AirPods Max
is ideal for immersive spatial audio.

Apple isn't the only company investing in
clever audio tech. Sony's 360 Reality Audio
format is available on many Sony headphones
as well as streaming services, such as Amazon
Music and Tidal, while Yamaha's 3D Sound Field
tech claims to take any standard stereo audio
and ‘upscale’ it to the equivalent of five-channel
surround sound.

However, Apple's version of spatial audio
is actually based on the Dolby Atmos format,
which has been a standard format for film
soundtracks for many years, and is becoming
increasingly popular for music recordings too.
Spatial audio is supported on the latest
third-gen AirPods (but not the second-gen
AirPods that are still on sale), as well as the
AirPods Pro and AirPods Max. However, Dolby
Atmos is also widely supported on other types

Stereo Audio

L]

Spatial Audio

®

Oy

1 Sound all around

You can get an idea of how spatial
audio works if you go into Settings on
iPhone or iPad. The Settings panel for
AirPods shows how spatial audio differs
from stereo, creating a sense of sound all
around you, rather than just the left/right
channels of conventional stereo.
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Control Centre

Open Control Centre while wearing
AirPods, and then press-and-hold the
Volume control. You'll see the Volume
slider with two smaller icons below it for
adjusting noise cancellation and spatial
audio. Just tap on the Spatial Audio icon
to see the options that are available.

Spatial options

By default, spatial audio is turned
off, but you have two options available if
you decide to turn it on. The standard
option is Fixed, which means that the
sound doesn't change if you turn your
head or get up and move around while
watching video or listening to music.

»Image credit: Apple Inc



Spatial speakers

Headphones aren't the only option for listening to
spatial audio. You can play spatial audio using built-in
speakers on the iPhone 7 or later, most recent iPads,
and Macs with M1/M2 chips (see bit.ly/3HFyVNm).
These compact speaker systems aren’t ideal for
creating the rich, immersive sound that you really need
for spatial audio. But, if you want to go to town, you can
use the Apple TV 4K to connect more powerful
speakers and soundbars for the full home-cinema
experience - as long as those speakers also support
Dolby Atmos. There are no speakers that currently

Apple audio tech APPLE SKILLS

support dynamic head tracking.

You can team an Apple TV 4K with a pair of HomePods for a true spatial audio experience.

of headphones and speakers too, so you don't
have to own a set of AirPods to listen to
spatial audio on Apple Music. But, Apple being
Apple, it has come up with an extra twist of its
own, called dynamic head tracking. This is an
additional feature that works in conjunction
with spatial audio for music or video, but it
requires special sensors that can monitor the
movement of your head while you're wearing
your headphones. These sensors are only
built into the third-gen AirPods, AirPods Pro,
AirPods Max and Beats Fit Pro, so these are
currently the only headphones that support

dynamic head tracking as well as spatial audio.

Space music
You can use dynamic head tracking when
listening to spatial audio on Apple Music, but

4 Head tracking

Select Head Tracked to activate the
AirPod’s dynamic head tracking feature.
Head tracking works best when watching
video, as it can adjust the soundtrack so
that the sound moves when your head
moves, and always appears to come from
the screen that is playing the video.

it works best for watching films or video that
have a Dolby Atmos soundtrack. When you're
watching a film with an Atmos soundtrack, the
sound is ‘fixed' so that it seems to come from
the same spot within your headphones. The
spectacular opening scene of Blade Runner
sounds great with spatial audio, as Harrison
Ford's hover-car zooms towards you and the
sound then pans off to the left as the hover-
car moves left across the screen. With head
tracking turned off, that panning sound always
comes from your left-earpiece, because the
soundtrack assumes you're always looking
directly at the screen. But, when you turn on
head tracking, the sound is automatically
adjusted whenever you start to move your
head away - in fact, if you face 180° away
from the screen, the sound of the hover-car
switches to the right-hand earpiece of the
AirPods to match the motion on the screen.
Spatial audio also works for music that you
stream or download from the Apple Music
service, as long as the tracks you're playing
are marked as supporting 'Spatial Audio With
Dolby Atmos' (and there are several spatial
audio playlists already set up on Apple Music
to help you get started). Spatial audio can be
really effective with a rock extravaganza such
as Bohemian Rhapsody, with the shrieking
Galileos and Figaros flying through the air, or
with dance tracks that really get you into the
rhythm. However, dynamic head tracking is
less effective when you're listening to music
- especially if you're also walking around while
wearing your AirPods. Many people find that
the constantly changing direction of the
sound can be quite distracting, so check the
screenshots (above) that show you how to
adjust both spatial audio and dynamic head
tracking to suit your preferences. Cliff Joseph

Apple's version
of spatial audio
is based on the
popular Dolby
Atmos format

Key fact

> As well as simply
turning spatial audio
on or off, you can use

a feature called
Personalised Spatial
Audio to improve 3D
sound effects. This uses
the TrueDepth camera
on the iPhone X or later
- which is also used for
Face ID - to scan your
head and ears and
create a personalised
profile that fine-tunes
the spatial audio effect
to suit the shape of
your head.
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eDITED BY HOWARD OAKLEY »

Going against
the grain

e're often our own
V\/ worst enemies
when using our

Macs. When what was

once simple becomes tricky
and tenuous, instead of
following the line of least
resistance, we insist on
doing what worked in

the past.

Apple silicon Macs are
designed and built to run
from their internal SSD:
it's remarkably quick,
convenient, and thoroughly
secure. While they can boot
from external disks, even
a hard drive if you really
want, that should rarely
be a choice because of
everything it loses.

Those who insist it's
best face many challenges.
Can it work with a USB
stick? Is FileVault encryption
available? Can a single boot
disk work across many
Macs? What about booting
older macOS? These can
be fun projects for those
who tinker, but when you
want to get on and use
your Mac, it's far better
to go with the grain.
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EXPERT
ADVICE

Our resident genius
solves your Mac and
iOS problems

Contact us

Email your queries and
your questions to
genius@macformat.com

s Ventura's protection good enough?

Do we still need to run third-party
anti-malware software on our
Macs in Ventura?

by NATHAN PARKER

Apple intends macOS to provide

sufficient protection against malware

for the majority of Macs, but it's up to
you to assess the risk and adopt defences.
Recent macOS have brought steady
improvement, and last summer saw the
introduction of new anti-malware scanning.

We tested how well Ventura 13.1 detected

four current malware samples with different
security settings. Because macOS is now less
reliant on apps being quarantined to trigger

# TodEdlt Fle EdR Fomat  viow  Wincew  Hep

“WindowServer® will damage your comperter,
‘fou should move it to the Bin,

XProtect in macOS successfully detected
and blocked this sample of the malware
CloudMensis from being run.

| EE—

checks, malware was found and blocked
effectively even when it had dodged
guarantine. The new XProtect Remediator
anti-malware scanner, active in Catalina and
later, also proved it does both detect and
remove known malware.

To get full benefit from built-in protection,
your Mac must run the current release of
macOS, which is fully patched against known
vulnerabilities, in Full Security with all security
systems including SIP and XProtect enabled.
Effectiveness also depends on Apple's
response to new threats by releasing Rapid
Security Responses and updating scanning
modules. Most of all, it relies on users
remaining alert and behaving securely.

@ 4 & Wi

genius@macformat.com
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Quickfire
questions

Currently that appears
to be Keka, which gives
you the choice of 14
major compression
formats with support for
AES-256 and Zip 2.0
encryption, and can
decompress more than
30 different formats. It's
based on the same code
as its popular and
mature macOS sibling.

Its app is usually tucked
away in the Utilities
section of the App
Library. Add it to the
Control Centre in that
section of Settings, then
you can swipe from the
top-right corner to tap
on its icon for use. You
can also set it to open
when you triple-click
the side button, in
Settings > Accessibility >
Accessibility Shortcut.

Email your queries and your questions
to genius@macformat.com

10S software GENIUS TIPS

OS software

Swipe away your touchscreen troubles and
rekindle your love of Apple's mobile devices

Sharing TV+ but not iCloud+

My partner has a new iPad. Can she

share my Apple TV+ subscription

without using my iCloud storage?
by TONY WILLIAMS

09:04

{ Family Subscriptions

except iCloud+, are
ith your family. You can
e subscriptions

Family Sharing offers many options,

and when set up carefully can

provide family members with just
the shared services you want them to enjoy.

The first step is to create your family

group in Settings. Tap your name at the top,
then Family Sharing, and Set Up Your Family
following the instructions. In the course
of those, you'll be prompted to send your
partner an invitation to join your family
group, starting the next step in the process.

You can always add others later by
tapping the Add Member icon at the top
right of Family in Settings. There are limits
imposed on family membership; each
Apple ID can be a member of only one
family group at a time, and can only
switch between different family
groups once each year at most.

When your partner has been added to
your group, the Family section in Settings
shows what they can access and share,
and gives you, as the Organiser, control
over those settings. To share any of
your existing subscriptions, in Settings
> Family, tap Subscriptions, where
those available for sharing are listed.

Tap Apple TV+to enable your
partner to share that subscription,
and they'll be sent an invitation. Once
they've accepted, it will unlock Apple
TV+ access on their iPad. Sharing iCloud
storage is controlled separately through

the same Subscriptions section, and
requires an iCloud+ subscription. As
you're the Organiser, only you can offer that,
similarly with Purchase and Location sharing.

Apple subscriptions,
automatically shared w
choose which eligible App Stof
you want to share. Learn mMore...
you W

SHARED
] Apple TV+
stv Shared by You

Manage Your Subscriptions

Review and manage your Apple and App Store

subscriptions.

AVAILABLE TO SHARE

®

iCloud+
Subscribed

DISCOVER MORE

n Apple Subscriptions

Subscriptions for Family

H

Sharing subscriptions to services like Apple TV+and
iCloud+ is controlled individually within a family group.

APRIL 2023 | MACFORMAT | 53



mailto://genius@macformat.com

GENIUS TIPS Mac hardware

Nl

Quick-fire
questions

Charge the mouse
fully, then enter
Recovery mode by
holding the Power
button until you're
informed that it's
loading. To pair your
mouse again, press the
Power button three
times in slightly less
than three seconds. You
should then see the
Bluetooth Setup
Assistant to help

you pair it.

Not easily. To access

Mac hardware

We help to solve your hardware hassles, from
interrupted upgrades to running diagnostics

More memory or larger storage?

My current Mac mini has 16GB of

memory, but sometimes struggles

when it's running major tasks.
Should the Mac Studio I'm getting to
replace it come with 32GB RAM and a
larger internal SSD, or will | need 64GB?
by PAUL MASLIN

Working out how much memory you
need in a new Mac is never easy, but
one of the best indicators is how
much swap space your current Mac uses when
working on larger and more challenging tasks.
macOS manages memory very efficiently,
and makes the most of all the physical RAM
available to it. Activity Monitor's Memory
view provides colour-coded Memory Pressure
and a figure for the amount of Swap Used,

o

& eclecticlight.co

1 & M2 Macs Mac Problems Mac articles Art

that's the space on its hidden VM volume
used as an overflow for real memory.

If your Mac mini seldom goes into the red
and uses little swap space with only 16GB of
physical memory, your new Mac Studio should
do very nicely with 32GB, allowing you to get
that larger SSD. Although there are substantial
differences in the way that Intel and Apple
silicon Macs use memory, in practice the total
required doesn’t seem to differ that greatly.

You should also aim to keep all your Home
folder and any active projects on the internal
SSD, although moving large media libraries
and less active projects to external SSDs is
often a wise economy. Ensure that you keep
at least 100GB free on your Mac's internal SSD
at all times, and more than that is even better,
as that will prolong its working life.

= ® Q & Wed1225

Macs Painting Q
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Email your queries and your questions
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Startup Security Uity

— Firmware password protection is off.

B 1 20 0N a trrwere password o praveTt T3 comaute rem starting up from e
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0 Full Security
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installation time.
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External Boot

0 Diszllow booting *rom external media
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Enable or remove a
firmware password
for an Intel Mac
using this utility
in Recovery mode.

Removing the extra password

My Intel MacBook Pro used to
start up as soon as | opened it,
but recently I've had to enter my
password before it will show the login
window. How can | reset that?
by PETER INGLIS

This is probably because you've

inadvertently set your notebook to

use a firmware password, which has
to be entered before it invites you to log in.
To disable that, start it up in Recovery mode,
holding the Cmd and R keys during startup.
When the Utilities window appears, click

Are more cores bad news?

(©) CINEBENCH

When | ordered a new
MacBook Air M2, the dealer
mistakenly ordered one with
a 10-core rather than an 8-core GPU.
Will it get hotter and suffer from
a shorter battery life?
by VLADO A

Your new MacBook Air

will come with the standard

four Efficiency and four
Performance CPU cores, which bear

Tools like CPUSetter demonstrate that
GPU use seldom accounts for a substantial
proportion of power use under load.

Utilities in the menu, and choose Startup
Security or Firmware Password Utility,
whichever is available. In that, click to Turn
Off Firmware Password. You'll then be
prompted to enter the firmware password
one last time before it's removed.

Close that utility, and choose the
Restart command in the Apple menu. Your
MacBook Pro should then restart into normal
user mode without troubling you for that
firmware password. If you decide you want
to enable it again, use the same procedure
in Recovery mode, but turn it on instead
and enter your chosen password.

In common with similar
iMacs, it supports a
maximum of 64GB,
installed as four
matching 16GB 260-pin
PC4-19200 (2400MHz)
DDR4 SO-DIMM
modules. Installation
is straightforward
and shown at bit.ly/
mac389imacmemory.

Start your Mac upin
Recovery. At the first
Options screen, hold
Cmd+D until told that
Diagnostics is loading,
then select the language
for the Diagnostics
Loader to run and offer
Diagnostics. If that fails,
Restart to Diagnostics
using the menu.

- o0 s iz s 1
Fu oz o |
Trven

consumption of about 10W, and 13.5W
for the 10-core, but with more cores it
should accomplish the same tasks more
quickly. So this isn't likely to make any
detectable difference in battery
endurance, or in heat output.

If your dealer accepts it was their
mistake and only charges you for the
8-core version, then you're in luck.

the brunt of its work, use much of the
power, and generate much of the heat
in its chip. However, they're used very
efficiently so that, when they're not
required to run code, they draw
almost no power at all.

The GPU handles accelerated
graphics, and is again used on demand.
When pushed, you should notice a

difference in performance from the
extra two GPU cores in the model
you're getting, but even if you do
lots of graphics-intensive work on
it, the difference in overall energy
consumption and heat production
should remain small relative to the
total. Measurements for the 8-core
GPU give a maximum power

Email your queries and your questions
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' GENIUS TIPS macOS

' =X
Shine a spotlight on the solutions to
. Jyour most irritating Mac problems
N
. . —_—
Quickfire e
questions » T
How to reinstall e s
the macos 13'2 ﬁ: ;::cl;m%[&rnbyteeonmskl .MMEIH“:M ;
update? o — o
Because Apple VAockifar; 18 Januiary 2033 at 0893 Finder - g
changed how macOS e IR niness skt e =y e
updates work in Big Sur, S I S B TR R
they now have a lot : ' e i L
more work to do and e _
can't be supplied as —
Installer packages in the : -
way they used to. If you ) 4

o7 slibest
T WM

can't update through

Software Update, the
only alternative is to use
the full installer app,
such as that in the

Mac App Store.

How to keep
sensitive files on an
external SSD?

Using Disk Utility, add
an APFS Encrypted
volume to the existing
container on that drive,
giving it a robust
password. Although
perhaps not quite as
secure as FileVault
protection on your
Mac's internal storage,
you can eject the
volume in the Finder
when you're not using it.

LOMAINGT AIKIV
AR i
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Stop a folder from being deleted in error

| store sensitive documents in a
folder with privileges set for write
only access, as a drop box. Why
then could | almost delete it by mistake?
How should | protect it?

by ANDY S

This is a common misunderstanding
that often gives rise to problems and
accidents. If you want to prevent a
folder from being deleted using permissions,
you have to change the permissions on the
folder containing that folder, rather than
the folder itself. This is because a folder
or directory is essentially a list of its
contents. If permissions allow you to
change the contents of that folder, as
here by adding new files to it, then they
also allow you to delete the folder.

To protect your folder of documents using
permissions alone, put that folder inside
another folder, and set the permissions on
that outer folder to read only. If you then try
to delete either of those folders you'll at least
be prompted to authenticate, and that should
hopefully set alarm bells ringing and stop
you from trashing your documents.

Another useful tool here is locking the
outer of the two folders. As with permissions,
this wouldn't stop you from putting either in
the Bin, but when you try to do so you're asked
to confirm. Consider trusted alternative
approaches too, including a separate APFS
Encrypted volume, or an encrypted sparse
bundle disk image, created using Disk Utility.
These can be given protective permissions
and locked, and both can be unmounted when
you're not using them, unlike a normal folder.

»Email your queries and your guestions
to genius@macformat.com
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How much free
space is needed
for Ventura

Apolications = b o L
Pestiar U anp

Frobiem Repart for Satari

u,j - .ﬁ B updates?
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T size of the macOS
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update, but the
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required to update 13.0
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i e r 25GB available, then
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Can you add a custom icon to Safari?

How can | put a custom icon on
the Safari app in Ventura?
by MIKE SAMS

You can’'t change the icon of any

A bundled app in macOS Ventura, as
they’re now kept in read-only storage.

Most are on the Signed System Volume (SSV),

which is a read-only snapshot. Some, including

Safari, come in cryptexes, special secure disk

images that also can't be changed. Older

e b 3

ke P Tk g 3

O R

»Email your queries and your guestions
to genius@macformat.com

versions of macOS let you work around this by
copying the app to the Data volume, where
you could modify them. Try that with Ventura,
though, and the signature is broken, so the
customised app won't launch.

You have one last chance: Safari
Technology Preview, free from the Mac App
Store, can have a custom app icon. Safari
Technology Preview is a test-bed for new
features that may be included in future
releases of Safari, and often even better.

complete correctly.

Which disk image
format is most
space efficient?

Sparse bundles make
best use of storage
space, but close behind
them now are regular
read/write disk images
(UDRW format) when
kept and used on APFS
volumes. This is
because from macOS
12 they're normally
stored as special
sparse files.

APRIL 2023 | MACFORMAT | 57


mailto://genius@macformat.com

58 | MACFORMAT | APRIL 2023




HOMEKIT:

Cliff Joseph

HomeKit is better than ever - now's the time to get your
smart home in order with help from your Mac or iPhone

here have been numerous
a4 occasions in Apple's
history where it has
developed products or
technologies that were technically
superior to those of its rivals, but
which failed to achieve real
mainstream success. And,
for the last few years, Apple's

HomeKit - the software that it developed
to control smart devices, such as lights
and security cameras - has sat on the
sidelines as Amazon's Alexa and Google
Home have made all the running in the
smart home market. However, all three
companies have been frustrated at
the slow adoption of smart home
technologies, so in 2019 they got together
to develop a new technology called
Matter. HomeKit is actually part of

Matter, so any device that supports Matter
will also work with HomeKit, and you will
still be able to control that device using Siri
and the Home app on your Apple devices
just like any other HomekKit gear.

That's good news for Apple of course,
but Matter casts its net wider and also
provides compatibility with Amazon Alexa
and Google Home. This means that a
smart light or other device that supports
Matter will still work with your Apple
devices, but will also function with
Amazon Alexa and Google Home too.

In this feature, we're going to show
you how to set up your smart home using
HomeKit, and we'll look at the cool things
you can do with it once it's up and running.
HomeKit is steadily improving, so now's a
good time to get your smart home started.
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How H

One app to rule them all (with some help from Siri)

: here's no shortage of smart
ﬁ devices now available that
r you can control with your
iPhone or iPad - smart
speakers, lights, security cameras,
and even thermostats and controls for
air conditioning systems. The problem
is, all these devices require their own
separate apps. If we're ever to reach the
promised nirvana of home automation,
then we need a simpler way of controlling
all our smart devices. Apple developed
HomeKit to provide that solution, by
designing a central control system that
links all our smart devices together. The
HomeKit software is built into Macs, the

iPhone and iPad, and also the Apple TV
box, and is controlled through either the
Home app or by using Siri. Apple also
allows other manufacturers to build
HomeKit into their own smart devices
too, rather than having to rely on
separate apps.

MAKING A SCENE

Having that central control point for lots
of different devices was absolutely the
right idea - and Apple got there before
Amazon or Google. Another strength of
HomeKit is that it also enables multiple
devices to work together, using 'scenes’
and ‘automations’. Scenes let you control

a group of devices together,

perhaps using Siri to say “turn off

all the downstairs lights" at bedtime,
or “turn off the security cameras”
when you come home in the evening.
Automations provide even more precise
control, enabling devices to respond to
specific conditions, such as turning on
your security camera at a specific time
of day, or turning on your lights if the
camera detects movement.

So, from a technical point of view,
HomeKit works very well. Unfortunately,
Apple also made it quite difficult, and
expensive, for other companies to build
HomeKit into their products. This meant

HOME HIERARCHY

The smart home market is
a mess of competing - and
incompatible - technologies

> There's an old saying in the computer
industry: ‘the great thing about
standards is that there's so many of
them'. That's certainly true when it
comes to home automation and smart
devices. There are several technologies
now available that attempt to provide a
control system for all the smart devices
in your home, including Samsung'’s
SmartThings, the oddly named Zigbee,
and the do-it-yourself programming
approach of IFTTT.

But, of course, the big three in the
home automation field are Apple’'s
HomekKit, Amazon Alexa, and Google
Home. HomeKit does work well on
Apple devices, enabling you to control
all your HomeKit-compatible devices
using either the Home app or Siri voice
commands. Unfortunately, Apple's
failure to promote HomeKit in its early
days allowed Amazon and Google to
gain far more support from the
manufacturers of smart home devices.
There are dozens of different brand
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You'll already find a range of speakers that support
Amazon Alexa and Google Voice, but the arrival of
Matter should mean good news for Siri fans.
smart speakers that support the
Amazon and Google voice assistants,
while Apple restricts Siri to just the
HomePod and HomePod mini. It's a
similar situation with lights, security
cameras and other smart devices -
thousands of devices support Amazon
and Google, and leave Apple and
HomeKit out in the cold. Hopefully,
Matter will change that, but here (see
right) is the current state of the big
three in the smart home market...

Amazon raced ahead in the smart
home market, thanks to its
affordable Echo range of smart
speakers (which were far cheaper
than Apple's HomePod). It's
estimated that there are around
100,000 different smart devices
that currently support Alexa.

Google's control of the Android
smartphone market has allowed its
Google Home app - with the Google
Assistant for voice commands - to
take second place in the smart
home market, with Google claiming
there are around 50,000
compatible smart devices.

HomeKit makes it easy to control
your devices through the Home app
or Siri. However, HomeKit has never
really taken off as Apple had hoped,
and it's thought that there are a
few hundred smart devices that
currently support HomeKit (check
out apple.co/3WeNNrX).

»Image credit: Amazon


https://www.apple.com/home-app/accessories/

Google Nest speakers obviously support Google
Assistant, and the Google Home app is currently
in second place in the smart home market charts.

that HomekKit has had to sit on the
sidelines over the last few years while
Amazon Alexa and Google Home got
most of the attention.

The other problem with HomeKit is that
it's Apple-only; if someone in your home
has an Android smartphone or an
Amazon Echo speaker, HomeKit

is no use at all.

So, in 2019, Apple got together with
Amazon, Google and a number of other
companies to develop a new technology
for smart home devices, called Matter.
Using HomekKit as part of Matter means
devices that support it will still be
compatible with the Home app and
Siri on Apple devices. However, the
involvement of Amazon and Google
means that a smart speaker or light
bulb that works with Matter can be
controlled using Siri voice commands
on your Apple devices, but will also work
with Amazon'’s Alexa or the Google
Assistant on non-Apple devices too.

That sounds like a win-win situation,
giving Apple a boost in the smart home
market, and also providing a wider choice
of smart devices that we can buy for our
homes, safe in the knowledge that they'll
all work together quickly and easily.
However, Matter 1.0 was only released
in October 2022, so there aren’'t many
devices currently available that support
Matter. But, with Apple, Amazon and
Google all backing this new standard, it
shouldn't be long before Matter emerges
as the central technology at the heart of
the modern smart home.

»Image credits: le 5 e

MATTER AND THREAD

FOLLOW THE THREAD
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Launched last October, the latest Apple
TV 4K supports both Matter and Thread.
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Setting uyj

in the

he HomeKit software
. is built into macOS, iOS,
r iPadOS and even tvOS on

the Apple TV. However, you
control your HomeKit-compatible lights

and other devices using the Home app,
which is primarily focused on iPhone and
iPad. There are versions of the app on
Mac and Apple TV as well, but these don't
allow you to add new HomekKit devices.

HOW TO Get started with Home >

Of course, any device set up in the
Home app can also be controlled using
Siri voice commands - such as “turn on
the kitchen light” or “lower the volume”
on some music playing on a speaker.

Speakers & TVs
MNaone Playing

HomePod

Welcome Home

The Home app automatically creates
My Home as the default location for all
the devices. It can detect the HomePod,
and it even knows that the HomePod is
in the office, so it adds Office as a new
room within My Home.

Home Settings
Edit Home View

Reorder Sections B

_ Office

2 Home settings

Let's get everything set up before
we add any new HomeKit devices. Click
the menu button (three dots in the top-
right corner) and select Home Settings.
You can also edit the layout of the
Home screen if desired.

HOW TO Add devices and rooms »

Cliff

Resident (Owner)

+  Invite People...

All members in the shared home can
control and see updates from
accessories. People invited to your home
will need to be on the latest software to
accept invitations.

Add people

My Home is a bit dull, so let's use
Home Settings to add a more interesting
name. The app recognises you as the
Owner of this home, but the Invite
People command lets you share
control of your HomeKit devices.

Add Accessory

Add Scene

Add Automation &)
Add Room I

Add New Home

‘I Home and away

Click '+’ to open the Add menu,
where you can add new devices, which
Apple calls ‘accessories'. You can also
set up new rooms, and even an entirely
new Home for devices in another
location, such as your place of work.
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Make sure your accessory is turned on
and nearby, or discoverable.

NEARBY

LIFX Mini
310542

2 Instant setup

This is where HomeKit gets really
clever. The LIFX Mini bulb supports
HomeKit, so rather than having to use
the separate LIFX app, the Home app
on an iPhone automatically detects it.
Just tap the light to add it.

ad)

Living Roofn (é‘uggest...

Add rooms

There's only one room set up at
the moment - the Office for a HomePod
- but the Home app asks where you
want to use any new accessories. Select
Living Room and this is added on the
app's main screen.

»Image credit: Apple Inc



1o} Home

() Automation

<> Discover
Categerias

9 Lights

& security
(g Speakers & TVs
Roams B

Cffice

=1

Living Room

Bedroom -
Dining Room
Entrance Hall
Garage ’

Hallway

Kitchen

== = = B = O = O =1 [ =1

Master Bedroom

D D
HOME ON MAC

>The Home app has been
redesigned for Ventura. You
can only add new devices on
an iPhone or iPad, although
Macs can control devices
once added.

Bedroom

ROOM BY ROOM

>Macs and iPads have a
sidebar that lists all the
rooms in your home, along
with the main categories of
devices. You can click or tap
to view more details.
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Speakers & TVs
:! Nonae Playing

Eedroorm
Sonos Roam
Mot Playing

LIFX Mini
No Response

Hue white lamp 2

FAVOURITES

>Devices within the Home
app are normally organised
by room, but you can also
set some devices to be
Favourites, shown at the
top for easy access.

HOW TO Personalise the controls »

KEY CATEGORIES

>The latest version of the
Home app also shows key
categories of devices. This
makes it easier to control
groups of devices at the
same time.

Y

dd Automation
[0 Add Room

MAKING A SCENE

>With the Mac Home app,
you can add rooms to a
home and also create
automations or scenes that
enable you to control
several devices together.

Automations

When | Arrive
A Home, Turn On o
. When | Leave
& Home, Turn Off

Add automations

The Home app will also ask if you
want to use ‘automations’. These are
commands that automatically respond
to certain conditions - such as using
Location Services on an iPhone to turn

the LIFX light on when you arrive home.

»Image credit: Apple Inc

Office

Hue white lamp 1
T0%

i HomePod
Not Playing

Device controls

You can now see all the rooms that
are set up within this home. You can
turn devices on or off by tapping their
icons, but tap-and-hold will display
additional controls, such as brightness
levels for lights, or volume on a speaker.

Control Centre

The Home app also appears within
Control Centre, providing quick controls
right from your Lock Screen. There's
one button to launch the Home app
itself, but Control Centre can also learn
which devices you use the most.
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Controlling
your devices

How to take full control of your smart home

o far we've followed the

process of adding devices

~ to the Home app, and
assigning them to specific

rooms within your home. But, of course,
you also need to be able to control how
all your devices work. Different types of
devices will provide their own specific
controls - such as brightness or colour
controls for lights, or temperature and
timer controls for a thermostat.

The Home app provides controls for
all your HomeKit devices and it's a great
time-saver, as it means that you don't
have to use several separate apps from
arange of different manufacturers. You
can change the brightness - and even the
colour - of your office lights, adjust the
volume on your HomePod, and turn off
the heating all from within the Home
app. And, of course, for even greater
convenience you can use Siri voice

commands to control these devices
without having to lift a finger.

IN THE ZONE

But controlling individual devices is just
the start of what HomeKit can do, and
the real strength is that it also allows lots
of different devices to work together all
at the same time. The Home app actually
provides several options for controlling
multiple devices together. We've already
seen that the Home app lets you assign
devices to particular rooms, but it's also
possible to create ‘zones' that include a
number of different rooms. This way you
can quickly activate a set of security
cameras in the ‘outside’ zone, or turn
off all the lights in the ‘downstairs’ zone
when you go to bed at night.

The latest version of the Home app in
Ventura and iOS or iPadOS 16 also groups
similar devices together, such as lights,

HOW TO Add devices and rooms >

§
U‘ Goodnight

~ Leave Home
X

Custom

1 Press the ‘+' button in the top-right
corner of the Home app and select Add
Scene. There are some simple Scenes
already built into the app to help you
get started, but you can create your
own custom scenes too.
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Living Room

© LIFX Mini
= HomePod

T OLIRX A9

2 Let's move a few devices into the
living room and create a new scene
called ‘Party’. You can select any device
to be part of this scene, but we'll start
with a couple of LIFX multicolour lights
and the HomePod for some music.

Quick tip

There are clear menu options
within the Home app for adding
scenes and automations, but the
Zones option is oddly hidden out
of sight. To add aroom to a zone,
select the room and then tap the

*... in the top-right corner. Select
Room Settings and you'll see a text
box labelled Zone, where you can
enter the name of the new zone.

You can add several rooms to
each zone, such as ‘upstairs’ and
‘downstairs' zones in your home.
These zones aren't clearly visible
in the Home app, but Siri knows
where they are, so you can quickly
use voice commands such as “turn
off all the downstairs lights".

speakers or security devices. This is
useful for getting a quick overview of
a particular set of devices, such as a
security system that includes several
cameras and motion sensors that may

LIFX Mini
100%

HomePod
Play

LIFX A19
100%

3 Here's the scene with the LIFX
lights set to the brightness and colour
settings needed, and a playlist lined up
for the HomePod. You can also quickly
check that your new scene works
properly by selecting Test This Scene.

»Image credit: Apple Inc



be spread across different rooms or
locations within a home or other building.

SET THE SCENE

The real power of HomeK:it lies in

the ability to create 'scenes’ and
‘automations’, which provide more
precise control over groups of devices
in your smart home. Scenes are
relatively simple, as they primarily
focus on turning devices on or off.

The Home app has a number of
scenes already built into it, including
Good Night which quickly turns devices
off, such as your lights and the heating
thermostat. There's also Leave Home,
which can use Location Services on
your iPhone to recognise when you
leave the building, and can then turns
lights off or perhaps activate a
security camera.

You can also create your own
scenes, such as a Party scene that
changes the lighting and even lines up
a music playlist as well. However, this is
still a straightforward matter of simply
turning devices on or off at the same
time. Automations are a bit more
complex, as they allow your devices to
react to specific triggers or conditions
- perhaps turning a security camera on
at midnight, or turning on a light if the

People Leave

E.g. “Everyane Has Left Home"

A Time of Day Occurs
E.g, "At 08:00" or "At Sunset"”

An Accessory

is Controlled
E.g. “Light Turns On*

4 Tapping the ‘+' menu lets you

add automations too. Automations are
more complex commands triggered by
specific events, such as the time of
day, people leaving home, or a security
camera that detects motion.

»Image credit: Apple Inc
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security camera detects motion when
everyone is away from home. This
extra level of complexity can be a bit
daunting - especially as automations
were poorly explained in earlier
versions of Home - but the app now
suggests one of its presets whenever

Your home hub

> There's one other thing to remember
about using HomeKit and the Home
app. In order to use all the features of
the Home app - including automations,
and remote control of your devices when
you're away from home - you also need
a home hub that acts as a central control
point for all your smart devices.

At the moment, you can use an iPad,
HomePod or HomePod mini, or Apple TV
box as your home hub. You don't have
to do anything to set up your hub,
as the Home app does everything
automatically, as soon as it detects
a suitable Apple device. However,

Apple has said that it plans to phase
out the iPad option with a future
upgrade to the Home app. That

To make the most of the Home app,
you need a central control point.

Detects Motion

Stops Detecting Motion

Time At night

Any time

5 We'll select the Agara security
camera that is set up in a hallway, and
set this automation to respond when the
camera detects motion. The automation
can also be set to work at certain times,
or when you're not home.

you add a new device to help you get
started. Scenes and automations also
work well with Siri, as you can control
groups of devices with simple voice
commands: just saying “Hey, Siri -
Party!" will start your playlist and
get the disco lights flashing.

may disappoint some users who are
currently using an iPad as their home
hub, but it does make sense.

Apart from anything else, your home
hub needs to stay at home in order to
control all your smart devices and, with
Apple increasingly pitching the iPad as
an alternative to a conventional laptop,
you can't rely on always having your
iPad at home anyway. Remember too,
that the HomePod (2nd gen) and Apple
TV 4K (with Ethernet), as well as the
HomePod mini, support Thread wireless
technology, which will be needed to
control a new generation of smart
devices that support Matter and Thread.

< When Motion Detected i... Next
Office

Hue white lamp 1 (/]

Living Room

6 If the camera detects any
movement at night, when away, the
automation will go crazy and turn on
all lights, and even start playing some
music on the HomePod. And, of course,
the camera sends a notification too.

APRIL 2023 | MACFORMAT | 65



[ FEATURE HomeKit quide ]

Hidden HomeKit

HomeKit has some powerful features - here's how to find and make the most of them

he developers of the
Controller For HomeKit app
(see right) introduce it by
- saying: "HomeKit can do
more than Apple's Home app is
showing you". They're right about that,
as there are several features of HomeKit
that aren't easily found within the app.
For instance, we've looked at how the
Home app enables you to use scenes and
automations to control your smart
devices, but you also have the ability
to use automations within the more
powerful Shortcuts app. When you're
creating a new automation, there’s a
Convert To Shortcut button - easily
missed at the bottom of the screen - that
adds the automation to the Shortcuts
app on iPhone or iPad (but not the Mac
version). This provides more advanced
control, such as the ability to use the
Wait command so that a device, such

as a security camera, can wait for a
specified time before triggering another
device - perhaps turning on the lights
or heating when you return home.

Security cameras, in particular, can
benefit from the hidden features within
HomeKit. Most security cameras will
automatically stream live video to your
Apple devices if they detect any unusual
movement, but you generally have to pay
for an additional monthly subscription if
you need online storage in order to
record and store video.

iCLOUD MEETS HOMEKIT

If you have an iCloud+ subscription, then
you also get a feature called HomeKit
Secure Video, which lets you store video
recordings from your cameras online as
part of your monthly subscription. The
iCloud+ subscriptions start at just 79p
per month with 50GB of storage for

HOMEKIT ROUTERS

outers are rarely mentioned

when discussing the

various types of devices

that support HomeKit - and
that's probably because there are
hardly any HomekKit routers available.
In fact, Apple’'s list of HomeKit-
compatible devices lists just a single
router - the Linksys Velop AX4200. It
supports Wi-Fi 6 and you can either buy
it on its own (£259.95 from the Apple
Store) and use it like a conventional
router, or as part of a wider mesh
networking system for larger homes
(from £419.95).

The advantage of using a HomeKit
router is that it can provide additional
security to keep your home network
safe from outside intruders and hacking
attacks. Every smart device that is
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connected to your home Wi-Fi network
is a potential point of weakness that
could allow a hacker to gain access

to your home network. However, a
HomeKit router can provide additional
protection - but only for other HomeKit
devices, such as lights and security
cameras, that are set up within the
Home app.

The router settings within the Home
app enable you to apply ‘restricted’
status to any of your other HomeKit
devices, ensuring that they only accept
commands from the Home app on your
Apple devices, and are also blocked
from going beyond your home network
and connecting to the wider internet.
Some devices do sometimes need to
connect to the internet for software or
firmware updates, so there's also an

your online iCloud Drive. This lets you
store recordings from a single camera,
while other iCloud+ plans support
multiple cameras.

However, camera recordings don't
count towards that storage allowance, so
you can store recordings online and still
have that 50GB of storage available for
other files. That makes iCloud+ an
affordable option for storing camera
recordings online - far cheaper than
the subscriptions offered by most
manufacturers of security cameras.
HomeKit Secure Video also includes
other security features too, such as the
ability to use face recognition, or to tell
the camera to only focus on specific
‘activity zones', perhaps around
a doorway or
parking space.

‘auto’ security setting that allows limited
connections to the internet, or you can
simply opt for ‘no restriction’, which
turns off all HomeKit security features.
However, you can apply these settings
to each of your devices individually.

»Image credit: Linksys Holdings Inc
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Controller For HomeKit provides an alternative to Apple's Home app for creating automations

pple's Shortcuts app

and controlling your devices.
is a pretty daunting
prospect for non-

programmers, but there

are other options for people who
want to delve deeper into HomeKit.
Controller For HomeK:it is a popular
app for Mac, iPhone and iPad, and
the free version provides a more
straightforward interface for
creating automations and scenes.
There's also a Pro version with
advanced features, such as the
ability to respond to notifications
from the Home app, which costs
£24.99 per year (with one week free

trial) or £54.99 for a lifetime licence.

Another user-friendly option for
going beyond the Home app is
Home+, which costs £12.99 from
Matthias Hochgatterer. This again
provides a more streamlined
interface that helps you to create
automations, along with a wider
range of predefined automation
controls than the Home app.

However, the main limitation of
HomekK:it is that it's supported by so
few smart devices. If you've bought
some of the popular Nest range of
security cameras and other devices,

»Image credit: Apple Inc

then you could try the Starling
Home Hub (from starlinghome.io).
For $99 (around £80 plus shipping),
this little device connects to your
Wi-Fi router and acts as a bridge
between your Nest devices and the
Home app on your devices.

And if you're feeling really
ambitious, there's an open-source
project called Homebridge that is
designed to work with a wide range
of smart devices that don't normally
support HomeK:it. Like any open-
source software, Homebridge tends
to be fairly complex to use - and,
like HomeKit, it requires a device
that can act like a home hub, that
must always be left on in order to
run the software and control all
your devices.

Homebridge can be installed on
Macs, Windows PCs, Linux, and even
on the Raspberry Pi too. Once that's
done, you then need to locate and
install a plug-in for the specific
smart devices that you want to
control (more info at homebridge.io).
Setting up a Raspberry Pi with
Homebridge could be a great
educational project for those who
are learning programming.
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What to do if HomeKit
devices do not appear
to work as expected

Log in to your Apple ID

The Home app links to your Apple
ID, so make sure that all your Apple
devices are logged in to the same
Apple ID in order to control your
smart devices.

Check home hub

Some features of the Home app,
such as using automations, require an
iPad, HomePod or Apple TV to act as
a ‘home hub'. It's easy to sometimes
forget and turn off your HomePod, so
always check your home hub if devices
aren't responding properly.

Try out the

manufacturer’'s app
If you're having trouble adding a
device to the Home app, check to
see if it works properly using the
manufacturer’'s own app first. The
app may also have instructions for
adding that device to the Home app.

Turn on Bluetooth

Most smart devices use Wi-Fi
to connect to your home network.
However, some devices also use
Bluetooth during the initial set-up
process, so turn on Bluetooth on
your Apple device while setting
up your smart devices.

Check your

Wi-Fi settings
Some smart devices can only connect
to Wi-Fi networks on the 2.4GHz
band, so make sure that your Apple
device and your third-party smart
devices are using the same Wi-Fi
frequency (you can switch bands
again later).
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Some of the best HomeKit gear for making life easier

omeKit may still be trailing
f. behind Amazon Alexa and
' ©  the Google Assistant in the
home-automation market,
but there are still enough HomeKit-
compatible devices available to create
a pretty impressive smart home setup.
The three top product categories in
the smart home market are speakers,
lights and security cameras. Apple does
have a list of HomeKit-compatible devices
on its website (@apple.co/3WeNNrX). The
list includes lots of other devices such
as thermostats, controls for fans and

Lights, action!

air conditioning systems, smart locks for
your front door, and even remote controls
for garage doors. However, many of
these more complex devices require
professional installation - the last thing
you want to do in the winter is screw up
your heating by trying to wireup a
HomeKit thermostat by yourself!

AIRPLAY & HOMEKIT

That brings us back to the big three
smart home items - speakers, lights and
security cameras. The good news for
audiophiles is that Apple's AirPlay

Build a smart lighting system with these HomeKit bulbs

> As we've mentioned, Philips has
dozens of different lights in its Hue
range. But, if you want to use your Hue
lights with HomeKit and the Home app,
then it's best to start with one of the
Hue Starter Kits. There are several
Starter Kit options, costing as little as
£69.99 for a basic kit with two plain
white bulbs, going up to £169.99 with
three colour-changing bulbs. However,
all the Starter Kits also include the Hue
Bridge, a small box that connects to
your home Wi-Fi router with an
Ethernet cable.

The Hue lights will work on their
own, but it's the Hue Bridge that
provides HomeKit compatibility, so you
need the Bridge in order to use your
Hue lights with HomeKit and the Home
App (and make sure you get the square
second-gen Bridge, and not the
circular first-gen version as
that's not compatible with
HomekKit). Once you've got the
Hue Bridge connected to your
router, you can then expand
your lighting system with any

When it comes to HomeKit-friendly
lighting, the Philips Hue range really
does have a lot of bases covered.

of the other Hue lights that you want
to buy, including ceiling-mounted
lights, floodlights for outdoor use,
and even the colourful Festavia
Christmas lights. Philips has also
announced that it plans to provide

a software update for the Hue Bridge
that will allow it to support Matter

in the coming months.

One other thing to watch out for
is that some of the Hue lights utilise
Bluetooth, rather than using Wi-Fi to
connect to your home network and
the Hue Bridge. Bluetooth lights can
be controlled individually using the
Hue app, but they're not compatible
with HomeKit, so be aware that you
won't be able to control them with
your other lights and smart devices
within the Home app.
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software - which was originally designed
for multi-room speaker systems - is
compatible with HomeKit and the Home
app. This means that any AirPlay speaker
can be controlled using the Home app,
Siri, or Control Centre on any of your
Apple devices. You can even mix
and match speakers from different
manufacturers, perhaps playing the
same music on a Sonos Roam portable
speaker in your garden, and also on
a HomePod in the kitchen.

And, while HomeKit has struggled
to attract support from other
manufacturers, AirPlay has been
adopted by many big-name audio brands,
such as Sonos, Bowers & Wilkins, and
Bang & Olufsen. Even Ikea has got in
on the act with its somewhat bizarre
Symfonisk speaker/lamp hybrid. The one
disappointment here is that Apple doesn't
allow these manufacturers to include Siri
in their smart speakers, so the only smart
speaker that currently supports Siri are
Apple's HomePod and HomePod mini.

LIGHT UP YOUR HOME

There aren't a huge number of smart
lights that support HomeKit, but the key
player that dominates this market is
Philips with its Hue range of smart lights.
Philips was one of the first companies to
support HomeKit in its products, and the
Hue range has been very successful,
spawning a wide range of lights, bulbs
and lamps for use in different rooms

‘_-d
PHILIPS
PHILIPS
: hue
= = v
_— s— -——
= —
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»Image credits: Signify Holding, Bowers & Wilkins
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HomeKit guide FEATURE

Any AirPlay speaker, such as the Bowers & Wilkins
Zeppelin, can be controlled using the Home app, Siri,
or the Control Centre on your Apple devices.

around your home, and even outdoor
lights for your garden or parking space.

If you want to use Hue products with
HomeKit and the Home app, then you
also need to buy a Hue Bridge - either
on its own or as part of a Hue Starter
Kit (see left). There are a couple of
other companies that make HomeKit-
compatible lights that are also well
worth exploring. LIFX makes a range
of lightbulbs, starting with simple,
affordable white bulbs through to
multicolour options, as well as decorative
lightstrips and even lighting kits for
gamers (available from lifx.com, although
they're not all HomeKit-compatible, so
make sure to check that before buying).

Nanoleaf also makes simple bulbs,
but it's best known for eye-catching,
multicolour modular lighting systems
(nanoleaf.me). Rather than using bulbs,
its lighting kits have names such as Lines,
Hexagon and Canvas, and consist of
illuminated panels of various shapes
that you can link together to create
decorative lighting designs that are
almost like sculptures - or, of course,
just disco lights for a party.

The future is looking even brighter
too as there are other companies, such
as Wiz (wizconnected.com), that have
announced plans to support the new
Matter technology with their smart
lights and other products. Matter will
be compatible with HomeKit, so that
should mean that there are more
speakers, lights, security cameras
and other devices available for Apple-
loving homes than ever before.

»Image credits: Logitech, Netatmo

HOMEKIT SECURITY

e're all concerned
‘M about the security
of our homes, so it's
hardly surprising that
security cameras are one of the
most popular categories of smart
devices. But while there are
dozens of security cameras
available that provide apps for
iOS and Android, there's a very
limited selection that also support
HomeKit and the Home app.
HomeKit cameras tend to be
quite expensive, but Agara is a new
company that makes some very
affordable security cameras, such
as its G2H Pro, which costs just
£74.95. The camera can also act
as a control hub for other Agara
security sensors, making it a good
way of setting up an affordable
security system for your home.
One of the few security
cameras that is totally focused on
HomeKit is Logitech's Circle View,
which can only be controlled
through the Home app on Apple
devices. Priced at £159.99, the
Circle View is a 1080p camera with
wide-angle lens and a sturdy metal
casing that is suitable for indoor
or outdoor use. The Circle View
doesn't have a battery, though,
relying on a 10ft long USB cable
for its power supply instead, which
means that it's not as portable
as some of it rivals. (Logitech
also introduced a Circle
View Doorbell recently,
costing $200, although this
isn't available outside the
US at the moment.)
If you're looking for a
dedicated outside option,
then you could consider
Netatmo's Smart Outdoor
Camera, a sturdy
floodlight camera
that is ideal for

monitoring gardens, parking spaces
and other outdoor locations. The
basic camera costs £239.99 or
there's a model with a built-in siren
for £289.99. Netatmo also makes
an indoor HomeKit security
camera, along with a range of
motion sensors, smoke alarms

and even thermostats too.

One of the biggest names in
security cameras is Arlo, which
makes an extensive (and
expensive) range of security
cameras. However, it's only the
more expensive models that
support HomeKit, such as the
Arlo Ultra 2 with 4K resolution
for £629.99 (for two cameras).
And, like many security cameras,
the Arlo range requires an

additional subscription
if you want to secure
online storage for your
video recordings.
However, this is one
area where HomeKit
can come to the rescue,
with useful, money-
saving features such as
HomeKit Secure Video,
which is available as
part of Apple's iCloud+
subscriptions (see p66).
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MANAG
YOUR
MONEY

ON MAC, iPHONE & iPAD

KENNY HEMPHILL

udgeting and looking
B after your finances

has never been much
fun. But the advent of open
banking a few years ago, along
with advances in artificial
intelligence have at least made it
easier and less of a chore. There
really is very little excuse now for
not keeping tabs on how much
you spend, where you spend it

of them also help you budget
by suggesting ways you could
spend less. For example,
by finding a better deal for
broadband than you
currently have. And they'll
suggest ways to save, such as
rounding up spending to the
nearest £1and putting the
difference in a savings pot.
While lots of banks now have

and when, no matter which of
your accounts it comes from.
The apps we've tested here
take advantage of open banking,
which allows them to access
data held by your bank about
your spending, SO you can see
everything in one place. Many

their own apps which allow you
to do similar things, the apps
here have the benefit that they
work with most bank accounts
and so, if you have accounts
with multiple providers, you
can see all your incomings

and outgoings in one place.

For each app, we looked at how friendly it was to use and how helpful
it was in terms of making suggestions about saving money. We also
checked which bank accounts each app supported, whether they had
apps for iPhone, iPad and Mac, and how easy it was to do things like split
bills, round up spending into savings pots, and manage direct debits and
standing orders. We evaluated how easy or otherwise it was to navigate
each app and complete the tasks we needed to carry out most often.

»Image credit: Getty Images



Budgeting apps

Things to consider...

Clearly this is essential if you
want an overview of your spending.
Few of us want to change bank account
just to use a money management app,
no matter how good it is.

Approved providers are
requlated by the Financial Conduct
Authority. If you're considering an app,
you can check at openbanking.org.uk.

Some providers have linked
savings accounts that pay interest. If
it's a better rate of interest than your
bank, it's worth considering, though

& Bankifvity File  Edit

Summary.

Calendar
ic

View Account  Transaction  Window  Help

+ ¢

Banktivity
Edited

Summary

Monthly Income & Expense

(B Het worth

you may have to pay extra for it.

Some apps look for discount

codes and vouchers for places you
shop reqgularly. Others will work ou
what you spend on utility bills

and suggest a switch.

Banktivity
Bronze Silver
banktivity.com i0S
Banktivity is the
successor to iBank, a
popular finance management
tool for the Mac. It's aimed at
those of us who don't want
any of the features of the
smart banking apps and just
need a tool that to help with
budgeting.

You can connect to your
bank to download balances
and transactions, and if you
do it reqularly, Banktivity will
learn how you name and
categorise transactions and
do it for you. You can group
accounts in ways that are
meaningful; for example,
one group for regular bank
accounts, another for savings
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Sat Up Budoet »

SLMMARY

Gold
13.5/mac0S 10.15 or later

accounts, and another for
credit cards and loans.

If you use it to budget,
you can tell it how much you
want to spend in a given
month, and then generate
reports to track your
progress. Generating
reports is a key strength
of Banktivity, allowing you
to view your incomings and
outgoings in just about every
way you could imagine.

+ Detailed reports

+ Mac app

- Expensive

= Takes a while to set up

*k

Emma

: Emma Plus
Ultimate

2 Emma enables you to
keep track of multiple

bank accounts in one place.
There's an iOS app, though no
Mac app and no option to log
in via a web browser. The free
version enables you to track
subscriptions, set budgets
and view weekly spending
reports. You can also get
daily balance notifications
and overdraft alerts, pay
friends and transfer money
between accounts.

Paid for features include
seeing the ‘true balance’ of
your account after monthy
subscriptions and other
reqular payments have
been deducted, and the

: Emma Pro
emma-app.com

; Emma
iOS 11

opportunity to earn cashback
from selected retailers in the
Plus version. The Plus version
also offers fraud detection
and more frequent syncing
with your bank. The Pro
version gives you ability to
rename transactions and
create offline accounts, and
the Ultimate version allows
you to add business accounts
and to create ‘Spaces’ of
grouped accounts.

+ Easy finance tracking
+ True balances
- Expensive
= iOS only
*

Image credits: IGG Software Inc, Emma Technologies Ltd
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Budgeting apps
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MoneyWiz 2023
Finance Tracker

hyperjar.com
i0OS 13 or later
; Standard
wiz.money

; Premium
shops or services and set i0S 13.4/mac0S 10.15.4 or later

3 HyperJar is different
spending limits.

to the other apps here,

because of the way it splits
your money into ‘jars’. You
get a pre-paid debit card that
you load money onto. Once
you've done that, you can
split the money into the ‘jars’,
which can be used for saving
or spending, and they can be
shared. So, for example, you
could have one jar that acts
as a shared account with a
partner, and another you can
put joint spending money into
for a holiday with friends.
Kids get their own app
and card and parents can add
money to it, monitor
spending, block specific

Image credits: HyperJar Ltd, Silverwiz LLC

The main app offers
rewards and discounts from
some stores and lets you
schedule payments into jars.
You can link shops to jars so
when you spend in a shop the
funds are taken from that jar,
and you can set limits to
block certain shops or specify
which shops' spending can be
taken from a specific jar.

+ Easy to manage spending
+ Discount offers
= Doesn’t connect to banks

= Need to use Hyper]Jar card
ok

4 The MoneyWiz app
can connect to your
bank accounts and, thanks
to the fact it uses third-
party providers to acces
your bank, it offers coverage
of 40,000 banks in 55
countries. Or you can choose
not to connect your bank
account and track income
and expenditure manually.
The free tier enables you
to carry out basic tasks, but if
you want to sync with multiple
devices, you'll need a Standard
subscription. To sync with your
bank accounts regularly, you'll
need the Premium version.

As well as tracking your
spending in a bank account,
MoneyWiz can keep tabs on
credit cards, investments,
loans, and cryptocurrency.

There are over 30 types of
reports you can generate, and
save as CSV or PDF. Despite
this, MoneyWiz's interface is
clean and easy to use.

+ Mac, iPhone and iPad apps
+ Lots of reports

= Lacks savings suggestions
= Premium version needed
to regularly sync with banks

*
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4 Search
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Rules

How | put maney aside

e Automatic
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Mermal

Maughty rule

Round Ups

Weekly. on

Pay Days

Set money aside just

Rainy days

Overdraft Deposits

Weekly Depositor

Set aside an amount every week

Whenever it rains, I'l set

4 Brain

RGN MO WS VLRI

52-Week Challenge

Sat asid

Blum

; Pro
withplum.com

Ultra

5 Plum is designed to
help you save as much

as possible. Like HyperJar, it
comes with a pre-paid debit
card, although in this case, it's
optional. And like the other
smart banking apps here, it
enables you to connect your
existing bank accounts.
There's a linked savings
account that pays interest
of up to 2.45%, though you'll
need to pay for a subscription
to access that rate.

Plum'’s attraction is in the
way it allows you to set rules
for saving money and then
analyses your income and
expenditure to determine how
much to put into savings and
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Premium

i0S 14.1 or later

when. It even turns saving
into a game by setting
challenges and, for example,
by putting money into your
savings whenever it rains.
Plum splits spending into
categories and suggests ways
you can save. You can also
use Plum to invest and
manage a Self-Invested
Personal Pension (SIPP), by
transferring an existing
pension into it.

VERDICT

+ Savings account

+ Challenges

= Limited bank support
= No reporting tools

* Kk

@ Home

Grab up to £150 in
vouchers when you
switch broadband

n

H Entertainment

Pinned

@ Find cut-price theatre tix incl.
Frozen, Lion King ¥

Here's my guide to find e cheapest tickets online

and what to expect pos

Browse

@ Home

Cut the cost of

your council tax bill
”
Lo

§noop

; Snoop Plus
i0S13.0 or later

6 While several apps
here aim to help you

save more, Snoop is designed
to help you spend less. It
tracks your spending in the
accounts you link to it and
analyses how much you
spend and where you spend
it. Snoop then suggests ways
you could save money.

For example, if it notices
you spend a significant sum in
a specific store, it will suggest
ways you could save money in
that store. It will also look for
price hikes in subscriptions
and utility bills and make it
easy to stop subscriptions
you don't use or switch utility
suppliers at the optimal time.

snoopapp.com

Snoop also keeps an eye on
your insurance policies and
checks annually to see if you
could get a better deal. Plus,
it works with other companies
to offer deals on things like
utilities and insurance.

The Plus version lets you
to create custom categories
so if your planning a wedding
or a renovation project, you
can track how much you
spend on them.

VERDICT

+ Switching deals

+ Custom categories

= Nags to upgrade

= Offers over-promoted

ok

Image credits: Plum Fintech Ltd, Usnoop Ltd
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THE WINNER

MoneyWiz 2023 Finance Tracker

Mac, iPhone and iPad apps, a clean interface, and tons of reports make it our top pick
hoosing a winner
C among the apps
here was difficult.
The four ‘smart’ banking apps
- Emma, Hyperdar, Plum and
Snoop - offer variations on

fewer banks than the others
and so we felt we couldn’t
make it a winner. HyperdJar
is a great idea and for some
people will work very well.
Snoop has some good

little annoying. Banktivity has
a long history on the Mac
(thanks to its predecessor
iBank), and has iPhone and
iPad apps. But we found the
set-up process laborious,

our favourite among the new
breed of smart banking apps,
at £14.99/month for Ultimate,
it's pricey. MoneyWiz is a
deserving winner. It has Mac,
iPhone and iPad apps, had

while its interface is not as

friendly as the others here.
That left Emma and

MoneyWiz. While Emma was

no trouble connecting to
our bank and enables us
to analyse our finances in
a huge variety of ways.

analysis features, but we
found the way it urged us
to upgrade or cut bills by
switching provider to be a

the same features, while
Banktivity and MoneyWiz give
you something very different.
Plum supports significantly

p =
How o
do they O
compare?
Specs Banktivity Emma HyperJar MoneyWiz Plum Snoop
Website banktivity.com emma-app.com hyperjar.com wiz.money withplum.com snoopapp.com
Cost for all features | £97.99/year £14.99/month N/A £48.99/year £9.99/month £499/month or
£31.99/year
Bank support Good Good Only for adding Good Fewer banks Good
funds to card than the others

Jododkok

True balance

Jododokok

Savings jars

Jokok

Reports
CSV export

Ease of use
Best feature
Nice to have

Yook
Reports

Can group accounts

Yook
Savings account

Savings challenges

Switching offers

Custom categories

Rewards and
discounts

Cashback offers

Note: The final verdict scores reflect the overall opinion of a product and are not necessarily an average of the criteria listed in the table.
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APPLE CHOICE Mac hardware

MacBook Pro
6-inch (2023)

T_he world's best laptop is now even better - and how!

> From £2,699 (model tested £3,699) » FROM apple.com/uk > FEATURES M2 Pro chip (12-core CPU, 19-core GPU),
512GB storage (2TB tested), 16GB of unified memory (32GB tested), 16.2-inch Liquid Retina XDR display (3456x
2234), MagSafe 3, 3x Thunderbolt 4 (USB-C) ports, x HDMI port, Wi-Fi 6E (802.11ax), Bluetooth 5.3

M2 Pro offers
impressive
performance
without
draining the
battery

The MacBook Pro 16-inch has
three Thunderbolt/USB 4
ports, plus an HDMI port, an
SDXC card slot and MagSafe 3.

e € RRR———

= e — ———— I

aunched alongside its 14-inch
sibling in January, the MacBook

Pro 16-inch doesn't so much
reinvent what Apple's laptops can do as
refines it, making it slicker and quicker than
ever, while retaining all the things about
the Apple silicon era we love - incredible
performance and battery life, wrapped in a
sophisticated and elegant portable package.

Before we explore the performance of the
MacBook Pro 16-inch, let’s look at the line-up
in the round. As we've suggested, the 2023
MacBook Pro comes in two different sizes, but
multiple configurations. Prices start at £2,149
for a MacBook Pro 14-inch with an Apple silicon
M2 Pro (10-core CPU, 16-core GPU and 16-core
Neural Engine), and also benefits from 16GB of
unified memory, 512GB of solid-state storage,
and topped off with a 14-inch Liquid Retina XDR
display. Paying £2,699 gets you a step-up
model with a 12-core CPU, 19-core GPU M2 Pro,
plus 16GB of unified memory and a 512GB SSD.
And £3,349 gets you a MacBook Pro 14-inch
with an M2 Max chip (12-core CPU, 30-core
GPU, 16-core Neural Engine), plus 32GB of
unified memory and 1TB of storage.

The MacBook Pro 16-inch line-up is similar.
The entry-level starts at £2,699 for a model
equipped with a 12-core CPU, 19-core GPU M2
Pro, plus 16GB of unified memory and a 512GB
SSD. Paying £200 more gets you an otherwise
identical model equipped with a 1TB SSD, and
the standard configurations top out at £3,749
for a MacBook Pro 16-inch equipped with a
12-core CPU, 38-core GPU, 16-core Neural
Engine M2 Max, 32GB of unified memory and
1TB of solid-state storage.

The new MacBook Pro steers clear of the controversial
Touch Bar in favour of a physical Function key row.

Like many Apple products, the MacBook
Pro can be equipped with a range of build-to-
order options, including both for memory and
on-board storage. A fully specced out MacBook
Pro 16-inch with a 12-core CPU, 38-core GPU
M2 Max, 96GB of memory and 8TB of storage
will cost you £6,749. The model on test here
though is more modest, being equipped with
a12-core CPU, 19-core GPU M2 Pro, 32GB of
unified memory and 2TB of storage, and costs
a considerably less wallet-straining £3,699.

Design and build
Whichever MacBook Pro you choose you're in
for a treat - both the 14-inch and 16-inch model
takes all the things you love about the pre-
Touch Bar-era Macs and polishes them to
perfection. In the hand, these are gorgeous
laptops to look at and to use with a generous
helping of ports on their left- and right-hand
sides, including 3x Thunderbolt/USB 4 ports,
MagSafe 3, an HDMI port, 3.5mm headphone
jack and an SDXC card slot, plus Bluetooth 5.3
and Wi-Fi 6E (802.11ax) wireless connectivity.
The keyboard, with its full physical Function
key row, is wonderfully tactile and easy to type
on, while the generously sized Force Touch
trackpad almost looks too big, until

e

you come to use it when its size
becomes a virtue. The only thing

e ——
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| that possibly counts against it is the
MacBook Pro's weight and size - at


https://www.apple.com/uk/

The 2023 MacBook Pro 16in
looks identical to its 2021
predecessor, right down to
its Force Touch trackpad and
FaceTime HD camera notch.

1.68x35.57x 24.81cm and 2.15kg for the 16-inch
M2 Pro model, and 2.16kg for the M2 Max, it's
hefty to lug around. Think of it as a desktop
replacement with occasional forays out on the
road, though, and you won't go far wrong.
Note: we've not mentioned the remaining
model in Apple's MacBook Pro line-up: the
13-inch. That's because, while it's still an
accomplished machine, it feels more like a
throwback to the last of the Intel-era models,
with its Touch Bar and limited port selection.
The 13-inch is also the only MacBook Pro to
come with the standard M2 chip, rather than
an M2 Pro or M2 Max, making it more akin to a
MacBook Air on steroids than a true ‘Pro’ Mac.
Before we move on to its performance,
there are two other things to love about the
2023 MacBook Pro: its display and its battery
life. The Liguid Retina XDR display on the
16-inch is truly incredible to look at and to use,
with its mini-LED backlighting offering 1,600
nits of peak HDR brightness, plus a1,000,000:1
contrast ratio. Throw in P3 wide colour gamut
support and you have a display you want to
drown yourself in - from photo editing to movie
viewing, it looks superb. And you get that with
a true all-day battery life of up to 22 hours -
and that was certainly the case in our tests.

Performance
The arrival of Apple silicon in 2019 has been
a true game changer for the Mac. No longer
subject to the whims (and shortcomings) of
Intel, Apple has been free to create custom
chips for its computers that deliver not only
in terms of pure power and performance, but
also in efficiency - a MacBook Pro with an M2
Pro or Max runs just as quickly on battery as
on mains power, and without sending you
scurrying for the nearest power socket like
Intel-era machines could.

Proof of those power and efficiency gains
manifests itself in two ways. Firstly, the M2 Pro
offers 30% faster graphics
performance than the M1 Pro
that preceded it, while also
delivering twice the memory
bandwidth (at 200GB/sec) of
the standard M2 launched in
2022. And the M2 Max goes
even further, also marking
a30% increase in GPU
performance over the M1 Max
and four times the memory
bandwidth (400GB/sec). ©

The M2 Pro chip offers 30%
faster graphics performance
than the M1 Pro chip and 2x
the memory bandwidth of the
standard M2.
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BENCHMARKS Our analysis explained »
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Index score (higher is better)

GEEKBENCH 5
SINGLE-CORE TEST

> This tests the capability of a single
processor core. Many more common
tasks on a Mac will only use a single
core at a time. Geekbench 5 is a
universal app running on Ventura.

Duration (shorter is better)

HANDBRAKE

VIDEO ENCODING

> We transcode a Blu-ray-quality
video file into H.264 format using
HandBrake to test the multicore
processor performance. Handbrake
is available as a universal binary.

Frames per second (higher is better)

RISE OF THE TOMB
RAIDER (1920X1280)

» For a real-world gaming test, we
use the benchmarking tool in this
game, with the graphics quality set
to High and the resolution set to
1920x1280. Not yet optimised for M1.

Duration (shorter is better)

DAVINCI RESOLVE

» In Blackmagic Design’s editing tool
for video professionals, we exported
an effects-laden, 2.5-minute project
to the H.264 format. The latest
version of the app (Version 18)

runs natively on M1 Macs.

Mac

FORMAT

VERDICT

> The MacBook Pro

is better than ever
with the 2023 16-inch
refining both power
and performance.

Yodokodok

& Fast and efficient
Apple silicon

& Great design

@ Better battery life
& 16-inch is big!
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The edge-to-edge Liquid Retina display is one of the brightest
and best on any laptop - and now has microLED backlighting.

© Those claims are borne out by our
benchmarks. From Geekbench 5 to Handbrake,
Rise of the Tomb Raider to DaVinci Resolve, the
MacBook Pro 16-inch we had on test delivered,
and then kept on delivering.

In Geekbench 5, the M2 Pro MacBook Pro
achieved an average single-core performance
score of 1,961 points, putting it way ahead of
the M2 MacBook Pro 13-inch we benchmarked
last year (1,903) and even further ahead of the
M1 Pro MacBook Pro, which achieved 1,703.

It's a similar story in Handbrake, where we
transcode an hour's worth of 4K video. Here,
the M2 MacBook Pro achieved the desired
result in 14 mins 3 secs, compared to the

23 mins 13 secs of the M2 MacBook
Pro 13-inch (2022), although it was
slower than the M1 Pro MacBook Pro

(2021), which achieved the same
result in 8 mins 40 seconds - a
result of slower SSD speeds perhaps.
In DaVinci Resolve, we were able
to render and export an effects-laden
video in 9 mins 31 secs on the M2 Pro

- MacBook Pro, compared to 19 mins 38

B sccs on the M2 MacBook Pro 13-inch
(2022) and 10 mins 57 secs on M1 Pro
MacBook Pro 16-inch from 2021.

In Rise of the Tomb Raider too, the M2
Pro MacBook Pro was butter-smooth
- when running our benchmarks,
g peaking at 49fps, despite the
game not being optimised for
Apple silicon. While that's only
10fps higher than the M1 Pro MacBook Pro
from 2021, it's better than the 25fps achieved
by last year's M2 MacBook Pro.

Polish and poise

With Apple redefining the MacBook Pro in all
kinds of interesting ways two years aqgo, it's
no surprise that the 2023 version should feel
evolutionary rather than revolutionary. But it's
no worse for that. With new Apple silicon, and
careful, considered refinements on board, the
MacBook Pro 16-inch remains one of the best
- if not the best - laptops in the world right
now. From its design and build to its power,
performance and battery life, it's an incredible
machine to own and to use. We can't wait to
see what Apple does next. Rob Mead-Green



The new HomePod takes
everything we loved about
Apple’s original smart
speaker and makes

it even better.

Hardware

HomePod (2023)

Apple’s original smart speaker is back — and better than ever

» £299 > FROM apple.com/uk » FEATURES 4-inch high-excursion woofer, 5x horn-loaded tweeters, 4x microphones for far-field Siri,
multi-room audio with AirPlay, Spatial Audio, Bluetooth 5.0, Wi-Fi 4 (802.11n), Thread, Ultra Wideband chip, 168x142mm, 2.3kg

The HomePod
delivers your
tunes with
real gusto,
sounding loud
and punchy

FORMAT

VERDICT

» Siri and connectivity

limitations aside, the
new HomePod proves
it was worth the wait.

Fokokok

& Brilliant sound

© Design and build

& Limited connectivity
@ Siri weaknesses

»Image credit: Apple Inc

like the follow-up to the first Stone
Roses album, HomePod aficionados

had almost given up on its second
coming following Apple’s ditching of it in
2021; its focus shifting to the HomePod
mini instead. Only now we have this; the
all-new second-gen HomePod and, boy,
was it worth the wait.

While outwardly little seems to have
changed, in reality everything has - from the
design of the mesh fabric outer (available in
black or white) to the Siri window on the top,
the 2023 HomePod is new. So too are its
insides. Now driven by an Apple S7 chip (the
same as in the Apple Watch Series 7), it
features a 4-inch high excursion woofer (for
mid-range and bass sounds), five horn-loaded

While it'll look familiar to anyone who owns an original,
the 2023 HomePod is all new - both inside and out.

tweeters (down from seven in the original)

and four microphones (down from six) for
listening to Siri instructions, plus humidity and
temperature sensors (also now enabled on the
existing HomePod mini). Other new features
include Thread smart home support and an
Ultra Wideband chip so you can hand off music
(and other sources) from your iPhone to the
HomePod by bringing it close to the speaker
and, somewhat controversially, Wi-Fi 4 (aka
802.11n) rather than Wi-Fi 6 (802.11ax) - Apple's
reasoning is that support for the latest Wi-Fi
standard simply isn't needed on a device
primarily designed for streaming sound.

Sound astounds

And what sounds they are. Where the
HomePod mini gives a spirited but small-scale
rendition in mono (pairing two in stereo works
better), the HomePod delivers your tunes with
real gusto, sounding loud and punchy without
overwhelming with boomy bass (like the
original could). From jazz to rock, classical to
vocal, the HomePod rarely disappoints - and,
when used for soundtrack playback on Apple
TV, it sounds glorious with realistic-sounding
dialogue, music and sound effects.

There's no doubt that two HomePods
sound better that one, while connectivity
remains limited to AirPlay. It's unfortunate, too,
that Siri remains a weak spot in an otherwise
brilliant multi-room speaker. Rob Mead-Green

APRIL 2023 | MACFORMAT | 81


https://www.apple.com/uk/

APPLE CHOICE Hardware

Mac mini (2023)

Apple’s most affordable Mac goes Pro — and about time too

» From £649 (model tested £1,899) » FROM apple.com/uk » FEATURES M2 chip with 8-core CPU, 10-core GPU, 8GB unified memory
(16GB/24GB available), 256GB storage (512GB/1TB/2TB available), two Thunderbolt 4 ports, M2 Pro chip with 10-core CPU, 16-core
GPU (12-core CPU, 19-core GPU available), 16GB of unified memory (32GB available), 512GB storage (1TB/2TB/4TB/8TB available),
four Thunderbolt 4 ports; HDMI port, Gigabit Ethernet port (10Gb Ethernet available), 3.5mm headphone jack, Wi-Fi 6E (802.11ax),

Bluetooth 5.3, built-in speaker, 3.58x19.7x19.7cm

Not only does
the M2 Pro

Mac mini have you're looking to make a first-time purchase,
. buy a second computer for your home or
more power, 1t office, or as an upgrade to an older machine.
also gets more That's because not only is the new Mac mini
£50 cheaper than before, it's now been
memory, more upgraded in a couple of significant ways. The
storage and first is that it's now powered by the same M2
System-on-a-Chip (SoC) found in the MacBook
more pOI'tS Pro 13-inch and the MacBook Air; the second

is that Apple’s now appealing to those of us

who want ‘pro’ level desktop Mac features,

but don't want to pay for a ‘pro’ Mac Studio.
To that end, there's a new option available

on the Mac mini, and that's to kit it out with an

M2 Pro, the same powerhouse chip used in the

The M2 Pro-powered Mac mini
has more ports, as well as a lot
more power than the M2 version.

ith prices starting at £649, the new
W Mac mini is an even more affordable

way to buy into the Mac - whether

MacBook Pro 14- and 16-inch (see p78). Not only
does the M2 Pro Mac mini have more power, it
also gets more memory, more storage and
more ports - although those added extras do
come at a cost, as you'll soon see.

Before we get to that, let's take a look at the
design. Like the previous-gen mini, the 2023
version comes in a low-slung aluminium box
with a power light on the front and a selection
of ports on the back. On M2-powered models
you get 2x Thunderbolt/USB 4, 2x USB 3.2 type
A ports, an Ethernet port, HDMI and a 3.5mm
headphone jack. M2 Pro-powered versions get
two additional Thunderbolt/USB 4 ports, plus
support for additional external displays.

While the M2-powered Mac mini can
support up two external displays (one at 6K, or
one at 5K plus one at 4K), the M2 Pro-powered

version can handle up to three (either two at

BENCHMARKS Our analysis explained »

6K and one at 5K via Thunderbolt, or two at
6K via Thunderbolt, plus one at 4K via HDMI).
Additionally, while the M2-powered Mac mini
can be kitted out with a maximum of 24GB

of unified memory and up to 2TB of storage,

Mac mini 3.3GHz M2 Pro (2023) Mac mini 3.3GHz M2 Pro (2023)

MacBook Pro 16in 3.3GHz M2 Pro (2023) MacBook Pro 16in 3.3GHz M2 Pro (2023)

Mac mini 3.3GHz M2 Pro (2023)

MacBook Pro16in 3.3GHz M2 Pro (2023)
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MacBook Pro 16in 3.3GHz M2 Pro (2023)
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GEEKBENCH 5
SINGLE-CORE TEST

» This tests the capability of a single
processor core. Many more common
tasks on a Mac will only use a single
core at a time. Geekbench 5 is a
universal app running on Monterey.

HANDBRAKE

VIDEO ENCODING

»We transcode a Blu-ray-quality
video file into H.264 format using
HandBrake to test the multicore
processor performance. Handbrake
is available as a universal binary.
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Frames per second (higher is better)

RISE OF THE TOMB
RAIDER (1920X1280)

> For a real-world gaming test, we
use the benchmarking tool in this
game, with the graphics quality set
to High and the resolution set to
1920x1280. Not yet optimised for M1.

Duration (shorter is better)

DAVINCI RESOLVE

»In Blackmagic Design'’s editing tool
for video professionals, we exported
an effects-laden, 2.5-minute project
to the H.264 format. The latest
version of the app (Version 18)

runs natively on M1 Macs.

»Image credit: Apple Inc
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Mac mini (2023)

APPLE CHOICE

the M2 Pro version can handle up to 32GB
of memory and up to 8TB of storage.

Spending £649 will bag you an 8-core CPU,
10-core GPU M2 Mac mini with 8GB of memory
and 256GB of solid-state storage, while £849
will get you an 8-core CPU, 10-core GPU M2 Mac
mini with 8GB of memory and a 512GB SSD.

To get into M2 Pro territory, though, you'll
need to spend at least £1,399 with build-to-order
prices rising from there. The model we tested
came with 12-core CPU, 19-core GPU M2 Pro with
16GB of memory and a 1TB SSD and costs a cool
£1,899. That makes it cheaper than a Mac
Studio, though, which is £1,999 to start.

Performance

While the cheapest Mac mini remains a great
way to get into the Mac in general and Apple
silicon Macs in particular, the M2 Pro-powered
Mac mini is in another league entirely. With an
M2 Pro at its heart, it can go toe to to with an M2
Pro-powered MacBook Pro which means when
it comes to performance you can expect similar
returns. This is something that's certainly borne
out by our benchmarks with the M2 Pro Mac
mini we had on test matching the MacBook Pro
16-inch (p78) measure for measure across
Geekbench 5, Handbrake, Rise of the Tomb
Raider and DaVinci Resolve.

In Geekbench 5, for example, the M2
Pro-powered Mac mini scored an average of
1,958 points in single-core CPU performance,
just three points short of the MacBook Pro,
while in Handbrake it transcoded a one-hour
4K video in 14 minutes 3 seconds, again an
identical result to Apple’s flagship notebook.

In Rise of the Tomb Raider with the display
resolution set to 1920x1280, graphics set to High
and V-Sync off, the Mac mini hit a consistent final
score of 49fps, with butter-smooth on-screen

action. Even in the newer Shadow of the Tomb
Raider, the Mac mini averaged 96fps - again
mirroring the one on the MacBook Pro.

For our final benchmark we render an effects
laden 2.5-minute video in DaVinci Resolve
and again the results proved astonishingly
consistent, achieving the final result in an
average of 9 mins 19 secs, compared to 9 mins 31
seconds on the similarly specified MacBook Pro.

Whichever benchmarks we threw at it, the
Mac mini delivered each of them without fuss,
remaining relatively cool to the touch with its
built-in fans kicking in (very quietly) on occasion.
Compare that to the heat and roaring fans of
the previous-generation Intel machines and
the Apple silicon advantage remains obvious.

In day-to-day use, the usual Apple silicon
superlatives apply - the Mac mini is quick to boot
and log in to, and apps typically launch in a single
bounce of their icons in the Dock. Everyday tasks
from messaging in Mail to photo-editing in
Photos is quick and easy, with little in the way of
stuttering and slowdowns. Put an Intel Mac and
an Apple silicon Mac side by side and ask us to
choose one for our everyday machine, and the
Apple silicon Mac would win every time, the
M2 Mac mini being just the latest example.

While rumours ahead of the new Mac mini
launch speculated about a possible redesign, the
fact that didn't happen doesn't matter. Instead,
the most important changes are all under the
hood - from faster wireless connectivity to the
huge leap in performance that comes with the
M2 Pro. While the M2 Pro-equipped Mac mini
is hardly cheap, it plugs a gap in Apple's Mac
line-up - if you want more power from a desktop
Mac than an M2 Mac mini or even an M1iMac can
provide, but don't want the expense of a Mac
Studio or Mac Pro, your needs are catered for.
And that is brilliant news. Rob Mead-Green

A fully kitted out Mac mini
with M2 Pro is expensive -
so expensive in fact, it ends
up in Mac Studio territory.

Mac

FORMAT

VERDICT

> The Mac mini is a
great compact desktop
for the rest of us - and
in M2 Pro guise it’s
crazy powerful too.

Fokkkok

& Powerful but compact
& M2 Pro option

& Excellent connectivity
& Great value
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Lenco LBT-18

Jump on the vinyl revival bandwagon
with this Bluetooth turntable

> E£219.99 > FROM lenco.uk » FEATURES Belt-drive turntable, 33
and 45rpm playback speeds, Moving Magnet Coil (MMC) pick-up,
aluminium platter, pre-amplifier, anti-skating weight, manual armlift,
Bluetooth 4.2, 1x RCA (phono) output, 1x USB-B port, 42x36x12.6cm

You'll have real
fun dusting
down your old
vinyl and
giving it a

Spin again

Mac

FORMAT

VERDICT

> A brilliant budget
turntable that exudes
class while breathing
new life into your
old vinyl collection.

ook

© Solid build quality
& Good range of
connectivity options
© Great sound

for the money

@ Set-up is a bit fiddly

84 | MACFORMAT | APRIL 2023

ith vinyl records now
W outselling CDs in the UK, it's no
surprise that turntables are hot

ticket tech items right now - especially
when they're as accomplished as the Lenco
LBT-188. Finished in groovy dark walnut,
it comes with 33 and 45rpm spin speeds,
support for 7,10 and 12in vinyl, and includes its
own phono preamp so you don't have to worry
about either owning a stereo amp with one
built-in, or adding an off-board one separately.
Best of all, it has Bluetooth and a USB-B
port on board - the first makes it easy to
connect to compatible wireless speakers and
headphones; the second means you can hook
it up to your Mac using the USB-B to USB-A
cable supplied (you'll need an adaptor if your
Mac has USB-C). You can then use that USB-B
connection to digitise your vinyl using an app
such as Audacity or Amadeus Pro. Easy. Hi-fi
purists aren't excluded either as the turntable
also includes an RCA (phono) output for
connection to an amplifier.

L S
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_,M;ZM—— -

While you can't use the turntable straight out of the box,
everything works well once you've got it all set up.

Considering the reasonable price, the Lenco LBT-188 boats
a very impressive build quality.

With those bases covered, let’s turn to the
Lenco LBT-188's build quality and ease of use
- and it's mostly a win for this £219.99 deck,
thanks to its high-quality finish, aluminium
platter, dial-shaped metal 33/45rpm and On/
Off switches and its metal tonearm, which
comes complete with an Audio Technica
Magnetic Moving Coil (MMC) cartridge.

Fun and quality
While some turntables - notably the £249.99
Sony PSLX310BT - require zero set-up and can
be used straight out of the box, the Lenco
LBT-188 needs some cosseting. Not only do
you have to adjust the counterweight at the
end of the tonearm, but you also have to add
the anti-skate weight, which dangles from a
separate anti-skate arm and is attached to the
tonearm with a skinny plastic cable that's akin
to a fishing line - and that can be a bit of a faff.
Once that's done though, the LBT-188
works brilliantly. We had no problem pairing
it with either a Bluetooth speaker or a pair of
Bluetooth headphones, or connecting to a Mac
for a marathon vinyl recording session via USB.
Sound quality is excellent for the money
and you'll have real fun dusting down your old
vinyl and giving it a spin again. Plus, the Lenco
LBT-188 has everything needed to enjoy it all,
with cables, a dust cover, platter mat and even
a vinyl cleaning cloth included.
While the Lenco LBT-188 lacks some of
the niceties of some of its rivals, it's a superb
budget deck that gets the basics right - and
for that it has to be applauded.
Rob Mead-Green

>Image credit: Lenco UK
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hy bother looking for
VV another note-taking
app when there's a

perfectly good one built into
macO0S? For the same reason you
might use a different email client
or web browser. While Apple's
Notes has become a very good
note-taking app, it's not perfect.
Take a look at the others here and
you'll see that Bear isn't just
beautiful, but has so many of the
features you'd find in a writing
tool, you can use it as one.
Agenda organises notes by date
and enables you to create and
share projects, while Evernote's
web clipping tool is a class apart
from the one in Notes.

Notability takes a different
approach in that it focuses on
creating notes using multiple
media. Sure, you can type notes,
but you can also record audio and
sync it with your notes, annotate
a PDF and deliver a presentation.

If those features are too much,
and you don't want either Notes'
Quick Note or sharing features,
Simplenote may be just what you
need. If Apple's Notes isn't the one
for you, one of the others on test
here certainly will be.

How we tested

» To test each of the apps here, we
installed them on our Mac, iPhone
and iPad and used them to create
notes from scratch. We tested how
easy it was to grab content from
websites and add them to a note,
or to use the content to create a
new note. Where other features
like audio recording were
available, we tested those too.

We added images, drawings,
annotations and links to apps.
And we examined how easy it
was to organise notes and to
search through them.
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Things to
consider...

Syncing with

other devices
You may want to make sure the
note-taking tool you choose has an

iPhone or iPad version, that it syncs and

whether there is an additional cost.

Web clipper

Grabbing a recipe from a website
is one of our favourite uses of notes
apps and the easier it is to grab, the
better. Some apps here use the Share

menu to do that, others have their
own browser extension.

3 Tagging

Tags are a simple but effective

way to organise notes. Add atag to

anote in an app that supports them,

and you can then filter notes for
a specific project.

Shortcuts

Apple's Shortcuts enable you

to automate all kinds of workflows
and processes for extra efficiency.

Agenda.

roup test

) MacFormat features

7] Mac Security guide
# MacFormat Tutorials
IF1 MacOS Catalina guide
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» Free; Premium £29.99 » FROM agenda.com

] The main difference

between Agenda and
the other note-taking apps
here is that it is ‘date-
focused'. This means that you
can assign dates to notes and
set reminders for them. You
can also import Calendars
and Reminders from the
respective macOS apps. The
Today view shows you all the
notes assigned to today, and
you can mark notes as On the
Agenda - usually those you
need to work on now.

Agenda notes support rich
text formatting, images, links
and tags. You can create
multiple projects and save
notes to them. You can also
save a note as a template and

88 | MACFORMAT | APRIL 2023

use it to create new notes in
future. You can add URLs
from Safari's Share menu,
although only the link is
inserted, not content from
the page.

Agenda is free, with a fee
for additional features such as
collaborating with others and
full-colour notes. Plus, one of
our favourite things about
Agenda is the active online
community, which shares
tips and tricks.

VERDICT

& Rich text & image support
& Templates

& Active community

@ Difficult to add web content
2.8 .0.6.8 4

Home Cooking Termpura Prawn Po’ oy

Tempura Prawn Po’ Boy

2 % 1809 packs of M&S tempura prawns

Ciabatta loaf
Lettuce
2 beef tomatoes

Jar off avatars guindillas

- Motdrhead Road
Crew American Pg|y

Al

Bear

=i By dishes

> Free; Bear Pro £13.99/year > FROM bear.app

2 Bear is by far the
prettiest note-taking

app here. But don't let its
cutesy aesthetic fool you:
this is a powerful note-
taking and writing tool. It
has full support for Markdown
and when you're done writing
a note, you can export it
either as the Markdown
original, rich text, a Word
document, PDF, or HTML.

As well as Markdown, you
can add images, URLs, and
format blocks of text as
code. Support for tagging is
excellent. Tags appear in the
sidebar, and you can group
them, use nested tags, and
add an icon to make a tag
easy to pick out. We like that

you can choose to ignore tags
when you export notes in
other formats.

Bear has its own web
clipper, which means you can
select whether to include
images and URLs when you
add a web page to a note.

Bear Pro syncs via iCloud,
enables you to secure notes
with a password, and gives
you access to lots of themes.
There are also Shortcut
actions for creating notes.

VERDICT

© Markdown support
© Web clipper

© Good export options

@ Free version very limited
Yodkodkok

»Image credits: Momenta BV, Shiny Frog Ltd
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> Free; Personal £68.99/year > FROM evernote.com

If you mainly want to

use a note-taking app
for grabbing and saving
articles or recipes from the
web, then Evernote is the
standout app here. Its web
clipper is second to none, and
enables you to choose each
time you clip whether to save
the full page, an article on the
page or a simplified version.
When you make a choice, you
will see a preview of the clip
before you save it.

Evernote is also the
notebook to choose if you
sometimes need to use non-
Apple platforms, as there are
versions for Android and
Windows, and a web app that

looks like the desktop version.

»Image credits: Evernote Corp, Ginger Labs Inc

Evernote syncs across all
your devices, though the free
version is limited to two. Your
data is stored on its servers,
so there's a limit on how much
you can upload, depending on
your chosen subscription plan.

There's full support for
tagging and creating rich-
text notes, as well as adding
images and links. The search
tool is excellent and the
paid-for version enables
you to create task lists, too.

VERDICT

© Works on any platform
© Excellent web clipper
© Formatting options

@ Expensive

Jodkok

Note-taking apps APPLE CHOICE

Related videos

+ It's great for lectures
+ Or meetings

Notability

> Free; Plus E11.49/year » FROM notability.com

4 Need to take lots of
notes in meetings or
lectures? Notability should be
top of your list. It enables you
to record audio as you make
notes and syncs the audio with
the written note. You can then
click on a word in the note to
hear the audio at that point.

Notability also enables you
to present your notes and view
one note on your screen while
another note is presented. You
can add images and links to
notes, and on the iPad version,
you can hand write or draw
using Apple Pencil.

The free version also
enables you to use templates
from a gallery, import and
annotate PDFs, scan

Notability allows you to record audio and write no

you have to do is click on the text and the audio recorde

documents and sync via
iCloud. Upgrade to Notability
Plus to convert handwritten
notes to text, access additional
templates, and convert
hand-written equations

to high-res images.

When it comes to sharing,
you can export notes as PDFs
and password protect them.
Or, you can share them as
images, notes, or text
documents using Notability's
share sheet.

VERDICT
© Audio and syncing

& Presentation mode
& Templates

@ No web clipper
Yook
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§otes

»Free > FROM apple.com/uk

5 Apple's Notes has

evolved into a very
capable note-taking tool. Of
course, it syncs with iPhone
and iPad, but it also enables
you to share notes with
others and collaborate on
them. An Activity view shows
you the changes others have
made to your notes, and
when you ‘@' someone you're
collaborating with, they'll get
a notification.

Quick Note enables you to
create or add to notes without
launching the app, or leaving
the app you're currently
using; just move the cursor
to the corner of the screen
or use the sharing extensions
in apps that support it.
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2 Search notes

Bl All Notes Te mpus Prawn Pot boy
] Trash 2 1809 packs of M&S tempura

prawns Ciabatta loaf Lettuce 2 baef

TAGS Do more with Motes on Mac,
L Appla Skills 03 Head: How to get tha
RIS mast from Notes Strap: On Mac,
recipe
Tim 7.1.3
COLUSCOUS Standfirst: Keep track of the tme you
spendd working on. projects Kenny
prawns
review BookFusion
£ Standtirst: Read, organize, take notes
MacLife on and share your fav
tutorial
e Harissa lamb & blueberrg
MacFormat Ingredients and directions 200 Grams
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How long does it take._..

..o Bync notes like *this™* https:l
wrrw.pixgimator.comitutorialsia-auick

When you grab a web
page from Safari, Notes
shows you a thumbnail
preview of the content as
well as embedding a URL.

Notes enables you to
organise notes folders, and
create Smart Folders to sort
based on criteria you specify.
And tags mean you can
search for and filter notes
easily. If you create notes that
you need to keep private,
secure them with a password.

VERDICT

& Quick Note

& Collaboration features
& Smart Folders

@ Limited to Apple devices
2.0 0.6 1
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zitle gem lettuces, finely shredded

2 beefl tomatoes, sliced

**FOR THE SAUCE**

11 garlic clove, crushed ar grated

O 1tbsp lemon juice

O &lbsp mayonnaise

O 1itsp hot sauce, plus extra to serve
O (optional)

O 1tsp smoked paprika

O 1tsp dijen mustard

O sp warcestershire sauce

LI 2thep finaly chopped pickles {we used
O Vadasz Fresh Pickles), plus extra

O slices to sarve

1. Preheat the even b 200°CHB0°C fan/
oas 6. Place the prawns on a baking tray

and sprinkle over the cajun seasoning
Rala far 16 mine Hil raalad thronh Raba

§implenote

> Free > FROM simplenote.com

If you want a

Markdown-friendly
app that dispenses with
fancy features in favour of
speed in jotting down and
retrieving notes, this is the
tool for you.

Simplenote is purely
about creating and storing
text notes. There are no
templates or audio recording
features. And the only way to
clip web pages is to manually
paste a URL, which remains
a URL, rather than a page
preview. However, it's easy to
use and you can preview the
Markdown output at the click
of a button. You can also
quickly see how many words
or characters are in a note.

You can publish notes to
Simplenote’s web platform,
as well as share them as text
in an email, message or to
another app. You can even
collaborate by adding an
email to the tags box. You
can filter notes by clicking
on a tag in the sidebar.
Notes are synced via
Simplenote’s own server,
meaning you can also sign in
to your account and access
your notes in a web browser.

VERDICT

& Fast search

& Good Markdown support
© Completely free

@ No web clipper
2.2 8.8 1

>Image credits: Apple Inc, Automattic
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A note-taking app that will keep you focused and help with managing your day

e could make a
case for at least

four of the apps
featured here to be the
winner of our group test.
Bear is not just visually
beautiful, but has a powerful
set of features that make it
both simple and very capable.

Notability is unique in
allowing you to record audio
and sync it with typed or
handwritten notes, and
then deliver them as a
presentation. And Simplenote
provides everything you
need in a basic, easy-to-use
note-taking app at no cost.

However, there can be
only one winner and, in this
case, that's Agenda. The date-
based approach and On the
Agenda view are a powerful
way to keep you focused
on what needs to be done,
and the integration with
Reminders and Calendar

are excellent. Add to that the
formatting options, image
support and collaboration
features, and Agenda is
hugely powerful. Plus, it

has excellent support for
Shortcuts, with several
actions ready to be included

in your workflows.

A
>How s
do they
compare?
Specs Agenda. Bear Evernote Notability Notes Simplenote
Base price Free Free Free Free Free Free
Full price £26.99/year £13.99/year £68.99/year £11.49/year Free Free
Website agenda.com bear.app evernote.com notability.com apple.com/uk simplenote.com
Syncs withother | i0S, iPad0S i0S, iPad0S i0S, iPad0S, Windows, | i0S, iPad0S i0S, iPad0S i0S, iPad0S, web
platforms Android, web
Web clipper? No (can use Safari Yes Yes No No (can use Safari No
share sheet, though) share sheet, though)
Collaboration Yes No No Yes No
features?
Password No Yes Yes* Yes Yes Yes
protection
Shortcuts actions | Yes Yes Yes No Yes Yes
Overall ** * * *

Note: The final verdict scores reflect the overall opinion of a product and are not necessarily an average of the criteria listed in the table.
*Can encrypt text within a note but not a whole note

»Image credit: Momenta BV, Shiny Frog Ltd, Evernote Corp, Ginger Labs Inc, Apple Inc, Automattic

APRIL 2023 | MACFORMAT | 91


https://agenda.com/
https://bear.app/
https://evernote.com/
https://notability.com/
https://www.apple.com/uk/
https://simplenote.com/

APPLE CHOICE iPadOS

Affinity Photo 2

Serif’s powerful editing app gets a serious update

» £17.99 (for iPad; universal licence £144.99) » FROM affinity.serif.com » NEEDS iPadOS 15 or later

You get a layer-
based image
editor that’s
split into
‘personas’

erif's Affinity suite rivals Adobe in
bringing pro-grade image editing

without a subscription to Macs and
iPads. The latest releases of the three Affinity
apps, released as version 2 rather than a free
update, may mean you have to pay once more,
but a universal licence - which gets you all apps
on all platforms with no extra costs - is about
the same as one year of equivalent Adobe
apps. There's a 30-day free trial too.

The iPad version of Affinity Photo 2 is
probably the most interesting of the updates,
as it has the broadest appeal and is cheaper
than the Mac app (which costs £69.99 if you
buy it separately). And while the both Mac and
iPad versions takes on Adobe Photoshop, the
Mac version lacks the organisational tools of
Adobe Lightroom or the browsing capabilities
of Adobe Bridge, and there is no equivalent on
iPad either, which is a shame.

With Affinity Photo 2, you get a layer-based
image editor that's split into ‘personas’. The
Photo persona is a straightforward image-
editing app, though a powerful and complex
one that will require time spent in the online
manual and tutorials to master. The Develop
persona is for processing your Raw files.
Liquify is for heavy retouching that's more like

Panoramas can be automatically stitched together from
a series of multiple images.

sculpture in the way it moves pixels about, and
Tone Mapping is for HDR. Finally, Export is for
creating the perfect output file for your needs.
Personas take over the interface of the app,
changing the available tools and options,
rather than appearing in a floating window.
Users of the first version of Affinity Photo
on Mac will find a great deal of refinement but
little that's actually new, though the iPad
version now features quick menus and a
command controller to speed up workflows, a
compact mode to make the best use of limited

APP TIPS

Hold the ‘?" button in the bottom right
of the iPad interface, and you'll get a
helpful overlay that makes up for the
lack of tooltips.
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Getting started with Affinity Photo 2: handy hints

The panels usually close automatically
when you tap on your image, but you
can keep one open with the pin icon
at the top right.

Swipe down with three fingers on your
document and a customisable quick
menu will open, with shortcuts for
common tasks.


https://affinity.serif.com/

screen size, and a resource manager for linked
content. The Layers palette has had an
overhaul, making masking, clipping and
reordering clearer; plus, there are a great
many more non-destructive options when
masking (the entire Develop persona is
non-destructive too, appearing as a layer with
adjustable settings). Additionally, you have the

There's a healing brush for skin retouching, and operations
such as frequency separation are easily accomplished.

»Image credit: Serif Ltd

Affinity Photo 2 APPLE CHOICE

option to export straight to the WebP format
or open the HIF files from Canon cameras.

Not about the smarts

While Adobe is pushing Photoshop in an
interesting direction with its neural filters and
Sensei-powered smarts, you won't find any of
that in Affinity Photo 2. The most automatic
thing is the selection of a correction profile
for your Raw files. Otherwise, you're doing
everything by hand, with Apple Pencil on iPad,
and Force Touch and Touch Bar on Mac to
assist. It's not just an image editor though, as
natural media brushes, vector illustration, and
type handling all come under its purview.

As part of the Affinity suite that centres on
Publisher - which is now available on iPad for
the first time - Affinity Photo 2 fits in nicely,
but works well as a standalone app too. While
not an app for absolute beginners, the ability
to dip in and learn without an ongoing
subscription is hugely valuable. lan Evenden

Linear Burn

Affinity Photo 2 for iPad has
the blend modes you'd expect
from the desktop version.

Mac

FORMAT

VERDICT

» Serif’s pro-grade
image-editing app is
now even more essential.

Fokokk

& A very capable app
gets even better

& Pay once, no
subscription

@ Steep learning

curve for newbies

@ No asset management
component
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CrossOver 22

Run (some) PC apps on your Mac without Windows

» £60 (12 months' support), £414 (lifetime support) » FROM codeweavers.com » NEEDS macOS 10.13 (Apple
silicon M1 or better requires macOS 11.1 or later), 1GB of free disk space plus more for installed Windows apps

The latest
improvements
make it a lot
easier for
everyday users
to successfully
run CrossOver

-

here will always be apps, mostly
games, whose publishers won't
port them to the Mac for financial

or contractual reasons. CodeWeavers'
CrossOver offers a simple, convenient way
to run many of those apps. The result isn't as
reliable or universal as other solutions, but it's
a lot cheaper and easier, and with CrossOver's
helpful database of app functionality and
generous try-before-you-buy period, you can
see whether it'll run the apps you want to use
before you commit your hard-earned cash.

CrossOver translates Windows commands
into Mac ones on the fly. It's based on
the open-source WINE project, but its
improvements to standard WINE make
it a lot easier for everyday users to
successfully run. CrossOver 22 is only
available from CodeWeavers' website.

After installation, CrossOver does most
of the hard work. It sets up a ‘bottle’ - a
contained virtual environment - in which
you can install basic Windows or Linux
underpinnings, plus any apps you'd care to
run. CrossOver builds in shortcuts to install
popular apps like Steam, and it can seamlessly
install apps from the web, from downloaded
ISO files, or from a physical disc, should you
have an external drive.

If you're into gaming, we'd recommend more than 8GB of memory, or a more powerful chip than an M1.
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If you need every Windows app you run to work well,
if not perfectly, on a Mac, CrossOver isn't for you.

You can have multiple separate bottles for
different apps, or put all the apps you use in a
single vessel. As with containerised software
set-ups like Docker, this makes CrossOver
easier and less stressful to use. In the event
that something goes wrong inside a bottle,
it won't affect your larger system. Just
delete the bottle and start fresh.

Fresh interface

Each new version of CrossOver offers
performance improvements, but CrossOver
22's biggest leap forward lies in its overhauled
interface. Previous versions hid important
toggles and features behind poorly designed
contextual menus. CrossOver 22 takes design
cues from the Mac App Store, with more crucial
options in full view. And it's now easier than
ever to run apps you've already got installed,
or add new ones.

CodeWeavers' database of popular
apps and their compatibility, maintained
by volunteer testers, is now more directly
integrated into the app itself, rather than
requiring a separate visit to CodeWeavers'
website. That database isn't particularly
comprehensive but it's a good place to
start when you're curious.

More processing power equals better
performance. Even though it's an Intel native
app, it runs best on Apple silicon under Rosetta
2 emulation, thanks to the sheer horsepower
of the M1 and higher. (CrossOver plans to
eventually support Apple silicon.) Popular
launcher apps like Steam, and simple 2D games
like Guacamelee! ran without a hitch in tests,

»Image credit: CodeWeavers, Electronic Arts Inc
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CrossOver 22 APPLE CHOICE

[# Run Cammand

ROTTLE ACTIONS

Uninstall Origin

Install

A14-day trial allows you to test
apps you want to run before
committing to a purchase.

but more sophisticated titles had various
degrees of trade-offs. On a stock M1 Mac mini,
2017's Star Wars: Battlefront Il looked great.
But depending on the game mode and the size
and type of the environments, performance
ranged from fast and fluid to an unplayable
crawl. If you want to game with CrossOver,

Alternatively, when it comes to gaming, you'll find sticking
to simple 2D games provides more dependable results.

»Image credit: Apple Inc, CodeWeavers, Drinkbox Studios

more than 8GB of memory or a more powerful
chip than a basic M1 will serve you well.

Furthermore, Metal has different aims and
priorities than DirectX, trading some measure
of tech sophistication for the ability to run
across macOs, i0S, and tvOS. Even under
Apple's new Metal 3, there are just some
things DirectX does for which Metal lacks
an easily translated equivalent. And even if
everything else goes swimmingly, there are
facets of Windows software that just won't
work outside that platform.

CrossOver 22 is impressive in its simplicity,
at least in terms of how easy it is to get select
Windows applications up and running on
macOS. It's by no means perfect, and your
mileage will vary dramatically depending
on the complexity of the apps you're looking
to run, not to mention the power of your
Mac itself. Nathan Alderman

Mac

FORMAT

VERDICT

» CrossOver is

an easy way to
experiment with
Windows’ games and
apps on your Mac.

Fokok

& A lightweight

solution to running

PC apps on Mac

© Easy to install and use
& No need to

buy Windows

@ Requires a fast
processor and lots

of memory
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6 apps to help with your

spring cleaning

Clear out the clutter and keep your home organised

Main

Bathroom bedinonm

Living
room

Kitchen

Kids'
bedroom

Office

Spotless

»Free (IAPs) » FROM rhpi.com.au
»NEEDS iOS 13 or later

The first step towards a
';%‘%}? cleaner home is making a plan
- of action. Once you've worked

out what needs to be done and when, you
will be more equipped to tackle your
tasks head-on. Spotless is the perfect
way to do that, as it lets you divide up
your home into rooms, set jobs for each
area, then track your progress and get
reminders when it's time for a little elbow
grease. With it by your side, you'll never
forget a cleaning chore again, helping
your home stay spotless for longer.
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Tody

»£5.99 > FROM todyapp.com
»NEEDS iOS 15 or later

Sometimes, it can feel as
though your cleaning routine is
in control of you, rather than
the other way around. Fortunately, you
can take back control with Tody. This
handy little app helps you keep on top
of every room in the house, but instead
of nagging you to clean up, it lets you
decide when to get started. Each task has
a dirt meter to help motivate you without
flooding your device with reminders and
notifications. And you can assign tasks to
other family members to share the load.

12:43 all = .

Dashboard Allfolders ¢f4

Digital camera
GX 800 AT

Digital camera
DSX 2000

Sortly

» Free (IAPs) > FROM sortly.com
» NEEDS iOS 14 or later

You can't clean out your house
. if you don't know what you've

got in the first place - and
that's where Sortly comes in. With this
app in your arsenal, you can catalogue
your items and quickly create an
inventory. Just snap a photo or scan
the barcode and add it to the app to get
started. You can then add tags, notes,
prices and more, giving you a complete
picture of your contents. And once you
know that, you can easily see what you
should keep and what you can get rid of.

»Image credits: Reach Health Promotion Innovations Pty Ltd, Peter Askjeer Drejer, Sortly Inc
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othing else helps to banish
N the winter blues quite like a
good clear-out and declutter.

But, even with the best intentions, taking
stock of what you've got and making
decisions over what you really need can
be daunting. And that's before you factor

How can we help you?

Qs

& O T

Hama Cleaning Handyman Hama

Reradaling

Interior Paint|

Most Popular Services

Bathroom Remodeling
Fence Installation
Exterior Painting
Furniture Assembly

—1 Kitchen Remodel

] Hanging ltems

Home Cleaning
Home Renovation

Install Wood Flooring

Handy.com

> Free > FROM handy.com
»NEEDS iOS 11 or later

Feel like there's more on your

plate than you can handle?

Sometimes it's best to get the
professionals in. Whether you need some
help with cleaning or want a plumber to
fix your pipes, Handy can put you in
touch with the best person. Just tell the
app what you need and when you need
it and you'll be connected with a host
of excellent options. When you're ready,
just pay in the app and you'll be on your
way. That's great for when you need an
extra helping hand around the house.

in actually, gulp, getting rid of stuff. As
always, it's reassuring to know there's an
app (several in fact) for that! From a spot
of cleaning and tidying, to finally getting
round to all those odd jobs and actually
offloading unloved items, you'll find help
is just a touchscreen away. Alex Blake

New updates since your last visit @

Kitchen Laundry Mechanical

() o |=
‘H/ QD )

ajor

Caonsumahles 5 -
ppliznce

Electrani
ectronics &
——

Centriq

» Free > FROM mycentrig.com
»NEEDS iOS 12 or later

As you accumulate devices

in your home over time, you
might find yourself throwing
out the manuals to save space. But
what if one day you need them? No need
to worry, as Centriq is a clever solution
to this problem. Simply scan a device's
product label and the app will chase
down manuals, guides, parts info, helpful
videos, and more. If you've ever found
yourself at a loss for how to fix a
product, Centrig can find the answers
for you - no online searching necessary.

»Image credit: Handy Technologies Inc, Centrig Technology Inc, Uppernauts

APPLE CHOICE

‘ou've gatten rid of

10 items!

0 Challergs Progiess

Get rid of it

> Free » FROM getridofit.uppernauts.com
> NEEDS iOS 9 or later

Inspired by podcasters The
0 Minimalists and their 30-Day

Minimalism Game, the idea
behind this app is simple. On day one,
you find one thing to get rid of. On day
two, you increase it to two things. And so
on, until the end of the month. You can
sell, bin, or give away your excess, and
when you're done, you'll be amazed at
how much stuff you didn't need - and
how much better you feel without it.
Instead of being overrun with needless
possessions, your home feels lighter.
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STORE GUIDE

Your guide to the best Apple hardware and third-party accessories
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debuted in 1998, Apple’s all-in-one
desktop computer has been setting
standards for design and performance.
The current 24in model is certainly
Apple's finest yet - thanks to its 4.5K
(4480x2520) Retina display and the
Apple-designed M1 chip, which is available
with either an 8-core CPU/7-core GPU at
the entry-level, or an 8-core CPU/8-core

iMac 24inch £1,249

(Entry level)

Display: 23.5in 4.5K Retina (4480x2520) with True Tone
Chip: Apple M1 with 8-core CPU (4 performance cores,
4 efficiency cores), 7-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 16GB)

Storage: 25668 (upgradeable to 512GB or 1TB)

Ports: 2x Thunderbolt/USB 4, 1x Gb Ethernet (option)

°
IMac 7
£1,249
> Ever since the Bondi Blue iMac

Apple Magic Keyboard with

Touch ID and Numeric Keypad

» From £179

» This extended keyboard is a great upgrade
option for any Mac and comes with Touch ID for
faster Mac logins. The black version costs £199.
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— Mid-range and top-tier iMacs

comes with a Magic Keyboard
with Touch ID. The entry-level
has a standard Magic Keyboard.

HEERHHEREEHE
kb s b i o S

DaobonGoE |
IS I I

GPU on the mid-range and top-tier
versions. All models come with 8GB of
memory as standard (upgradeable to
16GB), with solid-state drive (SSD) storage
ranging from 256GB on the entry-level
and mid-range versions to 512GB on the
top tier, although you can add more - up
to 1TB on the entry-level and up to 2TB on
the mid-range and top-tier models if you
wish via Apple’s build-to-order options.

iMac 24inch £1,449
(Mid-range)

Display: 23.5in 4.5K Retina (4480x2520) with True Tone
Chip: Apple M1 with 8-core CPU (4 performance cores,
4 efficiency cores), 7-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 16GB)

Storage: 25668 (upgradeable to 512GB, 1TB or 2TB)
Ports: 2x Thunderbolt/USB 4, 2x USB 3, 1x Gb Ethernet

Apple Magic
Mouse

» From £79

» Design quirks aside,
(we're looking at you,
Lightning Port) the Magic
Mouse is a great pointing
device, thanks to its Multi
Touch support. The black
version costs £99.

Available in a choice of seven
gorgeous colours (Green, Yellow, Orange,
Pink, Purple, Blue and Silver), each M1
iMac also comes with a 1080p FaceTime
camera, a six-speaker sound system and
support for Spatial Audio. You'll also find
two Thunderbolt/USB 4 ports on each
model, with mid-range and top-tier
options gaining two additional USB 3
(USB-C) ports. Prices start at £1,249.

iMac 24inch £1,649

(Ultimate)

Display: 23.5in 4.5K Retina (4480x2520) with True Tone
Chip: Apple M1 with 8-core CPU (4 performance cores,
4 efficiency cores), 8-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 16GB)

Storage: 5126B (upgradeable to 1TB or 2TB)

Ports: 2x Thunderbolt/USB 4, 2x USB 3, 1x Gb Ethernet

Apple Magic
Trackpad

> From £129

» This Multi Touch glass
trackpad is a thing of
beauty, giving you lots
of control over mac0S
and it's rechargeable
too. The black version
costs £149.

»Image credit: Apple Inc



EXPECTED
JUNE 2023

MacBook Air

> Updated in June 2022, Apple's
thinnest, lightest laptop now comes
with Apple's new M2 chip. The M2
features a next-gen 8-core CPU (offering
18% more CPU performance), along with
Apple's next-generation GPU, which now
has up to 10 cores (providing a 35%
boost in GPU performance), and up to
50% more memory bandwidth. The
base model comes with 8GB of memory
as standard but this is configurable to

16 or 24GB.

The redesigned Air is now thinner at
11.3mm and weighs just 1.24kg. Apple has
also managed to reduce overall volume
by 20%. Despite its slimline profile,
it now also comes with a 13.6in Liquid
Retina display. Boasting a resolution of
2560x1664, the display is bigger and

MacBook Air £999
(Entry level)

Display: 13.3in Retina with True Tone

Chip: Apple M1 with 8-core CPU (4 performance cores,
4 efficiency cores), 7-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 16GB)

Storage: 2566B (upgradeable to 512GB, 1TB or 2TB)
Ports: 2x Thunderbolt/USB 4, 3.5mm headphone jack

&1V 4K

> From £149

> Apple's third-gen little
black box with Al5 Bionic
chip now adds HDR10+ to
the mix. Prices now start at
just £149 (Wi-Fi only); the standard
version now comes with 64GB of
storage, while paying £20 extra gets
you 128GB and Ethernet support.

> From
£999

25% brighter than before and supports
up to one billion colours.

The M2-equipped MacBook Air gets
a1080p FaceTime HD camera, and the
laptop also features a four-speaker
sound system which supports Apple’s
immersive Spatial Audio technology.

As before, you get two Thunderbolt/
USB 4 ports and a headphone jack as
well as 802.11ax Wi-Fi (aka Wi-Fi 6) and
Bluetooth 5.0, and there's the welcome
return of MagSafe. You also still get great
battery life, with up to 18 hours of video
playback or 15 hours of web surfing.

The Air is available in Space Grey and
Silver but now also comes in Midnight
and Starlight finishes. Prices for the M2
version start at £1,249. The M1 model is
still available from £999.

MacBook Air £1,249
(Mid-range)

Display: 13.6in Liquid Retina with True Tone

Chip: Apple M2 with 8-core CPU (4 performance cores,
4 efficiency cores), 8-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 24GB)

Storage: 2566B (upgradeable to 1TB or 2TB)

Ports: 2x Thunderbolt/USB 4, 3.5mm headphone jack

Apple HomePod/
HomePod mini
>£99/£299

> Apple's Siri-powered
speakers sound great,
you can link two for
stereo sound, and use them .

as smart home hubs. The mini comes in five
colours, while the new Midnight/White HomePod
(£299), offers higher spec and spatial audio.

EXPECTED
JAN 2024

®&Watch |-
Series SE,\—
8 and Ultra

» From £259

> The 8 and SE are water resistant to 50m, but the
new titanium Ultra is water resistant to 100m. The
8 and the Ultra boast an always-on display, and all
three offer Emergency SOS and Crash Detection.

> From
£649

Mac mini
> Apple's most affordable desktop
may not come with a mouse, a
trackpad or keyboard, but it's also
great value starting at even less
than the last model at £649.

Despite the reduction in price, the
Mac mini now boasts Apple’'s M2 chip,
boasting an 8-core CPU, 10-core GPU
and 16-core Neural Engine. The 8GB of
memory can now be boosted up to
24GB, while SSD storage options
range from 256GB all the way up to
2TB. There is now also an M2 Pro
version with a 10-core CPU/16-core
GPU (configurable to 12-core CPU/19-
core GPU), with 16 to 32GB memory
and 512GB to 8TB SSD storage.

Entry-level and mid-range M2 Mac
mini models continue to come with
two Thunderbolt/USB 4 ports, but the
M2 Pro model has now has four.

Mac mini £649
(Entry level)

Chip: Apple M2, 8-core CPU (4 performance cores, 4
efficiency cores), 10-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 24GB)

Storage: 256GB (upgradeable to 512GB, 1TB or 2TB)

Ports: 2x Thunderbolt/USB 4, 2x USB-A, x HDMI 2.0,

3.5mm headphone jack, Gb Ethernet (10Gb Ethernet option)

Mac mini £1,399
(Ultimate)

Chip: Apple M2 Pro with 10-core CPU (4 performance cores,
4 efficiency cores), 16-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 16GB)

Storage: 512GB (upgradeable to 1TB or 2TB)

Ports: 4x Thunderbolt/USB 4, 2x USB-A, 1x HDMI 2.0,

3.5mm headphone jack, Gb Ethernet (10Gb Ethernet option)
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MacBook Pro

» From £1,349

> While the MacBook Pro 13-inch got
the M2 treatment back in June 2022,
January 2023 sees the introduction
of the M2 Max or M2 Pro in the 14in
and 16in models. The new 14-inch M2
Pro model is available in a variety of CPU/
GPU flavours - 10-core CPU/16-core GPU,
12-core CPU/19-core GPU, with 16 or 32GB
memory options. Alternatively, if you step
up to the M2 Max option, you can go for a
12-core CPU/30-core GPU or 12-core
CPU/38-core GPU, with 32 or 64GB
unified memory. All range from 512GB

MacBook Pro 13in £1,349
(Entry level)

Display: 13.3in Retina (2560x1600) with True Tone
Chip: Apple M2 with 8-core CPU (4 performance cores,
4 efficiency cores), 10-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 24GB)

Storage: 25668 (upgradeable to 512GB, 1TB or 2TB)
Ports: 2x Thunderbolt/USB 4, 3.5mm headphone jack

>Launched in March 2022, the Mac
Studio is the best expression of
Apple's silicon's superpowers yet.

Looking like an oversized Mac mini,
its capacious aluminium body is still
remarkably compact for a desktop Mac,
measuring 197x197x95mm, but it's
what's inside that really counts.

The £1999 entry-level model packs
the same M1 Max chip as the MacBook
Pro, with a 10-core CPU, 24-core GPU
and 32GB of memory, but it's the step-up
models that are the most interesting.

That's because you can also buy a
Mac Studio with M1 Ultra - a powerhouse
piece of Apple silicon with a 20-core CPU,
and up to 64 graphics cores, as well as

Mac Studio £1,999
(Entry level)

Chip: Apple M1 Max with 10-core CPU (8 performance cores,
2 efficiency cores), 24-core GPU, 16-core Neural Engine
Memory: 32GB (upgradeable to 64GB)

Storage: 512GB (upgradeable to 1TB, 2TB, 4TB, 8TB)

Ports: 4x Thunderbolt 4, 2x USB-C, 2x USB-A, 1x HDMI 2.0,
1x 3.5mm headphone jack, 1x 10Gb Ethernet, SDXC card slot
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‘ Mac Studio s

EXPECTED
JAN 2024

SSD storage to 8TB SSD storage. The
16in offers an M2 Pro 12-core CPU/19-
core GPU, with 16 or 32GB memory. The

MacBook Pro 14in £2,149
(Mid-range)

Display: 14.2in Liquid Retina (3024x1964) with True Tone
Chip: Apple M2 Pro with 10-core CPU (6 performance cores,
4 efficiency cores), 16-core GPU, 16-core Neural Engine
Memory:16GB (upgradeable to 32GB)

Storage: 5126B (upgradeable to 1TB, 2TB, 4TB or 8TB)
Ports: 3x Thunderbolt/USB 4, HDMI port, SDXC card slot

EXPECTED
OCT 2023

The Mac Studio is Apple’s most powerful

desktop Mac to date - it's pricy though.

up to 128GB of unified memory. Storage
options also scale up to 8TB.

With Mac Studio M1 Ultra prices
starting at £3,999, it's not for everyone -
especially as you'll need to add a display,
a keyboard and a mouse or trackpad too.
But even the base model gets a decent
array of connectivity options.

Mac Studio £3,999
(Ultimate)

Chip: Apple M1 Ultra with 20-core CPU (16 performance cores,
4 efficiency cores), 48-core GPU, 32-core Neural Engine
Memory: 64GB (upgradeable to 128GB)

Storage: 1TB (upgradeable to 2TB, 4TB, 8TB)

Ports: 4x Thunderbolt 4, 2x USB-C, 2x USB-A, 1x HDMI 2.0, 1x
3.5mm headphone jack, 1x 10Gb Ethernet, SDXC card slot

M2 Max comes in either 12-core CPU/30-

core GPU, with 32 or 64GB memory

flavour or 12-core/28-core GPU, with
32 to 96GB memory. Again, all range
from 512GB to 8TB SSD storage.

MacBook Pro 16in £3,749
(Ultimate)

Display: 16.2in Liquid Retina (3456x2234) with True Tone
Chip: Apple M2 Max with 12-core CPU (8 performance cores,
4 efficiency cores), 38-core GPU, 16-core Neural Engine
Memory: 32GB (upgradeable to 96GB)

Storage: 1TB (upgradeable to 2TB, 4TB or 8TB)

Ports: 3x Thunderbolt/USB 4, HDMI port, SDXC card slot

Studio Display

»From £1,499

» Launched alongside the Mac
Studio in March 2022, the Studio
Display is a great addition to any
Mac setup.

Powered by Apple's A13 Bionic
and running iOS, it features a
27-inch Retina display with 5K
resolution (5120x2880 pixels)
and True Tone, a 12MP Ultra Wide
camera with Centre Stage, and
a six-speaker sound system with
support for Spatial Audio. A range
of stand options are available, and
you can choose nano-texture glass
for £250 more.

»Image credit: Apple Inc



EXPECTED
NOV 2023

iPad/mini

»iPad (10th gen) From £499
»iPad mini From £569

> Apple celebrates the iPad's 10th
incarnation by increasing the
display to 10.9in and boosting its
internals to an A14 Bionic chip. You
now get an Ultra Wide 12MP front and
updated 12MP back camera. The iPad
now also finally adopts the USB-C
port, and comes in Blue, Pink, Yellow
and Silver. Prices start at £499.

The iPad mini is like a shrunk
down iPad Air, with an all-screen
design centred around its 8.3in Liquid
Retina display. The £569 version
comes with 64GB of storage (but can
be upgraded to 256GB), comes with a
12MP Wide camera, second-gen Apple
Pencil support and USB-C charging.

iPad iPad mini
Display: 10.9in Display: 8.3in

Chip: A14 Bionic Chip: A15 Bionic
Storage: 64GB, 256GB Storage: 64GB, 256GB
Ports: USB-C Ports: USB-C

Unlocking: Touch ID Unlocking: Touch ID

Apple Smart Folio

» From £69

> Available in a range of stylish colours, these
wrap-around magnetic cases will keep your iPad
mini, iPad Air and iPad Pro looking good for
years, and they double as handy stands.

—- . e

EXPECTED

MAR 2023

iPad Air .7

> Like the iPad, iPad mini and iPad
Pro, the iPad Air has an all-screen
design that makes the most of its
10.9in Liquid Retina display. Inside its
super-slim chassis, you'll find the same
Apple silicon M1 chip as the entry-level
MacBook Air and Mac mini. Plus it's
available in a choice of storage options
(64GB or 256GB), has 802.11ax Wi-Fi
(@ka Wi-Fi 6) and Bluetooth 5.0
onboard, and there are Wi-Fi+Cellular
variants with 5G starting at £719.

The iPad Air also supports Apple’s
second-gen Apple Pencil and can be
teamed with Apple's Magic Keyboard
for powerhouse productivity on the go.
Augmented reality fans will love its
LiDAR-equipped 12MP Wide camera,
plus it also has Centre Stage.

iPad Air

Display:10.9in

Chip: Apple M1
Storage: 64GB, 25668
Ports: USB-C
Unlocking: Touch ID

Apple Pencil

» From £89

> Available in first-gen and
second-gen variants, the
Pencil brings pinpoint
accuracy to your iPad
interactions, making it great
for sketching, painting and
creating handwritten notes.
And lots more besides.

Apple kit STORE GUIDE

—— EXPECTED
NOV 2023

iPad Pro &30

> Apple’'s priciest iPad is also its
most fully featured. Available in 11in
and 12.9in sizes, the iPad Pro models
now boast M2 Apple silicon, which
turbocharges the performance, and
iPadOS 16 enables the new Apple
Pencil 'hover experience'.

The 12.9in model's Liguid
Retina XDR display boasts miniLED
backlighting, but even the 11in model
gets 120Hz ProMotion refresh rates,
plus a Thunderbolt/USB 4 port for
charging and connection to a wide
range of external devices. And both
support the second-gen Apple Pencil,
Magic Keyboard, and Centre Stage.
The 12.9in now makes an even
greater MacBook replacement.

iPad Pro

Display: 1in or 12.9in
Chip: Apple M2
Storage: 128GB-2TB
Ports: Thunderbolt 4
Unlocking: Face ID

Apple Magic
Keyboard/Folio
> From £279

> The Magic Keyboard
(for iPad Air/iPad Pro),
comes with backlit
keys and easy-to-use
trackpad. There's now
also a Magic Keyboard
Folio for iPads.
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EXPECTED

SEPT 2023

iPhone SE

»From £449

> Apple's most affordable iPhone

is now even better value, thanks
to a March 2022 update that saw
it receive the same A15 Bionic chip
as the rest of the iPhone line-up
and gain 5G to boot. Old-school
design aside, the iPhone SE has most
of the things people love about
iPhone, from iOS's phenomenal ease
of use to a 12MP Wide main camera
with 4K recording - perfect for
shooting photos and videos.

Battery life is decent too with the
iPhone SE lasting for up to 15 hours
between recharges (with Qi wireless
charging onboard too). The main
thing the iPhone SE misses out on
is Face ID unlocking, making do with
Touch ID on the Home button instead.

iPhone SE

Display: 4.7in

Chip: A15 Bionic
Storage: 646B-256GB
Connectivity: 56, Wi-Fi
Unlocking: Touch ID

Apple AirTag

>£35

> Ideal for keeping track
of keys, bags and other
easily mislaid items,
AirTag hooks into Apple's
Find My network, with
precision finding on the
iPhone 11 or later, thanks
to their built-in U1 chip.
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EXPECTED
SEPT 2023

iPhone 14/
Plus

»iPhone 14 From £849
»iPhone 14 Plus From £949

> The iPhone 14 retains the 6.1in
screen of the 13, although the mini
has been discontinued, and there's
a 14 Plus with a 6.7in screen.

The two handsets retain the A15
Bionic chip, and the Main, Ultra Wide
TrueDepth cameras are still 12MP but
the phones now boast a Photonic
Engine for better low-light images.

The iPhone 14 lasts up to 20 hours
for video playback; the Plus up to
26 hours. All four handsets feature
Emergency SOS and Crash Detection -
Apple's latest ways of establishing an
accident and contacting the
emergency services.

iPhone 14 iPhone 14 Plus
Display: 6.1in Display: 6.7in
Chip: A15 Bionic Chip: A15 Bionic

Storage: 1286B-512GB
Connectivity: 56, Wi-Fi
Unlocking: Face ID

Storage: 1286B-512GB
Connectivity: 56, Wi-Fi
Unlocking: Face ID

Apple

AirPods/ S ’
AirPods =

Pro 2

> From £189

> Third-gen

AirPods and

second-gen AirPods Pro boast Spatial Audio
with dynamic head tracking. The Pro also
support ANC and Adaptive Transparency.

EXPECTED
SEPT 2023

"""i_Phone 14
Pro/Pro Max

>iPhone 14 Pro From £1,099
»iPhone 14 Pro Max From £1,199

> The iPhone 14 Pro and Pro Max
come with the Dynamic Island,
an interactive area around the new
TrueDepth camera, that integrates
alerts, activities, and notifications.
The Pro 14 and Pro Max are
powered by a new A16 Bionic chip,
and despite now offering an always-
on display, the 14 Pro can last up to
23 hours for video playback, while
the 14 Pro Max can keep going for
up to 29 hours. Photography gets
an upgrade too, as a new quad-pixel
sensor on the Main camera provides
48MP quality at 12MP optimisation.

iPhone 14 Pro iPhone 14 Pro Max
Display: 6.lin Display: 6.7in
Chip: A16 Bionic Chip: A16 Bionic

Storage: 128GB-1TB
Connectivity: 56, Wi-Fi
Unlocking: Face ID

Storage: 128GB-1TB
Connectivity: 56, Wi-Fi
Unlocking: Face ID

Apple AirPods
Max

»£549

> These premium
headphones arent for  *
everyone - especially at §
that eye-watering price
tag. They are supremely
comfortable and great-
sounding though.

»Image credit: Apple Inc



BEST BUYS...

Third-party kit STORE GUIDE

»NOISE-CANCELLING HEADPHONES

Sony WH-1000XM5
£349 sony.com

> They're a bit pricey but
these are the best noise-
cancelling cans you can
buy. The app is great too.
Jokkkk MF382

>OURTOP3
USB-C MONITORS

BenQ EW3280U
>£539>MF364
>beng.eu/en-uk

HPE27d G4
@ >£478.80 > MF364
>hp.com
&! Lenovo Q2710
—

>£299.99> MF364
>lenovo.com

BEST BUYS... Third-party Mac a

> WIRELESS KEYBOARD

Mophie 3-in-1
ravel Lharger
£134.95 zagg.com
» A three-device charger -
equipped with MagSafe
- in a neat design.
* ¥k xk MF387

»OURTOP3
PORTABLE PRINTERS

Epson Workforce WF-110W
H >£199.99 > MF370

>epson.co.uk

Canon Pixma TR170

>£229.99>MF370
- >canon.co.uk

HP OfficeJet 250

’ >£259.99 > MF370

>hp.com

> EXTERNAL DRIVE

OWC Envoy Pro SX

From £315 owc.com

> Life is hard and so is this
external SSD, delivering
super-fast performance in
a super-tough enclosure.
ok xkk MF371

»OURTOP3
DESKTOP SPEAKERS
Audioengine A2+

[ % >£239> MF374
B >audloeng|neusa com

Klipsch ProMedia Heritage
2.1 Speaker System
J >£359 > MF382

>klipsch.com

Q Acoustics M20 HD
>£439>MF374
>gacoustics.co.uk

> PHOTOEDITOR » PRODUCTIVITY TIMER 2 TEXT RECOGNITION
Luminar Al Vitamin-R 4.14 TextSniper 3
£59 skylum.com €2795 (about £30) £6.99 textsniper.app

publicspace.net
» Break your working day
up into short bursts of

» If you want to improve
your photos without
spending too much, this

> TextSniper can quickly
recognise and extract text
from anything you can see

is the app for you. distraction-free activity. on your Mac's screen.
Yok xkk MF361 Yk kk*x MF384 Jokokk*x MF364
>OURTOP3 >OURTOP3 >OURTOP3
ANTI-VIRUS WEB BROWSERS EMAIL
Intego Internet Security X9 " Firefox Spark
@ >£60/year > MF377 . >Free>MF369 >Free > MF375
>intego.com >mozilla.org >sparkmailapp.com

Bitdefender Antivirus Opera Edison Mail

B >£30/year > MF377 O >Free > MF369 a >Free (IAPs) > MF375
>bitdefender.com >opera.com >mail.edison.tech
Clario Vivaldi - Airmail

@ >£53/year > MF377 >Free > MF369 @ >£2.99/month > MF375
>clario.co >vivaldi.com >airmailapp.com

»Image credits: Sony Group Corporation, ZAGG Inc, Other World Computing Inc, BenQ Corporation, HP Development
Company LP, Lenovo, Seiko Epson, Canon, Audioengine, Klipsch Group Inc, Q Acoustics, Skylum, Publicspace.net, Valerijs
Boguckis, Intego, Bitdefender, Clario Tech, Mozilla Corp, Opera, Vivaldi Technologies, Readdle Inc, Edison Software, Bloop,
LumaTouch LLC, Ginger Labs, The Grizzly Labs, Grailr LLC, Capture One, Reeder, inkle Ltd

BEST BUYS...
Third-party iPhone,
IPad & Watch apps >

> VIDEO EDITOR (i0S/iPADOS)
. LumaFusion 3

£25.99 luma-touch.com
> A powerful and reasonably priced
video-editing suite. Existing users

can upgrade for free.
*xkkk MF372

» NOTETAKING (10S/iPADOS)
@ Notability
£8.99 notability.com

» Notability is a superb note-taking
app with lots of flexibility. It's ideal
for a variety of projects.

* ¥k *k MF360

» SCANNING/OCR (i0S/iPADOS)
GeniusScan+
£8.99 grizzlylabs.com

» Fast, flexible and useful scanning
with good optical character
recognition (OCR).

*xkxk MF368

» WEATHER (i0S/iPADOS)
Pes') CARROT Weather
¥ £4.99/month meetcarrot.com
» Feature-packed forecasts and a snarky
sense of humour mean the outlook for
this app is very bright indeed.
Jkdokk MF367

»PHOTO EDITOR (iPADOS)

] Capture One

£4.49/month captureone.com

» A comprehensive photo editor offering
powerful Raw conversion and desktop-
quality editing tools on the iPad.
*dkxk MF384

» RSSREADER (i0S)
* Reeder 5
£4.49 reederapp.com
» Version 5 brings minor, but welcome
improvements to an already great

RSS news-reader app.
* ¥k Kk MF361

» GAME (i0S/iPADOS)
: Overboard!
v £4.99 inklestudios.com

» A gem. A small, but perfectly formed
and entertaining game about a ship-
based murder mystery.

*dkxk MF372
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iIPod Hi-Fi

With a new HomePod on the shelves, Graham Barlow

looks back at Apple’s first venture into home audio

pple surprised everybody in
January this year with the release
of a new home speaker, the second

no AUX-in port, meaning you need to be running
an Apple-only household to get the most out of it.
It’s a world away from Apple’s first foray into

the audio market - the ill-fated iPod Hi-Fi from back
in 2006. Decked out in the purest Apple white, the
iPod Hi-Fi was a beast of a speaker that lacked the
subtlety that Apple had become known for. It was
heavy too (7.6kg when fed with the required six
D-size batteries), and at 17-inches long there was no
way it could be discreetly tucked away in your front

incarnation of the HomePod. Undercut by
much cheaper Alexa rivals, the original 2018
HomePod model had disappeared from Apple’s
product line-up by 2021, with only the cheaper
HomePod mini still available for anybody who
wanted to buy an Apple speaker. But now the
new full-size HomePod (2nd gen) is back to

reclaim its rightful throne from Alexa.

At £299, the HomePod (2nd gen) is still an
expensive investment, and it’s a whole £200
more than the HomePod mini, which is only
£99. It also looks pretty similar to the original
model. So, what are Apple banking on to make
the new HomePod a success this time around?

If a powerful high-excursion woofer and
beam-forming tweeters aren’t enough to
persuade your ears then the new HomePod
is also a smart home hub, with Siri built in, so
you can talk to it about life, the universe and
everything, or maybe just ask it to turn down
your smart light bulbs in the living room when
you want to watch a movie. Unfortunately,
Apple still insists on ignoring Bluetooth
entirely in favour of AirPlay, and there’s also
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room. Its built-in handles seemed to imply it was
portable, but it was probably the least portable
accessory that Apple had ever made.

When Steve Jobs launched the iPod Hi-Fi he claimed

that it was, “Home stereo. Reinvented”. But it’s
strange to think that there was once a day when
Apple thought that having a massive speaker was
what people wanted, when everything else was
getting smaller. It sounded great though, and if it
had been Bluetooth compatible and a bit smaller,
it probably would have had a longer life, because
just a short year and a half after its launch it was
gone forever. Now you can buy one on eBay for
about £75. Let’s hope the (second-gen) HomePod
lasts a bit longer than that.
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IF I HAD
SOMEWHERE
TO LIVE...

When Abi's mum died, life got tough. She didn't get on with her
dad and the arguments became violent. Abi felt her only choice
was to leave home. With just the clothes on her back, and no
idea where to go, she ended up sleeping on the streets in the
freezing cold.

Right now, you could give a homeless young person like Abi
somewhere to start their future

Abi’s life changed when she was given a room at Centrepoint.
A safe place to sleep and recover. A place to develop the skills
and confidence she needed to rebuild her life - and leave
homelessness behind for good. Now, Abi believes she can

go anywhere.

FOR £12 A MONTH

Please collect my payment on the 1st/15th of every month iplease circle preferred date)

To the Manager: I3
Name and full address of your
Bank or Building Society:

Postcode
Name(s) of Account Holder(s)

Dank Sort Code: [ 2 [l jAc:oun(Numbcr;l I | I l I | [|

Instructions to your Bank or Building Society: Please pay Centrepoint Direct Debits
from the account detailed in this instruction, subject to the safeqguards assured by the
Direct Debit Guarantee. | understand that this instruction may remain with Centrepoint
and, if so, details will be passed electronically to my Bank/Building Society.

Signature(s) Date

Banks and Building Societies may not accept Direct Debit Instructions for some types of account.

Increase your donation by 25p for every £1 you donate with Gift Aid ﬁ,‘ﬁw'd;,{r

[ By ticking this box | confirm | am a UK taxpayer and want Centrepoint to Gift Aid
all donations I've made in the last four years and any donations | make in the
future until | notify you otherwise. | understand that if | pay less Income Tax and/
or Capital Gains Tax in any tax year than the amount of Gift Aid claimed on all my
donations it is my responsibility to pay any difference.

Your name and address are needed to identify you as a current UK taxpayer.

Your donation will go towards funding Centrepoint’s vital work with young people all year round providing
accommodation and support. We sometimes use models and change the names of the young people we
waork with to protect their identity; however all stories are true and as told by the young person.

Thousands of homeless young people like Abi are desperately
trying to find their place in the world - but first they need a
place to start again. You could help right now by sponsoring
a room at Centrepoint for just 40p a day.

We know this support changes lives. 88% of the young
people we help move on positively in life. So please, help
someone like Abi today. Thank you.

Text PLACE to 78866 to donate £3

Call free on 0800 472 5798

Visit centrepoint.org.uk/place

Or complete and return the form below

Full Name:

Address:

Postcode: Telephone:

Email:

Thank you for donating to Centrepoint today.

We'd love to show the impact of your support and share how young people
continue to need your help, through newsletters, fundraising appeals and
information about events. Please let us know how best to stay in touch with
you by adding your details above, and ticking the relevant boxes:

[JPlease contact me by email [1Please contact me by phone

Last year our supporters helped us change the lives of over 15,000 homeless
young people. By letting us know we can count on you, we can continue helping
young people with a home and a future.

Your privacy is key.

We promise never to sell or swap your details, and will always keep them secure.
You can view our Privacy Notice in full at www.centrepoint.org.uk/privacy.

You can opt out of post and change how we communicate with you at any

time. Please call 0800 232320 and speak to one of our friendly team or email
supportercare@centrepoint.org to do this and ask us any questions.

Please return this form to: Freepost Plus RTXY-LBEA-UTJJ, Angel Fulfilment
Services Ltd, Communication Centre, Par Moor Road, Par PL24 25Q

Registered office address: Central House, 25 Camperdown Street, London E1 8DZ.

Company no. 1929421, Registered Charity no. 292411. Housing association no. H1869.
VAT registration no. 649 345 018.
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PAPER POWER

60% of the energy used to produce paper and
paper packaging in Europe comes from renewable sources.

Discover the story of paper
www.lovepaper.org

Source: Confederation of European Paper Indusiries (CEPI), 2018
CEPI represents 92% of European pulp and paper production



